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Перелік скорочень та умовних позначень 

ЛКМ – ліва кнопка миші; 

ПКМ – права кнопка миші; 

САПР – система автоматизованого проєктування; 

CAD (англ. Computer-aided design) – система автоматизованого проєктування. 

 



6 
 

Вступ 

 

Для розробки нового та вдосконалення існуючого обладнання хімічного або іншого 

виробництва необхідні  кваліфіковані фахівці з проєктування. На даний час раціонально 

використовувати системи автоматизованого проєктування (САПР або CAD), що дає змогу 

зменшити час та значно збільшити продуктивність праці по виконанню поставлених задач з 

3D-проєктування.  

Наразі існує значна кількість CAD-систем. Однією з найбільш поширених систем 

автоматизованого проєктування є SolidWorks. Володіння навиками роботи в цій CAD-системі 

дасть змогу значно розширити свої можливості як професійного проектувальника.  

Даний посібник написаний української мовою, що спрощує освоєння наведеної 

інформації. Адже більшість підручників по даній тематиці видано іноземними мовами, що 

може ускладнювати освоєння програми SolidWorks. 

Для інформативності в посібнику наведені ілюстративні матеріалу з робочого вікна 

програми. 

Посібник відповідає темам лекційних занять з дисципліни «3D-інженерія: SolidWorks». 
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SolidWorks: характеристики, інтерфейс, навігація 

Характеристики програмного продукту SolidWorks 

SolidWorks  це програмний продукт, що являє собою систему автоматизованого 

проєктування1, інженерного аналізу для вирішення поставлених задач в конструкторській та 

технологічній підготовці виробництва, а також управлінні даними та процесами. В основі, 

SolidWorks є конструкторською системою твердотільного параметричного моделювання. 

Розробником програмного продукту є «SolidWorks Corporation», що є дочірньою 

компанією «Dassault Systemes». Позиціонує себе як Dassault Systemes SolidWorks Corporation 

головним офісом в Волтгем, Массачусетс, Сполучені Штати Америки. Оригінальний сайт 

www.solidworks.com Також компанія має офіційні акаунти в різних соціальних мережах та 

відеохостингу YuoTube2. Офіційний сайт довідки по програмному продукту SolidWorks 

https://help.solidworks.com 

Емблема програмного продукту Soldworks: 

 

Solidworks підтримується операційною системою Windows. По типу ліцензії є 

пропрієтарним програмним забезпеченням3. 

SolidWorks крім основного засобу для проєктування 3D-моделей, також містить 

модулі/доповнення, призначені для розширення можливостей цього програмного продукту. 

Зокрема модуль SolidWorks Motion призначений для розрахунку руху механізмів, 

SolidWorks Routing - для проектування трубопроводів, SolidWorks Simulation 

(COSMOSWorks) є універсальним інструментом для аналізу методом кінцевих елементів, а 

модуль SolidWorks Simulation дозволяє проводити інженерні розрахунки і моделювати 

різних впливи навколишнього середовища на виріб. Для забезпечення автоматичного 

сполучення стандартних виробів при вставці в збірку та надання можливості групових 

операцій застосовується бібліотека стандартних виробів Toolbox. 

Установка SolidWorks 

Програмний продукт Solidworks не є безоплатним і для його активації потребує 

придбання ліцензійної копії (ключа продукту). В залежності від версії, призначення  та 

наявності модулів вартість різниться. Існує також комерційна  версія для студентів за 

зниженою вартістю. В межах вивчення студентами заклад вищої освіти безоплатно надає 

 
1 Система автоматизованого проєктування (САПР, САП або АСП – автоматизована система проєктування, 

версія англ. CAD – computer-aided design) – автоматизована система, яка призначена для автоматизації 

технологічного процесу проєктування виробу, результатом якого є комплект проєктно-конструкторської 

документації, достатньої для виготовлення та подальшої експлуатації об'єкта проєктування. 
2 Офіційна сторінка компанії Dassault Systemes SolidWorks Corporation у відеохостінгу YouTube: 

https://www.youtube.com/solidworks 
3 Пропрієтарне програмне забезпечення (або власницьке програмне забезпечення, від англ. proprietary 

software) — це програмне забезпечення, на яке зберігаються немайнові та майнові авторські права. Користувач 

цього програмного забезпечення отримує обмежені права користування, прописані в ліцензійній угоді до 

програмного забезпечення. 

http://www.solidworks.com/
https://help.solidworks.com/
https://www.youtube.com/solidworks
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доступ до персональних комп’ютерів з ліцензійними версіями програмного продукту 

Solidworks. 

В цілому, офіційна4 методика установки Solidworks на окремих комп’ютерах наступна. 

Менеджер установок Solidworks встановлює різні компоненти Microsoft, в тому числі 

Microsoft Windows, Microsoft Visual Studio Tools для програм, Visual Basic і платформу .NET 

Framework. Якщо на комп’ютері не встановлені всі необхідні компоненти Windows, Менеджер 

установок Solidworks автоматично виконає їх установку перед установкою продуктів 

Solidworks. 

SOLIDWORKS Chromium Embedded Framework (CEF) — це інший компонент, який 

встановлюється Менеджером установок Solidworks. Він призначений для відображення 

підтримуваних програм Solidworks і 3DEXPERIENCE Platform. 

Існує три методи установки: 

1. Завантаження зі сторінки завантаження Solidworks. 

2. Установка за допомогою каталогу завантаження на сервері. 

3. Оновлення поточної установки Solidworks за допомогою параметра «Перевірити 

наявність оновлень». 

Перший метод установки «Завантаження зі сторінки завантаження Solidworks» 

включає такі етапи: 

1. Перейти на сторінку завантаження Solidworks. 

2. Виконайте вхід у якості клієнта з підпискою на послугу, використовуючи свою 

адресу електронної пошти та пароль або свій серійний номер Solidworks. 

3. На сторінці скачування в розділі Select Version (Вибір версії) вибрати рік. 

4. Перейти на вкладку Solidworks у розділі продуктів Solidworks, а потім вибрати 

пакет оновлення у розділі Продукт. 

5. Натисніть Прийняти угоду та продовжити на сторінці CLOSA. 

6. Натиснути Завантажити. 

7. Запустити SolidWorksSetup.exe. 

8. В менеджері встановлення Solidworks обрати Встановити на цьому комп’ютері. 

9. Ввести свій серійний номер Solidworks. 

10. Натиснути Змінити, щоб змінити продукти або параметри за замовчуванням. 

11. Прийняти умови ліцензійної угоди та натиснути Встановити. 

12. Якщо користувач не є власником ліцензії SolidNetWork, при першому запуску 

Solidworks активувати ліцензію для завершення установки. 

Підготовка 

1. Переконатися, що комп'ютер відповідає системним і програмним вимогам, має 

сертифікований драйвер і графічну плату, а також забезпечує надійний доступ до 

Інтернет. 

2. Переконатися, що є локальні права адміністратора на комп'ютері. 

3. Отримати серійний номер від реселлера або адміністратора CAD. 

4. Зареєструвати обліковий запис на порталі клієнтів Solidworks і створити Solidworks 

ID. 

5. На порталі клієнтів Solidworks у розділі Підтримка можна зареєструвати продукти. 

 
4 https://help.solidworks.com/2024/russian/SolidWorks/install_guide/c_installing_on_individual_computers.htm 

https://help.solidworks.com/2024/russian/SolidWorks/install_guide/c_installing_on_individual_computers.htm
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Управління 

1. Щоб встановити пакети оновлення, перейти на портал клієнтів SOLIDWORKS і в 

розділ СКАЧАТИ натиснути Завантажити та оновити. 

2. Для внесення змін, виправлень або видалення перейти в меню Пуск > Панель 

управління > Програми і компоненти. Потім обрати версію SOLIDWORKS і 

натиснути праву кнопку мишки Змінити або Видалити. 

3. Щоб перенести ліцензію на інший комп'ютер, необхідно деактивувати ліцензію на 

одному комп'ютере, перш ніж перенести її на іншу. Щоб деактивувати ліцензію, в 

SOLIDWORKS потрібно натиснути  > Ліцензії  > Деактивувати. 

Другий метод установки «Установка за допомогою каталогу завантаження на 

сервері»: 

1. У каталозі скачування два рази натиснути setup.exe. 

Каталог скачувань повинен бути доступний на комп’ютері, на якому здійснюється 

установка продуктів SOLIDWORKS, і повинен містити всі установчі файли SOLIDWORKS до 

початку процесу встановлення. Менеджер установок SOLIDWORKS дозволяє шукати файли, 

яких бракує, за наявності доступу до Інтернету та права запису в каталозі скачування. 

Третій метод установки «Оновлення поточної установки SOLIDWORKS за 

допомогою параметра «Перевірити наявність оновлень»: 

Виконати одну з наступних операцій: 

1. У SOLIDWORKS обрати  > Перевірити наявність оновлень. 

2. У Windows вибрати Пуск > Менеджер установок SOLIDWORKS > Перевірити 

наявність оновлень. 

У Менеджері установок SOLIDWORKS також можна вибрати параметр Завантажити 

та надати загальний доступ до всіх файлів, включаючи необхідне програмне забезпечення. 

Ця функція корисна, якщо встановлюється програмне забезпечення на кількох комп’ютерах і 

необхідно скопіювати його за допомогою портативного або мережевого диска. Також корисно 

встановити пакети оновлення, адже повна версія і пакет оновлення містяться в одній 

установці. 

Після завершення установки необхідно запустити програму SOLIDWORKS і 

активувати ліцензію. 

Щоб відобразити список продуктів, для яких використовуються ліцензії на комп’ютері, 

у головному меню SOLIDWORKS потрібно виконати наступні дії: 

1. Натиснути  > Мої продукти. 

2. Вибрати Головна на панелі задач і перейти до розділу Ресурси SOLIDWORKS > Мої 

продукти. 

3. Натиснути кнопку Пуск > Інструменти SOLIDWORKS версія > Мої продукти. 

У діалоговому вікні прапорцями позначені продукти, якими володіє користувач або 

його організація на основі активації або мережевих ліцензій. Також можна дізнатися більше 

про продукти SOLIDWORKS, натиснувши посилання у верхній частині кожної категорії 

продуктів. 

Якщо на комп’ютері є ліцензія Solidworks, в ОС Windows можна переглянути, які 

ліцензії використовуються. Для цього необхідно перейти на вкладку Пуск > Інструменти 

Solidworks версія > SolidNetWork License Manager > Використання ліцензій. 
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Основна мова SolidWorks є англійська. При установці є можливість обрати іншу наявну 

мову, або ж вона автоматично визначиться в залежності від налаштувань операційної системи. 

В посібнику використана версія SolidWorks Premium 2023 SP1.0, інтерфейс якої за 

відсутністю мовного пакету з українською мовою налаштовано англійською. 

Інтерфейс програми 

Ярлик SolidWorks Premium 2023 SP1.0 на робочому столі Windows: 

 

При подвійному натисканні мишкою ярлика SolidWorks з’являється невелике завантажувальне 

вікно, зовнішній вигляд якого щоразу дещо змінюється. Далі представлено три варіанти вікна з 

багатьох завантажування програми SolidWorks версії Premium 2023 SP1.0. 

   

У вікні можна побачити назву та версію програмного продукту, компанію-розробника, вказівку 

поточного елемента, що завантажується та ілюстрацію розробленого в програмі виробу, який щоразу 

під час нового завантаження змінюється. 

Після завантаження SolidWorks відображається основне вікно програми та додаткове, в якому 

є можливість швидкого вибору створення типу файлу, завантаження нещодавніх документів, папок 

розташування файлів, інформаційні ресурси програмного продукту тощо.  
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Під час запуску програми SolidWorks головне меню, що знаходиться зверху вікна 

та містить вкладки File, View, Tools, Help (Файл, Вид, Інструменти, Допомога/Довідка) 

згорнуто.  

 

Для відображення меню необхідно навести курсор мишки на стрілку справа від 

логотипу програми. Проте при відведенні курсору меню знову згорнеться. Для фіксації меню 

необхідно натиснути значок скріпки, справа від нього.  

 

Далі справа від меню знаходяться кнопки швидкого доступу до основних команд, 

зокрема Welcome to SolidWorks (Ласкаво просимо до SolidWorks) (Ctrl+F2), New (Новий) 

(Ctrl+N), Open (Відкрити) (Ctrl+O), Options (Параметри) та ін. Деякі з них неактивні в зв’язку 

з відсутністю створеного документу та виконаних дій в ньому. 

Для створення нового документу або відкриття існуючого є декілька варіантів: 

1. Обрати відповідну команду з меню File (Файл) (команди New (Новий) та Open 

(Відкрити)). 

2. Скористатись кнопками швидкого доступу New (Новий) та Open (Відкрити). 

3. Застосувати комбінації клавіш: для створення Ctrl+N та Ctrl+O для відкриття. 

   

Якщо обрати команду створення нового документу, з’явиться діалогове вікно з 

можливостю обрання типу документа: Part  (Деталь), Assembly (Збірка) та 

Drawing  (Кресленик).  
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Необхідно обрати тип документа та натиснути клавішу Enter або кнопку ОК у вікні. 

Документ типу Деталь призначений для створення виробу, виготовленого з 

однорідного за найменуванням і маркою матеріалу без виконання складальних операцій. 

Розширення файлу .sldprt. 

Документ типу Збірка призначений для створення виробу, що складається з двох чи 

більше деталей. Також збірка може складатись з двох чи більше складальних одиниць або в 

поєднанні з деталями. Тобто документ типу збірка містить більше двох одиниць деталей, 

інших збірок або їх поєднання. Розширення файлу .sldasm. 

Документ типу Кресленик призначений для створення 2D-креслеників як деталей, так 

і збірок. Розширення файлу .slddrw. 

Кількість одночасно відкритих файлів обмежена лише ресурсами персонального 

комп’ютера, на якому запущена програма SolidWorks. 

В 3D-проєктуванні доцільним є спочатку побудова 3D-об’єктів, на основі яких 

створюються 2D-кресленики в автоматизованому режимі. 

Після обрання типу документа Деталь вікно програми SolidWorks набуде наступного 

виду: 

 

Для прикладу нижче наведено вікно SolidWorks при наявній побудові 3D-об’єкту 

(деталі). 
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Основні елементи вікна SolidWorks під час 3D-проєктування: 

  

У Рядку меню представлено меню SolidWorks, кнопки (інструменти) швидкого 

доступу, вікно пошуку SolidWorks, параметри довідки та кнопки керування вікна SolidWorks. 

Диспетчер команд CommandManager – це контекстна панель інструментів, яка 

автоматично оновлюється залежно від панелі інструментів, до якої потрібний доступ. За 

замовчуванням вона містить вбудовані панелі інструментів, залежно від типу документа. 
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Панель інструментів керованого перегляду – панель інструментів, що містить 

інструменти для налаштування відображення виду об’єкта в робочому полі 

Панель задач – панель, що забезпечує доступ до ресурсів, бібліотек повторно 

використовуваних елементів проектування SolidWorks, видів, які можна перетягувати на 

креслярські листи, та інших корисних об'єктів та відомостей. 

Рядок стану в нижній частині вікна SolidWorks відображає інформацію про завдання, 

яке виконується. 

Графічна область – частина вікна програми SolidWorks, в якому відображаються 

деталі, збірки та кресленики, якими може оперувати користувач. 

Довідкова система координат – система координат, яка з'являється в документах 

деталей і збірок для покращення орієнтування при перегляді моделей. Також може 

використовуватися для зміни орієнтації виду. 

Панель управління – панель, призначена для управління проєктуванням деталей та 

збірок, листами креслеників, властивостями, конфігураціями та сторонніми додатками. 

Зверху панелі управління є можливість перемикатись між її вкладками панелі (Дерево 

конструювання FeatureManager, Менеджер властивостей PropertyManager, Менеджер 

конфігурацій ConfigurationManager, DimXpertManager, Дисплей менеджера). 

Налаштування відображення вікна програми SolidWorks 

Користувач має змогу налаштувати кольорову схему вікна програми SolidWorks та 

колір, яскравість фону графічної області та якість відображення моделі. 

Для зміни поточної кольорової схеми необхідно виконати такі дії: в меню Tools > 

Option > Colors > Current color scheme (Інструменти > Параметри > Кольори > Поточна 

схема кольору). 

Для зміни фону графічного вікна необхідно виконати такі дії: в меню Tools > Option > 

Colors > Color scheme settings > Edit (Інструменти > Параметри > Кольори > Вікно 

графічного вікна > Редагувати). 

Для зміни якості відображення моделі в Графічній області необхідно пересунути 

повзунок: в меню Tools > Option > Performance > Level of detail (Інструменти > 

Параметри > Якість зображення > Рівень деталізації). 

Для зміни розміру відображення кнопок інструментальних панелей а диспетчері 

команд, на вкладках панелі управління, панелі інструментів керованого перегляду, панелі 

задач тощо необхідно відкрити вспливаюче вікно через меню Tools > Customize 

(Інструменти > Налаштування), або через праву кнопку миші у вільній частині диспетчера 

команд чи рідка меню, або через кнопку швидкого доступу Options (Параметри) і обрати 

необхідний розмір кнопок: Small, Medium, Large (Малі, Середні, Великі). Малі кнопки є за 

замовчуванням. 

Приклади вікна SolidWorks за різного розміру кнопок інструментів: 

1. Малі 
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2. Середні 

 
3. Великі 
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Рядок меню 

Рядок меню знаходиться зверху вікна SolidWorks. Компоненти рядка меню можуть 

змінюватись в залежності від типу документа і в параметрах є  можливість їх налаштування. 

Нижче наведено рядок меню при створенні документа типу Деталь. 

 

В такому разі рядок меню складаються з таких елементів: 

1. Емблема програмного продукту SolidWorks. 

2. Вкладки меню. Типовими є File, Edit, View, Insert, Tools, Window (Файл, Правка, Вид, 

Вставка, Інструменти, Вікно). 

3. Кнопки (інструменти) швидкого доступу. 

4. Назва створеного документа (за умови роботи у вже створеному документі). 

5. Вікно пошуку SolidWorks. 

6. Довідка. 

7. Кнопки  керування вікна SolidWorks: згортання, повноекранного відображення та 

закриття вікна. 

Диспетчер команд 

CommandManager (Диспетчер команд)– це контекстна панель інструментів, яка 

автоматично оновлюється залежно від панелі інструментів, до якої потрібний доступ. За 

замовчуванням вона містить вбудовані панелі інструментів, залежно від типу документа. 

За необхідності диспетчер команд можна прибрати, прибравши галочку Enable 

CommandManager (Включити диспетчер команд) у контекстному меню через праву кнопку 

миші у вільному полі самого диспетчера команд або вище в рядку меню. 
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Внизу диспетчера команд є вкладки для перемикання між наборами тематичних 

панелей інструментів. Наприклад, якщо натиснути на вкладку Features (Елементи), в 

диспетчері команд поле оновлюється для відображення відповідних панелей інструментів: 

 

Для переходу за вкладками CommandManager використовуються комбінації клавіш 

Ctrl+Page Up та Ctrl+Page Down або курсором мишки. 

Для задання або зняття відображення підписів до кнопок інструментів панелі необхідно 

натиснути правою кнопкою миші в диспетчері команд і встановити або зняти прапорець Use 

large buttons with text (Використовувати великі кнопки з текстом). Цей параметр також 

доступний у меню Tools > Customize (Інструменти > Налаштування).  

Варіанти відображення диспетчера команд із активною вкладкою Sketch (Ескізи): 

1. З підписами до кнопок інструментів панелі 

 

2. Без підписів до кнопок інструментів панелі 

 

Панель управління 

Панель управління призначена для управління проектуванням деталей та збірок, 

листами креслеників, властивостями, конфігураціями та сторонніми додатками. 

 

Основні вкладки панелі управління: 

Іконка5 Назва Призначення 

 

FeatureManager design tree 

(Дерево конструювання 

FeatureManager) 

  

Відображається контурний вигляд активної деталі, 

збірки або кресленика та побудова моделі або 

збірки, а також є можливість переглянути різні 

аркуші та види кресленика. 

 

PropertyManager  

(Менеджер властивостей) 

 

Призначене для налаштування властивостей та 

інших параметрів багатьох команд SolidWorks. 

 

ConfigurationManager  

(Менеджер конфігурацій)  

Призначене для створення, вибору та перегляду 

численних конфігурацій деталей та збірок. 

 
5 Іко́нка (від англ. icon), піктогра́ма (від лат. pictus — мальований і грец. γράμμα — письмовий знак, риска, лінія), 

значо́к (зменшене від знак) — елемент графічного інтерфейсу, невелике зображення, що репрезентує застосунок, 

файл, теку, вікно, компонент ОС, пристрій тощо. 
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DimXpertManager 

Призначене для формування списку елементів із 

допусками, визначеного функцією DimXpert для 

деталей. Також відображаються інструменти 

DimXpert, які використовуються для вставки 

розмірів та допусків до деталей. Такі розміри та 

допуски можна імпортувати до креслеників. 

 
DisplayManager 

(Менеджер відображення) 

Містяться списки та є можливість редагувати 

зовнішні види, написи, сцени, джерела світла та 

камери, які застосовуються до поточної моделі. За 

наявності доповнення PhotoView 360 

DisplayManager дає можливість доступу до 

параметрів PhotoView. 

Дерево конструювання (перша вкладка на панелі управління) є однією з найбільш 

вживаних вкладок Панелі управління під час побудови об’єктів, адже містить дані про 

послідовність всієї побудови моделі чи збірки з широкою можливістю редагування цього 

процесу. Послідовність елементів в Дереві конструювання відповідає етапам побудови моделі 

чи збірки. 

Дерево конструювання і Графічна область динамічно зв'язані. Тому вибір об’єкта в 

Дереві конструювання виділяє його графічне відображення в Графічній області та навпаки. 

Видалення об’єкта з Дерева конструювання видалить його також з побудови. 

За допомогою Дерева конструювання можна виконати такі операції: 

1. Контролювати хід побудови. 

2. Вибирати необхідні об’єкти побудови за іменем, н-ад для їх редагування. 

3. Змінювати назву операції чи побудованого об’єкта шляхом подвійного натискання 

на них. 

4. Перевпорядкувати елементи шляхом їх перетягування у списку дерева 

конструювання. При перетягуванні елемента змінюється порядок їх побудови з 

оновленням зображення у графічній області. 

5. Фільтрування дерева конструювання. 

6. Відображати розмір елемента подвійним натисканням на ім'я елемента. 

7. Погашення та скасування погашення деталей та компонентів збірки (тобто 

видалення їх з побудови без видалення з дерева конструювання. Надає можливість 

оцінити побудову без врахування даних деталей чи компонентів збірки з 

можливістю швидкого повернення в побудову). 

8. Переглянути зв’язок батьків/нащадків, натиснувши правою кнопкою миші на 

елемент у списку і вибравши Parent/Child (Батьки/нащадки). 

9. Перевірити наявність помилок  і попереджень , що стосуються моделі або 

елементу та описаних у підказках та документі Що не так?. 

10. Відображення опису елементів та компонентів, імен та опису конфігурації 

компонентів. 

Перегляд залежностей між елементами (зв’язки батьків/нащадків) можна відобразити у 

виді графічних зв'язків між елементами завдяки параметру Dynamic reference visualization 

(Візуалізація динамічних посилань)  батьків та нащадків. При активації цього параметру при 
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наведенні миші на елемент із посиланнями у Дереві конструювання відображаються 

посилання для перегляду зв'язків.  

 
Стрілки синього кольору показують батьківські зв'язки, а стрілки фіолетового кольору 

– дочірні взаємозв'язки. 

 
Візуалізація динамічних посилань за замовчанням вимкнена. Щоб її увімкнути, 

необхідно виконати такі дії: 

1. У Дереві конструювання натиснути правою кнопкою миші на перший об'єкт 

(деталі або збірки). 

2. У контекстній панелі інструментів або на вкладці Перегляд > Інтерфейс 

користувача 
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обрати один або обидва параметри: Dynamic reference visualization (parent) 

(Візуалізація динамічних посилань (батько)) та / або Dynamic reference visualization (child) 

(Візуалізація динамічних посилань (нащадок)). 

В Дереві конструювання наявна смуга відкату. Вона показує до поки виконується 

побудова. Також її можна переміщувати вручну, контролюючи межу побудови. 

 

Також існує можливість задання матеріалу шляхом натискання правою кнопкою миші 

на піктограмі Material (Матеріал): 

 

Щоб змінити видимість Дерева конструювання FeatureManager потрібно натиснути 

на клавішу F9 або обрати меню View > User interface > FeatureManagert tree area 

(Вид > Інтерфейс  користувача > Дерево  конструювання FeatureManager). 
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Панель інструментів керованого перегляду 

Панель інструментів керованого перегляду містить інструменти для налаштування 

відображення виду об’єкта в робочому полі 

 

Більшість інструментів панелі керованого перегляду також дублюються у меню View 

(Вид). 

Інструменти панелі керованого перегляду: 

Іконка Назва Призначення  

 

Zoom to fit  

(Змінити в розмір екрану) 

Змінює масштаб виду так, щоб 3D-модель, збірка 

або кресленик повністю відображались.  

Клавіша F 

View > Modify > Zoom to fit  

(Вид > Змінити > Змінити в розмір екрана) 

 

Zoom to area 

(Збільшити елемент виду  

Збільшує або зменшує елемент виду, вибраного 

його шляхом поміщення в рамку. 

View > Modify > Zoom to area 

(Вид > Змінити > Збільшити елемент виду) 

 

Previos view 

(Попередній вид) 

 

Після зміни виду відображення в робочому полі 

можна повернути 3D-модель або кресленик до 

попереднього вигляду. Можна скасувати останні 10 

змін виду. 

 

Section view 

(Розріз)  

Відсікання частини 3D-моделі деталі чи збірки по 

умовній площині. Дана операція призначена лише 

для покращення візуалізації об’єкта і відображення 

повертається до попереднього стану при 

повторному натисканні на дану кнопку. 

View > Display > Section view 

(Вид > Відобразити> Розріз) 

 

Dynamic annotation views 

(Динамічні види примітки)  

Відображення лише види приміток, які стосуються 

орієнтації поточної моделі. При обертанні моделі 

види приміток, які розташовані за нормаллю до 

орієнтації моделі, зникають. Примітки з'являються 

при наближенні до нормалі. 

 
View orientation 

(Орієнтація)  

Дозволяє обертати та змінювати масштаб моделі 

або кресленика до поточного виду 

 

Display style 

(Тип відображення)  

 

Налаштовує вигляд 3D-моделі (відображення чи 

прозорість граней, кромок моделі тощо). 

View > Display (Вид > Відобразити) 

 

Hide/Show items 

(Приховати  / Відобразити 

об’єкти) 

Налаштовує відображення чи приховування різних 

елементів в робочому полі (ескізи, площини, точки, 

системи координат тощо).  
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Одноразове натискання на кнопці відключає 

відображення всіх елементів. Також щоб 

приховати всі типи у поточному документі:  

View > Hide/Show > Hide all types 

(Вид > Приховати/Відобразити > Приховати всі 

типи) 

 

Edit appearance 

(Редагувати зовнішній вид)  

Редагування зовнішнього виду об’єктів в моделі, 

зокрема колір, текстуру, освітлення, прозорість. 

 

Apply scene 

(Застосувати сцену) 

 

Застосування обраної сцени до моделі як її фонове 

художнє оформлення, заміна сцени по 

замовчуванню. 

 

View settings 

(Перегляд налаштувань)  

Включення / відключення застосування до моделі 

тіней, імітації розсіяного світла, перспективи, 

динамічного відображення 

Інструмент View orientation (Орієнтація)   відкриває можливість задання 

відображення в Графічній області, причому в останній твердотільна модель починає 

відображатись в умовному кубі зі скошеними гранями та вершинами. При наведенні на будь-

яку зі сторін куба, в т.ч. і на скошені його частини, в спливаючому вікні генерується 

зображення твердотільної моделі як вона буде виглядати якщо натиснути на наведену 

курсором мишки сторону куба. 

 

Основні види відображення моделі в Графічній області також можна обрати 

комбінацією клавіш: 

Сtrl+1 – вид спереду 

Сtrl+2 – вид ззаду 

Сtrl+3 – вид зліва 

Сtrl+4 – вид справа 

Сtrl+5 – вид зверху 
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Сtrl+6 – вид знизу 

Сtrl+7 – ізометричний вид 

Сtrl+8 – перпендикулярно 

Також важливе налаштування відображення моделі виконується через інструмент 

панелі Display style (Тип відображення) . Даний інструмент задає стиль відображення 

моделі, а саме: 

1. Shaded with edges (Зафарбовано з кромками) – модель непрозора, пофарбована, є 

кромки. 

2. Shaded (Зафарбовано) – модель непрозора, пофарбована, без кромок. 

3. Hidden lines removed (Видалено невидимі лінії) – модель непрозора, проте не 

пофарбована; є кромки (лише ті, які видимі з поточної орієнтації моделі). 

4. Hidden lines visible (Невидимі лінії відображаються) – модель умовно прозора, не 

пофарбована; є кромки (суцільною лінією ті, що видимі за поточної орієнтації моделі, 

та пунктирною ті кромки, які невидимі за поточної орієнтації моделі). 

5. Wireframe (Каркасне представлення) – модель прозора, непофарбована, видно 

абсолютно всі кромки моделі, які відображаються однаково. 

6. Integrated preview (Інтегрований попередній перегляд) – модель відображається 

найбільш реалістичною із врахуванням її характеристик (наприклад, матеріалу).  

 
Зафарбувано з 

кромками  

 
Зафарбувано  

 
Видалено невидимі 

лінії  

 
Невидимі лінії 

відображаються  

 
Каркасне 

представлення  

 
Інтегрований 

попередній перегляд  

Панель задач 

Панель завдань забезпечує доступ до ресурсів, бібліотек повторно використовуваних 

елементів проєктування SolidWorks, видів, які можна перетягувати на креслярські листи, та 

інших корисних об'єктів та відомостей. 
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Іконка Назва Призначення  

 

SOLIDWORKS resources 

(Ресурси SolidWorks)  

 

Групи команд Інструменти SOLIDWORKS, 

Інтерактивні ресурси та Передплата послуг, а 

також посилання на діалогове вікно привітання. 

 

Design library 

(Бібліотека проєктування) 

На вкладках Бібліотека проектування, Toolbox 

та Вміст SOLIDWORKS доступні різні 

стандартні деталі, бібліотечні елементи та інший 

вміст, що використовується повторно. 

 

File explorer 

(Провідник файлів) 

Дублює Провідник файлів на комп'ютері та 

містить папку Відкрити в SOLIDWORKS. 

Якщо встановлено додаток SOLIDWORKS 

PDM, вкладка змінюється на . 

 

View palette 

(Палітра видів) 

Зображення стандартних видів, видів приміток, 

розрізів та розгорток (для деталей із листового 

металу) для перетягування на креслярський 

лист. 

 

Appearances, scenes, and 

decals 

(Зовнішні види, сцени та 

надписи) 

Бібліотека зовнішніх видів, сцен та написів. 

 

Custom properties 

(Властивості користувача)  

У налаштованому інтерфейсі, який можна 

створити за допомогою Property Tab Builder, 

задайте властивості, що настроюються у файлах 

SolidWorks. 

Графічна область 

У графічній області відображаються деталі, збірки та кресленики, якими може 

оперувати користувач. 

Знизу зліва у графічній області розташований динамічний значок Довідкової системи 

координат  
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Динамічний значок можна приховати, проте не можна використати в якості точки 

формування («закріплення» моделі в просторі). 

Щоб відобразити або приховати довідкову систему координат, необхідно натиснути 

меню Tools > Option > System option > Display (Інструменти > Параметри > Параметри 

системи > Відобразити). У вікні потрібно встановити або зняти прапорець Display referenced 

triad (Відобразити довідкову систему координат), а потім натисніть OK. 

Також за допомогою динамічного значка довідкової системи координат можна 

змінювати орієнтацію виду: 

Опція Опис 

Вибір осі Перегляд, перпендикулярний площині екрану. 

Вибір осі, перпендикулярній 

площині екрана 

Зміна напряму виду на 180 градусів. 

Shift + вибір осі Поворот довкола осі на 90 градусів. 

Ctrl + Shift + вибір осі Поворот на 90 градусів у зворотному напрямку. 

Alt + вибір осі Поворот навколо осі зі збільшенням клавіш зі стрілками, 

вибраних Tools > Option > System option > View 

(Інструменти > Параметри > Параметри системи > Вид)  

Ctrl + Alt + вибір осі Поворот у зворотному напрямку. 

По центру графічної області зафіксована вихідна точка, яка відображається синім 

кольором для моделі та червоним для ескізу: 

  

Вихідна точка моделі є координатою моделі (0,0,0). Коли ескіз стає активним, вихідна 

точка ескізу має координату (0,0,0) ескізу. 

Розміри та взаємозв'язки можуть бути додані до вихідної точки моделі, але не ескізу. 

Рядок стану 

Рядок стану знаходиться в нижній частині вікна програми SolidWorks. 

 

Інформація в рядку стану різниться в залежності від типу документа та поточній 

операції. Рядок стану призначений для відображення: 

1. поточної версії SolidWorks. 

2. значка перебудови , що відображається при внесенні змін до ескізу або деталі, які 

потребують перебудови; 
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3. стану ескізу та координати покажчика під час роботи в ескізі; 

4. вимірів, що часто використовуються для вибраних елементів, наприклад довжина 

кромки; 

5. повідомлення, що вказує на те, що деталь редагується під час знаходження у збірці; 

6. типу системи одиниць і можливість її зміни; 

7. піктограми , що використовується для доступу до діалогового вікна 

"Перезавантажити" у режимі спільної роботи; 

8. кнопки для відображення / приховання вікна Мітки, в якому можна додавати ключові 

слова до елементів або деталей для спрощення пошуку. 

Щоб відобразити або приховати рядок стану: View > User integrase > Status bar 

(Перегляд > Інтерфейс користувача > Рядок стану). 

Робота з пристроєм для управління курсору (комп'ютерною мишею) 

Для роботи в програмі SolidWorks для застосування додаткових можливостей 

керування доцільно використовувати комп'ютерну мишу з двома клавішами та колесом 

мишки, в яке вмонтована третя кнопка (тобто колесо миші натискається). 

Швидкість переміщення курсору миші налаштовується в меню: 

Tools > Options > System options > View > Mouse speed 

(Інструменти > Параметри > Параметри системи > Вид > Швидкість миші) 

Основне призначення лівої кнопки миші (ЛКМ) – виділення об’єктів, правої кнопки 

миші (ПКМ) – поява контекстного меню, вміст якого залежить від об’єкта виділення та 

поточної операції. 

Для множинного виділення об’єктів необхідно натиснути і не відпускати клавішу Ctrl 

або Shift та почергово натискати ЛКМ на об’єктах. Відмінністю клавіш є те, що з клавішою 

Ctrl при повторному натисканні ЛКМ на об’єкті відбувається зняття його виділення. А з 

клавішою Shift можна лише додавати виділення об’єктів. І повторне натискання на об’єкті не 

приводить до зняття його виділення. 

Під час виділення об’єкту/ів прямокутною рамкою під час затискання лівої кнопки 

миші зліва направо виділяється лиш ті об’єкти чи об’єкт, що попали в прямокутну рамку 

(блакитного кольору). А під час виділення лівою кнопкою миші справа наліво виділяються всі 

об’єкти, які хоча б частково попали в область виділення (зеленого кольору).  

Контур виділеного об’єкта ескізу змінює свій колір із синього на блакитний. 

З виділенням ЛКМ зліва-направо: 

Під час виділення Результат виділення 
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Як видно з рисунку, в результаті виділились ті об’єкти (лінія, прямокутник, коло), які 

повністю попали в область виділення (прямокутну рамку). Еліпс не повністю помістився в 

рамку, тому він і не виділився. 

З виділенням ЛКМ справа-наліво: 

Під час виділення Результат виділення 

  

Як видно з рисунку, еліпс, що попав лише частково в рамку, також був виділений. 

Крім виділення прямокутною рамкою, існує також фігурне виділення об’єктів за 

допомогою команди Ласо / Лассо. Для її вибору необхідно натиснути правою кнопкою миші 

в графічній області та у контекстному меню обрати пункт Інструменти вибору / Вибір Ласо 

(Инструменты выбора / Выбор Лассо).  

 

Потім, затиснувши ЛКМ, можна довільним чином будувати область виділення.  

Наприклад, нижче наведено два типи виділення (Увага! В даному прикладі площа 

виділення ласом зеленого кольору): 
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Результат виділення буде однаковим. Адже, як видно з рисунків, область виділення 

зеленого кольору (за деяких маніпуляцій курсором може бути також блакитного). Отже буде 

виділятись все, що хоча б частково попало в цю область: 

 

Обертання виду (тільки для деталей та збірок). 

Для довільного обертання виду моделі необхідно натиснути на колесо миші і почати її 

переміщувати. 

Для обертання виду моделі навколо вершини, кромки чи грані необхідно вибрати 

колесом миші відповідний об’єкт довгим натисканням та почати переміщувати мишу. 

Збільшення / зменшення виду – масштабування (тільки для деталей та збірок): 

Потрібно здійснити обертання колеса миші вперед або назад. Під час обертання колеса 

курсор має бути в області, яку необхідно збільшити. Якщо вказівник знаходиться за межами 

графічної області, то збільшиться для перегляду центральна частина моделі. 

Для зміни напрямку збільшення / зменшення виду моделі (зміни масштабу її 

відображення в робочому полі програми) під час обертання колеса миші необхідно зайти в 

Tools > Options > System options > View > Reverse mouse wheel zoom direction (Інструменти 

> Параметри > Параметри системи > Вид > Зміна напряму масштабування колесом миші). 

Для швидкого збільшення / зменшення виду необхідно одночасно натиснути клавішу 

Shift та на колесо миші і почати її переміщувати.  

Переміщення виду (тільки для деталей та збірок): 

Для переміщення 3D-моделі в робочому полі програми (лише візуально, прив’язка 

моделі до системи координат не змінюється) необхідно одночасно натиснути клавішу Сtrl та 

на колесо миші і почати її переміщувати.  

Для швидкого позиціонування 3D-моделі відносно центру робочого поля з 

автоматичним підбором масштабу (але без обертання системи координат) необхідно двічі 

натиснути на колесо миші або на клавішу F. 

Також для швидкого відображення відповідного виду 3D-моделі з автоматичним 

підбором масштабу відносно робочого поля існують такі комбінації клавіш: 

Сtrl+1 – вид спереду 
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Сtrl+2 – вид ззаду 

Сtrl+3 – вид зліва 

Сtrl+4 – вид справа 

Сtrl+5 – вид зверху 

Сtrl+6 – вид знизу 

Сtrl+7 – ізометричний вид 

Сtrl+8 – перпендикулярно 

Для швидкого запуску попередньо призначених інструментів або макросів, працюючи 

з креслеником, деталлю, збіркою або ескізом є спеціальне графічне меню (інші назви: 

покажчик жестів миші або радіальне меню). Воно викликається перетягуванням в робочому 

полі покажчика миші, утримуючи праву кнопку натиснутою. За замовчуванням, жести миші 

включені, а в покажчику жестів миші відображаються лише чотири жести в залежності від 

місця роботи (ескіз, побудова 3D, збірка, кресленик): 

 

На рисунку вище в центрі графічного меню вказане відношення конкретного меню до 

типу побудови. В реальності це позначення в програмі не відображається. 

Також можна змінити кількість жестів миші, що відображаються в графічному меню 

миші (2, 3, 4, 8 або 12). При установці двох жестів можна орієнтувати їх по вертикалі або 

горизонталі. Види графічного меню за різної кількості задання жестів миші:  

 

2 жести миші по вертикалі 

 

2 жести миші по горизонталі 



 31 

 

3 жести миші 

 

4 жести миші 

 

8 жестів миші 

 

12 жестів миші 

Щоб увімкнути або вимкнути відображення жестів миші в графічному меню,  вибрати 

кількість жестів миші необхідно у відкритому документі в SolidWorks вибрати 

Tools > Customize (Інструменти > Налаштування). На вкладці Mouse gestures (Жести миші) 

потрібно встановити або видалити прапорець Enable mouse gestures (Увімкнути жести миші).  

Також тут можна налаштувати види жестів мишею за допомогою візуального 

перетягування інтерфейсу користувача. Перетягніть інструменти зі списку команд до будь-

якого списку жестів мишею. 

Контрольні запитання 

1. Навести алгоритм установки програми SolidWorks? 

2. Які  типи документів можна створити в програмі SolidWorks? 

3. Які розширення мають документи (файли) програми SolidWorks? 

4. Яким чином змінити напрям масштабування колесом миші? 

5. Яким чином змінити фон Графічної області? 

6. Де відображається інформація про поточну операцію, що виконується? 

7. Як виконувати масштабування в Графічній області за відсутності скроллера (колеса 

миші)? 

8. Як змінити величину значків в Диспетчері команд? 

9. Чи є різниця між напрямком руху курсора миші під час виділення об’єктів? 

10. Як називаються основні структурні елементи вікна програми SolidWorks? 
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Створення ескізів  

Типи ескізів 

Ескіз є основою для подальшої побудови тривимірної моделі. 

В програмі SolidWorks є можливість створити два типи ескізів: двовимірний та 

тривимірний. Для вибору типу ескізу можна скористатись інструментальною панеллю Sketch 

(Ескіз) в Диспетчері команд або в меню Insert > Sketch (Вставка > Ескіз) чи Insert > 

3D Sketch (Вставка > Тривимірний ескіз). 

  

Створення двовимірного ескізу 

Двовимірний ескіз (або просто Ескіз) Sketch є типовою основою для подальшого 

створення тривимірної моделі (деталі). Його особливістю є побудова на пласкій поверхні. В 

більшості випадків для подальшої побудови твердотільної моделі використовується саме 

двовимірний ескіз. Для побудови нового ескізу спочатку необхідно створити новий документ 

Part (Деталь). Також є можливість локальної побудови / добудови деталі через створення 

ескізу в Assembly (Збірці). Проте це більш як додаткова можливість, ніж типова методика 

побудови деталей. 

Ескіз можна побудувати на плоскій поверхні – площині (як на одній з головних площин: 

Front plane (Площина спереду), Top plane (Площина зверху) чи Right plane (Площина 

справа), так і створеній користувачем), сплайні на поверхні або на грані твердотільної моделі. 

Для створення нового двовимірного ескізу в документі Деталь (Part) необхідно: 

1. Натиснути Sketch (Ескіз)  на панелі інструментів Sketch (Ескіз)  в Диспетчері команд 

CommandManager або вибрати меню Insert > Sketch (Вставка > Ескіз). 
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2. Вибрати одну з трьох базових площин: 

Front plane (Площина спереду) – площина XY; 

Top plane (Площина зверху) – площина XZ; 

Right plane (Площина справа) – площина YZ.  

 

Крім базових площин можна обрати площину або грань твердотільної моделі, 

побудовані раніше користувачем.  

Порядок виконання операцій 1 та 2 можна поміняти місцями. Тобто спочатку вибрати 

місце побудови ескізу і вже потім обрати відповідну команду Sketch (Ескіз) . 
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3. Створити ескіз за допомогою відповідних інструментів на панелі інструментів Sketch 

(Ескіз)  або меню Tools > Sketch entities (Інструменти > Об’єкти ескізу) та 

Tools > Sketch tools (Інструменти > Інструменти ескізу). 

4. Вказати розміри об'єктів ескізу. Встановити взаємозв’язки та ступінь визначеності 

ескізу в цілому. 

Панелі інструментів двовимірного ескізу 

Інструментальні панелі для побудови ескізу активуються в Диспетчері команд при 

виборі вкладки Sketch (Ескіз) . 

 

Панель інструментів Sketch (Ескіз)  керує всіма аспектами створення ескізу за 

винятком сплайнів і блоків, для яких існують власні панелі інструментів. 

Панель інструментів Sketch (Ескіз) 

 

Всі елементи панелей інструментів Sketch (Ескіз): 

Іконка Назва (оригінал) Назва (переклад) 

 
Select Обрати   

 
Grid/Snap Масштабна сітка / Прив’язати   

 
Sketch or Exit Sketch Ескіз або Вихід із ескізу   

 
3D Sketch Тривимірний ескіз   

 
3D Sketch On Plane Тривимірний ескіз на площині   

 
Slicing Розрізання   

 
Rapid Sketch Швидкий ескіз   

 
Instant2D Instant2D  

 
Shaded Sketch Contours Зафарбовані контури ескізу   

 
Line Лінія   

 
Corner Rectangle Прямокутник з кута   

 
Center Rectangle Прямокутник із центру  

 
3 Point Corner Rectangle Прямокутник через 3 точки під кутом  

https://help.solidworks.com/2023/english/SolidWorks/sldworks/c_Select.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/HIDD_OPTIONS_GRID.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_sketching_sketch_entities_tool.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Exiting_Sketches.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Beginning_a_3D_Sketch.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/HIDD_DVE_SKETCH_3D_PLANE.htm#njz1450446538011
https://help.solidworks.com/2023/english/SolidWorks/sldworks/c_slicing_tool.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Using_RapidSketch.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Modifying_2D_Sketch_Dimension_Instant2D.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Extruding_Shaded_Sketch_Contours.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Sketching_Lines.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Sketching_Corner_Rectangles.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Sketching_Center_Rectangles.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Sketching_3_Point_Corner_Rectangles.htm
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3 Point Center Rectangle Прямокутник через 3 точки під кутом   

 
Parallelogram Паралелограм   

 
Straight Slot Пряма проріз   

 
Centerpoint Straight Slot Пряма проріз через центральну точку  

 
3 Point Arc Slot Проріз по дузі через 3 точки  

 
Centerpoint Arc Slot Проріз по дузі через центральну точку   

 Polygon Багатокутник   

 
Circle Коло  

 
Perimeter Circle Коло по периметру  

 
Centerpoint Arc Дуга зі вказівкою центра   

 
Tangent Arc Дотична дуга  

 
3 Point Arc Дуга через три точки  

 
Ellipse Еліпс  

 
Partial Ellipse Неповний еліпс  

 
Parabola Парабола  

 Conic Конічний переріз  

 
Spline Сплайн  

 
Style Spline Стиль сплайна  

 
Spline on Surface Сплайн на поверхні  

 
Equation Driven Curve Крива, керована рівнянням  

 
Point Точка  

 
Centerline Осьова лінія  

 
Midpoint Line Лінія середньої точки   

 Construction Geometry Допоміжна геометрія   

 
Text Текст   

 
Plane Площина  

 
Sketch Fillet Заокруглення   

https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Sketching_3_Point_Center_Rectangles.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Sketching_Parallelograms.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Sketch_Creating_Straight_Slot.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Sketch_Creating_Centerpoint_Straight_Slot.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Sketch_Creating_3_Point_Arc_Slot.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Sketch_Creating_Centerpoint_Arc_Slot.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Sketching_Polygons.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Sketching_Circles.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Sketching_Perimeter_Circles.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Sketching_Centerpoint_Arcs.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Sketching_Tangent_Arcs.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Sketching_3_Point_Arcs.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Sketching_Ellipses.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Sketching_Partial_Ellipses.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Sketching_Parabolas.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/c_Conics.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Creating_Multiple_Point_Splines.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/c_about_style_splines.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/c_Splines_on_Surfaces.htm#xbp1450446542727
https://help.solidworks.com/2023/english/SolidWorks/sldworks/c_equation_driven_curves.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Sketching_Points.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/c_Centerlines.htm#jwi1450446543206
https://help.solidworks.com/2023/english/SolidWorks/sldworks/c_midpoint_line_help.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/c_Construction_Geometry.htm#mhg1450446537562
https://help.solidworks.com/2023/english/SolidWorks/sldworks/c_Sketch_Text.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/HIDD_DVE_CREATE_PLANE_NEW.htm#okm1450446537947
https://help.solidworks.com/2023/english/SolidWorks/sldworks/c_Sketch_Fillets.htm
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Sketch Chamfer Фаска   

 
Offset Entities Зміщення об’єктів   

 
Offset On Surface Зміщення на поверхні   

 
Convert Entities Перетворити об’єкти  

 
Intersection Curve Ескіз вздовж перетину тіл   

 
Face Curves Криві грані   

 
Segment Сегмент  

 
Trim Entities Відсікти об’єкти   

 
Extend Entities Подовжити об’єкти   

 
Split Entities Розбити об’єкти   

 
Mirror Entities Дзеркально відобразити об’єкти   

 
Dynamic Mirror Entities Динамічне дзеркальне відображення 

об’єктів   

 
Move Entities Перемістити об’єкти   

 
Rotate Entities Повернути об’єкти   

 
Scale Entities Масштаб об’єктів   

 
Copy Entities Копіювати об’єкти   

 
Replace Entity Замінити об’єкти   

 
Stretch Entities Елементи ескізу   

 
Linear Sketch Pattern Лінійний масив ескізу   

 
Circular Sketch Pattern Круговий масив ескізу   

 
Make Path Створити шлях  

 
Modify Sketch Змінити ескіз   

 
No Solve Move Перемістити без рішення  решения  

 
Sketch Picture Картинка ескізу   

 
Sketch Numeric Input Числові вхідні дані для ескізу   

 
Sketch Dimension Driven Управляємий розмір ескізу   

https://help.solidworks.com/2023/english/SolidWorks/sldworks/c_Sketch_Chamfers.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/c_Offset_Entities.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Creating_Sketch_offsets_on_3D_Geometry_Surfaces.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/c_Convert_Entities.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/c_Intersection_Curves.htm#mgw1450446538823
https://help.solidworks.com/2023/english/SolidWorks/sldworks/c_Face_Curves.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_equidistant_points_and_segments.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/c_Trim_Entities.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Extend_Entities.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/c_split_entities.htm#nij1450446539827
https://help.solidworks.com/2023/english/SolidWorks/sldworks/c_Mirror_Entities.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/HIDD_DVE_SKETCH_DYNAMIC_MIRRORING.htm#zlx1450446540260
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Moving_or_Copying_Sketch_Entities.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Rotating_Sketch_Entities.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Scaling_Sketch_Entities.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Moving_or_Copying_Sketch_Entities.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/c_replace_sketch_entities.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Stretching_Sketch_Entities.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Creating_Linear_Sketch_Patterns.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Creating_Circular_Sketch_Patterns.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/c_Make_Path.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/HIDD_MODIFY_SKETCH.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Using_No_Solve_Move.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/c_Sketch_Picture.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_numeric_sketch_input.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Inserting_Reference_Dimensions.htm
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Add Dimension Додати розмір  

 

Insert Pen Sketch Вставити ескіз від руки   

 
Detach Segment On Drag Відв’язати сегмент при переміщенні   

 
Reverse Endpoint Tangent Реверс дотичної в кінцевій точці   

 
Dissolve Entities Роз’єднати об’єкти   

Об’єкти ескізу 

Sketch entities (Об’єкти ескізу) – геометричні примітиви. 

Обрати об’єкт ескізу можна через відповідну інструментальну панель на вкладці Sketch 

(Ескіз) в Диспетчері команд: 

 
Також Sketch entities (Об’єкти ескізу) можна обрати через меню Tools > Sketch entities 

(Інструменти > Об’єкту ескізу): 

 

https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Displaying_Dimensions.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/t_Using_Detach_Segment_On_Drag.htm
https://help.solidworks.com/2023/english/SolidWorks/sldworks/r_dissolve_smart_explode_lines.htm
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Sketch entities (Об’єкти ескізу): 

Іконка Назва Що будується 

 Line (Лінія) Лінія за двома точками 

 Centerline (Осьова лінія)  Осьова лінія за двома точками 

 
Midpoint line 

(Лінія середньої точки)  
Симетрична лінія із середньої точки лінії 

 Circle (Коло)  Коло з центру 

 
Perimeter circle 

(Коло по периметру)  
Коло по периметру за трьома точками 

 
Spline (Сплайн)  Закруглена лінія по точкам згину 

 Style spline (Сплайн стиля)   Заокруглена лінія між точками згину 

 

Spline on surface 

(Сплайн по поверхні) 
Заокруглена лінія на поверхні 

 

Equation driven curve 

(Крива, яка управляється 

рівнянням) 

Заокруглена лінія, траєкторія якої задається 

рівнянням 

 
Corner rectangle 

(Прямокутник по кутам)  
Прямокутник по двом вершинам одної діагоналі 

 
Center rectangle 

(Прямокутник з центру)  
Прямокутник з центральної точки та вершині 

 

3 point corner rectangle 

(Прямокутник через 3 

точки під кутом) 

Прямокутники через три вершини під заданим 

кутом 

 

3 point center rectangle 

(Прямокутник через 3 

точки з центру) 

Прямокутники з центральної точки, вершину та 

точку середини прямої під заданим кутом 

 

Parallelogram 

Паралелограм  
Паралелограм по трьом вершинам 

 

Centerpoint arc 

Центр дуги  

Дуга за центральною точкою, початковою та 

кінцевою точками 

 

Tangent arc  

(Дотична дуга)  
Дуга, дотична до інших об’єктів 

 
3 point arc  

(Дуга через 3 точки) 

Дуга за початковою, середньою та кінцевою 

точками 

 
Ellipse (Еліпс)  

Еліпс за трьома точками (центром, вершиною та 

довільною на кривій еліпса) 
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Partial ellipse 

(Неповний еліпс)  

Еліптична дуга з центральної, початкової та 

кінцевої точки, аналогічно створенню дузі із 

зазначенням центру 

 
Parabola (Парабола)  Парабола за центром та вершиною 

 Conic (Конічний переріз)  Криві другого порядку 

 
Straight slot  

(Пряма проріз)  
Проріз за допомогою двох кінцевих точок 

 

Centerpoint straight slot  

(Пряма проріз через 

центральну точку) 

Проріз від центральної точки 

 

3 point arc slot (Проріз по 

дузі через 3 точки)  

Проріз по дузі за допомогою трьох точок, 

розташованих уздовж дуги 

 

Проріз по дузі через 

центральну точку  

Проріз по дузі за допомогою центральної точки 

радіусу дуги та двох кінцевих точок 

 

Polygon 

(Багатокутник)  

Рівносторонні багатокутники, які матимуть від 3 

до 40 сторін 

 
Sketch fillet (Заокруглення) Заокруглення між двома відрізками 

 
Sketch chamfer (Фаска)  Фаска між двома об’єктами ескізу 

 Point (Точка)  Точка на ескізі 

 Text (Текст)  Текст на ескізі 

 
Plane (Площина)  Площина в ескізі 

Інструменти ескізу 

Sketch tools (Інструменти ескізу) – операції по редагуванню об’єктів ескізу. 

Обрати Sketch tools (Інструменти ескізу) можна через відповідну інструментальну 

панель на вкладці Sketch (Ескіз) в Диспетчері команд: 

 

 Також можна обрати через меню Tools > Sketch tools (Інструменти > Інструменти 

ескізу): 
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Sketch tools (Інструменти ескізу): 

Іконка Назва Призначення 

 
Trim entities 

(Відсікти об’єкти) 

Вибір типу відсікання та керування іншими 

параметрами відсікання. 

 
Extend entities 

(Подовжити об’єкти)  

Вибір типу подовження та керування іншими 

параметрами подовження. 

 

Convert entities 

(Перетворення об'єктів)  

Створити одну або декілька кривих в ескізі шляхом 

проектування кромки, петлі, грані, кривої, 

зовнішнього контуру ескізу, групи кромок або 

групи кривих ескізу на поверхню ескізу. 

 

Silhouette entities 

(Силуетні об’єкти)  

Побудова об'єктів ескізу, проекціюючи контур тіл у 

деталі або компонентах збірки на паралельну 

площину ескізу. 

 
Intersection curve 

(Ескіз вздовж лінії перетину 

тіл)  

Відкриває ескіз та створює намальовану криву при 

наступних типах перетинів: площина та поверхня 

або грань деталі, дві поверхні, поверхні та грані 
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деталі, площина та вся деталь, поверхня та вся 

деталь. 

 
Offset entities 

(Зміщення об’єктів)  

Зміщення одного чи декількох об’єктів ескізу на 

задану відстань. 

 
Offset on surface 

(Зміщення по поверхні)  

Зміщення кромок та граней моделі на поверхні та 

створення 3D-ескізу в моделі поверхні. 

 

Mirror entities 

(Дзеркально відобразити 

об’єкти)  

Для дзеркального відображення існуючих 

двовимірних об'єктів ескізу на площині. 

 
Linear sketch pattern 

(Лінійний масив ескізу) 
Створює лінійний масив ескізу, використовуючи 

елементи ескізу на площині або моделі. 

 
Circular sketch pattern 

(Круговий масив ескізу)  
Побудова по колу масиву елементів на площині або 

моделі з використанням елементів ескізу або 

кромки моделі для визначення масиву. 

 

Move entities  

(Перемістити об’єкти)  
Переміщає об'єкти шляхом вибору вихідних та 

кінцевих точок або за допомогою координат X та Y 

 
Copy entities 

(Копіювати об’єкти) 
Копіювання об'єктів шляхом вибору вихідних та 

кінцевих точок або використовуючи координати 

точки призначення X та Y. 

 
Rotate entities 

(Обертати об’єкти)  
Виконує поворот об'єктів шляхом вибору центру 

повороту та кута повороту у градусах. 

 
Scale entities 

(Масштабувати об’єкти)  
Виконує масштабування та копії об'єктів шляхом 

вибору Базової точки , Коефіцієнта 

масштабування  та, за необхідності, кількості 

копій. 

 
Stretch entities 

(Розтягнути об’єкти)  
Розтягує об'єкти шляхом вибору базових точок та 

перетягування або за допомогою координат точки 

призначення X та Y. 

 
Repair sketch 

(Виправити ескіз) 
Виконується пошук та, у деяких випадках, 

виправлення помилок ескізу. 

 

Rapid sketch 

(Швидкий ескіз) 
Дозволяє вибирати плоскі грані або площини та за 

допомогою будь-якого активного інструменту 

ескізу починати створення ескізу. При переміщенні 

до кожної плоскої грані програма створює площину 

та відкриває ескіз. Інструменти ескізу можна 

змінювати під час виконання операцій. 

 
Instant2D Активація режиму динамічного маніпулювання 

розмірами ескізу як ескізу. 

 

Shaded sketch contours 

(Зафарбовані контури 

ескізу) 

Можна переглядати закриті контури та підконтури 

ескізу як зафарбовані об'єкти. Зафарбовані контури 

ескізу можна перетягувати, змінювати їх розмір та 

застосовувати до них взаємозв'язки. Якщо вибрати 

параметр Зафарбовані контури ескізу, 

зафарбовуються лише закриті форми ескізу. Таким 

чином, простіше визначити, чи повністю закрита 

форма чи ні. 
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Розміри 

Dimensions (Розміри) – інструменти для нанесення розмірів на об’єкти ескізу. 

Обрати Dimensions (Розміри) можна через відповідну інструментальну панель на 

вкладці Sketch (Ескіз) в Диспетчері команд: 

 

Також можна обрати через меню Tools > Dimensions (Інструменти > Розміри): 
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Dimensions (Розміри): 

Іконка Назва Призначення 

 

Smart dimension 

(Розумний розмір) 

Нанесення розмірів, тип яких визначаються 

вибраними об’єктами ескізу. 

 

Auto Insert Dimension 

(Автоматичне нанесення 

розмірів) 

Нанесення розмірів на ескізі з автоматичним 

розпізнаванням типу об’єкта ескізу 

 
Horizontal dimension 

(Горизонтальний розмір) 
Задає горизонтальний розмір між двома об'єктами. 

 
Vertical dimension 

(Вертикальний розмір)  
Задає вертикальний розмір між двома об'єктами 

 

Baseline dimension  

(Розмір від базової лінії)  

Створення групи лінійних розмірів, виміряних в 

тому самому місці 

 

Chain dimension 

(Ланцюговий розмір) 

Створення групи розмірів, кожен наступний з яких 

починається від закінчення попереднього 

 

Symmetric linear diameter 

dimension (Симетричний 

лінійний розмір діаметра) 

Cтворення симетричних лінійних розмірів діаметра, 

для яких потрібна лише одна сторона виноски 

 

Ordinate dimension 

(Ординатний розмір)  

Проставляння розмірів, що починаються з нульової 

ординати у кресленні чи ескізі. У кресленнях є 

довідковими розмірами, тому їх значення не можна 

змінювати чи використовуватиме керування 

моделлю 

 

Horizontal ordinate 

dimension 

(Горизонтальний 

ординатний розмір)  

Створення горизонтальних ординатних розмірів у 

кресленні або ескізі, що починаються по 

горизонталі першого обраного об'єкта 

 

Vertical ordinate dimension 

(Вертикальний ординатний 

розмір)  

Створення вертикальних ординатних розмірів у 

кресленні чи ескізі, що починаються по вертикалі з 

першого вибраного об'єкта 

 

Angular Running 

Dimension (Ординатний 

кутовий розмір)  

Створення кутового ординатного розміру в 

градусах від обраного об’єкта. 

 
Path length dimension 

(Розмір довжини шляху)  

Створення компонувальних ескізів наприклад для 

верстатів. 

 

Chamfer Dimension 

(Розмір фаски) 

Задання розміру фасок з використанням різних 

типів тексту, виносок та розмірів знаку X. 

Також існує можливість автоматичного додавання розмірів та взаємозв’язків для 

повного визначення ескізу за допомогою команди Fully define sketch (Повністю визначений 

ескіз). Даний інструмент знаходиться на панелі інструментів Relations (Взаємозв’язки) 

вкладки Sketch (Ескіз) в Диспетчері команд. Також можна скористатись меню 

Tools > Dimensions > Fully define sketch (Інструменти > Розміри > Повністю визначити ескіз). 
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За замовчуванням розміри наносяться на об’єкти ескізу вже після їх побудови. Проте 

для зручності можна налаштувати в програмі SolidWorks так, щоб під час побудови об’єкта 

ескізу була можливість відразу вводити розмір цього об’єкта. 

Для цього необхідно поставити галочку в Tools > Options > System options > 

Sketch > Enable on screen numeric input on entity creation (Інструменти > Параметри > 

Параметри системи > Ескіз > Ввімкнути цифрове введення при створення об’єктів). 

Також можна поряд поставити галочку в Create dimension only when value is entered 

(Створювати розміри тільки якщо введені значення). Це дасть змогу автоматичного зникнення 

розмірних ліній якщо користувач не вводить значення розмірів. 

 

За таких налаштувань під час побудови об’єкту ескізу (ліній, кола, прямокутника тощо) 

відразу з’являтимуться відповідні розмірні лінії, в яких можна за допомогою клавіатури 

вводити значення розмірів. Якщо розміри не вводити, то розмірні лінії самі по собі 

зникатимуть по закінченню побудови об’єкта. 

Загалом, існують два типи розмірів: керуючі та керовані. Розміри, за якими 

відбувається побудова, називаються керуючими. А розміри, які не впливають на побудову і є 

довідковими, називаються керованими. Наприклад, керованим розміром буде той, що дублює 

інший, раніше проставлений. Керовані розміри відображається більш блідим кольором. 

Розглянемо приклад, наведений нижче, коли користувач пробує проставити останній 

замикаючий ланцюговий розмір 45 мм за існуючого загального (сумарного) в 120 мм. Розмір 

в 45 мм є «зайвим», адже він разом з іншими ланцюговими розмірами дасть в сумі 120 мм. В 

такому випадку ескіз набуде стану перевизначеності (Over defined). Тому під час 

проставляння розміру 45 мм у спливаючому вікні пропонується зробити цей розмір 

керованим, на противагу іншим керуючим. У разі погодження користувачем (правий рисунок) 

новий створений розмір в 45 мм стане керованим і буде відображатись більш блідим сірим 

кольором. Керовані ж розміри відображаються насиченим сірим кольором. 
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Якщо ж розмір в 45 мм зробити керуючим, обравши пункт Leave this dimension driving 

(Залишити розмір керуючим), то ескіз стане Over defined (Перевизначений).  

 

Для виправлення цього необхідно видалити один із ланцюгових розмірів або загальний  

(адже наразі всі вони рівнозначні керуючі). Також можна змінити статус одного з цих розмірів 

на керованого, натиснувши ЛКМ на розмірі та на вкладці Other (Інші) в Менеджері 

властивостей PropertyManager лівої панелі управління поставити галочку Driven 

(Керований). Інший варіант – натиснути ПКМ на розмірі та вибрати пункт Driven 

(Керований). 
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Взаємозв’язки 

Relations (Взаємозв’язки) – інструменти для задання правил між об’єктами ескізу для 

визначення взаємного розташування та обмеження можливості руху між ними. Взаємозв’язки 

є умовами, які визначальні за задання взаємного розташування декількох об’єктів ескізу. 

Наприклад, за допомогою взаємозв’язків можна задати вертикальне розташування лінії, 

паралельність чи перпендикулярність ліній, концентричність кіл, рівність довжини відрізків 

(ліній) тощо. 

Взаємозв’язки разом із розмірами визначають стан визначеності всього ескізу в цілому. 

Показати, видалити, додати взаємозв’язки можна через відповідну інструментальну 

панель на вкладці Sketch (Ескіз) в Диспетчері команд: 

  

Також дані команди можна обрати через меню Tools > Relations (Інструменти > 

Взаємозв’язки): 
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Опис команд: 

Іконка Назва Призначення 

 

Display/Delete relations 

(Відобразити / видалити 

взаємозв’язки) 

Відображає або приховує відображення, які 

накладені на об’єкти ескізу 

 

Add relation 

(Додати взаємозв’язок) 

Додає геометричні взаємозв'язки між об'єктами 

ескізу або між об'єктами ескізу та площинами, 

осями, крайками або вершинами 

 

Fully define sketch 

(Повністю визначений 

ескіз) 

Застосування розмірів та взаємозв'язків, отриманих 

під час розрахунків програми SolidWorks з метою 

повного визначення ескізів або вибраних об'єктів 

ескізу. Tools > Dimensions > Fully define sketch 

(Інструменти > Розміри > Повністю визначити 

ескіз) 

 

Automatic Relations 

(Автоматичні 

взаємозв’язки)  

Задає чи створюватимуться автоматичні 

геометричні взаємозв'язки під час створення 

об'єктів ескізу. 

 
Scan Equal  

Сканує в кресленнях лінії ескізу однакової довжини 

або дуги ескізу однакового радіуса. 

 

Isolate Changed 

Dimensions (Ізолювати 

змінені розміри)  

Функція, що дозволяє переглядати змінені розміри 

на вимогу, а не автоматично при відкриванні 

кресленика, що дає можливість переглядати змінені 

розміри тільки коли виникає необхідність. 

Також існує можливість автоматичного додавання розмірів та взаємозв’язків для 

повного визначення стану ескізу за допомогою команди Fully define sketch (Повністю 

визначений ескіз). Даний інструмент знаходиться на панелі інструментів Relations 

(Взаємозв’язки) вкладки Sketch (Ескіз) в Диспетчері команд. Також можна скористатись 

меню Tools > Dimensions > Fully define sketch (Інструменти > Розміри > Повністю визначити 

ескіз). 

Види взаємозв’язків 

Назва Вибрані об’єкти Призначення 

Horizontal 

(Горизонтальна) або 

Vertical (Вертикальна) 

Одна чи декілька ліній або 

дві чи декілька точок 

Лінії стають горизонтальними чи 

вертикальними. Точки вирівнюються по 

вертикалі чи горизонталі 

Collinear 

(Колінеарність) 

Дві чи декілька ліній Елементи лежать на одній і тій же 

нескінченній лінії 

Coradial 

(Корадіальність) 

Дві чи більше дуг В елементах використовуються одні й ті 

ж самі центр і радіус 

Perpendicular 

(Перпендикулярний) 

Дві лінії Два елементи перпендикулярні один 

одному 
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Parallel 

(Паралельно) 

Дві чи декілька ліній. Лінія і 

площина (чи пласка грань) в 

тривимірному ескізі 

Елементи паралельні один одному. 

Лінія паралельна до обраної площини 

Parallel YZ 

(Паралельно YZ) 

Лінія і площина (чи пласка 

грань) в тривимірному ескізі 

Лінія розташована паралельно площині 

YZ щодо обраної площини 

Parallel ZX 

(Паралельно ZX) 

Лінія і площина (чи пласка 

грань) в тривимірному ескізі 

Лінія розташована паралельно площині 

ZX щодо вибраної площини 

Along Z 

(Вздовж Z) 

Лінія і площина (чи пласка 

грань) в тривимірному ескізі 

Лінія розташована перпендикулярно до 

межі обраної площини 

Tangent 

(Дотична) 

Дуга, еліпс чи сплайн, і лінія 

чи дуга 

Два елементи залишаються дотичними 

один до одного 

Concentric 

(Концентричність) 

Дві або більше дуг, або точка 

і дуга 

Для дуг використовується один і той же 

центр 

Midpoint 

(Середня точка) 

Дві лінії або точка і лінія Крапка залишається в центрі лінії 

Intersection 

(Перетин) 

Дві лінії і одна точка Крапка залишається на перетині двох 

ліній 

Coincident 

(Співпадіння) 

Точка і лінія, дуг або еліпс Крапка лежить на лінії, дузі або еліпсі 

Equal 

(Рівно) 

Дві або більше ліній, або дві 

чи більше дуг 

Довжини ліній або радіуси залишаються 

рівними 

Equal curvature 

(Однакова кривизна) 

Два сплайна Радіус кривизни та вектор (напрямок) 

збігаються для двох сплайнів 

Symmetric 

(Симетричність) 

Осьова лінія і дві точки, лінії, 

дуги або два еліпси. 

Елементи залишаються на рівній відстані 

від осьової лінії, перпендикулярної до неї 

лінії 

Fix 

(Зафіксований) 

Любий об’єкт Фіксуються розмір та місцезнаходження 

об'єкта. Однак кінцеві точки нерухомих 

ліній можна вільно переміщати вздовж 

нескінченної лінії, що лежить унизу. Крім 

того, кінцеві точки дуги або еліптичного 

сегмента можна вільно переміщати 

вздовж повного кола або еліпса. 

Fix slot 

(Зафіксувати проріз) 

Прорізи в об’єктах ескізу Фіксуються розмір та місце 

розташування об'єкта 

Pierce 

(Точка пронизання) 

Точка ескізу і будь-яка вісь, 

край, лінія або сплайн. 

Точка ескізу збігається з місцем, де вісь, 

кромка чи крива пронизують площину 

ескізу. Взаємозв'язок «Точка 

пронизання» використовується в 
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елементах траєкторії з напрямними 

кривими 

Merge points 

(Злити точки) 

Дві точки ескізу чи кінцеві 

точки. 

Дві точки ескізу зливаються в одну точку 

Doubled distance 

(Подвоєна відстань) 

 

Осьова лінія та будь-який 

об'єкт ескізу. 

Для об'єкта ескізу задані розміри, які 

дорівнюють подвійній відстані від 

осьової лінії 

Equal slots 

(Рівні прорізи) 

Дві чи більше прорізів в 

об'єктах ескізу. 

Елементи мають однакову довжину та 

радіус 

On edge 

(На кромці) 

Кромки твердотільного 

елемента. 

Кромки твердотільного елемента 

проектуються на площину ескізу за 

допомогою інструмента Перетворення 

об'єктів  

On plane 

(На площині) 

Ескіз об'єкти на площині. Об'єкти ескізу розміщуються на площині 

On surface 

(На поверхні) 

Об'єкти ескіз на поверхні. Об'єкти ескізу розміщуються на поверхні 

Tangent to face 

(Дотичність до грані) 

Об'єкт ескізу та грань 

твердого тіла. 

Об'єкт ескізу та грань стикаються 

Traction 

(Тягове зусилля) 

Об’єкти ескізу Створення між об'єктами ескізу 

обмеження відносного обертання 

шляхом додавання взаємозв'язку 

"Дотичність" між блоками шківів або 

зірочок 

Torsion continuity 

(Безперервність 

кручення) 

Сплайн та один з наступних 

об'єктів: сплайн; дуга; 

конічна чи еліптична дуга; 

лінійні, кругові, конічні, 

параболічні, еліптичні або 

сплайнові кромки моделі. 

Об'єкти ескізу набувають взаємозв'язок 

гладкої безперервності з однаковою 

кривизною та однаковою швидкістю 

кривизни у загальній кінцевій точці 

Нанесення взаємозв’язків 

Для додання або перегляду існуючих взаємозв’язків необхідно обрати (виділити) один 

чи декілька об’єктів (елементів) ескізу. У вікні Менеджера властивостей PropertyManager 

з’явиться віконце показу обраних об’єктів ескізу Selected entities (Обрані об’єкти). Нижче 

відображається Existing relations (Існуючі взаємозв’язки) – перелік застосованих раніше 

наразі до цих об’єктів взаємозв’язків (пусте, якщо вони ще відсутні). Також ту будуть 

відображатись взаємозв’язки під час поточного вибору. У віконці Add relations (Додати 

взаємозв’язки) буде наведений повний перелік можливих для даного випадку взаємозв’язків.  
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Для видалення існуючого взаємозв’язку необхідно натиснути на відповідному об’єкті 

ескізу і в Менеджері властивостей PropertyManager обрати необхідний взаємозв’язок/-ки. 

Після цього натиснути клавішу Del.  

 

Також для видалення взаємозв’язку можна натиснути на його піктограму в графічній 

області і після цього на клавішу Del. 
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Відображення взаємозв’язків в графічній області можна налаштувати за допомогою 

Панелі інструментів керованого перегляду, активувавши або деактивувавши кнопку View 

sketch relations (Відображення взаємозв’язків ескізу). 

 

Швидкі прив’язки 

Quick snaps (Швидкі прив’язки) – інструменти для задання типу прив’язки ескізу, яка 

буде застосована за одну наступну операції. 

Вибрати вид Quick snaps (Швидкі прив’язки) можна через відповідну інструментальну 

панель на вкладці Sketch (Ескіз) в Диспетчері команд: 
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Також можна обрати через меню Tools > Relations > Quick snaps (Інструменти > 

Взаємозв’язки > Швидкі прив’язки): 
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Quick snaps (Швидкі прив’язки): 

Іконка Назва Призначення 

 
End points and sketch points 

(Прив’язка по точкам) 

Створювання прив'язок до точок для вибраних 

елементів під час створення ескізу 

 

Perpendicular 

(Перпендикулярна 

прив’язка) 

Створювання прив'язки однієї лінії до іншої  під час 

створення ескізу 

 

End points and sketch 

points (Прив’язати по 

центральним точкам) 

Створювання прив'язки до центру наступних 

об'єктів ескізу: кола, дуги, округлення, параболи та 

неповні еліпси під час створення ескізу 

 
Parallel 

(Паралельна прив’язка) 

Створювання прив'язки до центру наступних 

об'єктів ескізу: кола, дуги, округлення, параболи та 

неповні еліпси під час створення ескізу 

 

Midpoints 

(Прив’язка по середнім 

точкам) 

Виконується прив'язка до середніх точок ліній, 

багатокутників, прямокутників, паралелограмів, 

округлень, дуг, неповних еліпсів, сплайнів, точок, 

фасок та осьових ліній 

 

Horizontal/vertical lines 

(Прив’язка до 

горизонтальних/вертикальні 

ліній) 

Прив'язується лінія вертикально до існуючої 

горизонтальної лінії ескізу і горизонтально до 

існуючої вертикальної лінії ескізу 

 
Quadrant Points 

(Прив’язка квадранта) 

Виконується прив'язка до квадрантів кіл, дуг, 

округлень, парабол, еліпсів та неповних еліпсів 

 

Horizontal/vertical to points 

(Прив’язка по точкам 

горизонталі/вертикалі) 

Прив'язка лінії вертикально або горизонтально до 

існуючої точки ескізу 

 
Intersections 

(Прив’язка до перетину) 

Виконується прив'язка до перетинів об'єктів, що 

зустрічаються або перетинаються 

 
Length 

(Прив’язка до довжини) 

Прив'язка ліній до інкрементів, налаштованих за 

допомогою масштабної сітки, без відображення цієї 

сітки 

 
Nearest 

(Найближча прив’язка) 

Додання прив’язки всіх можливих для конкретного 

випадку і яка включаються, тільки якщо вказівник 

знаходиться поблизу точки прив'язки 

 
Grid 

(Прив’язка до узлів сітки) 

Прив'язка об'єктів ескізу до вертикальних та 

горизонтальних сегментів масштабної сітки. Це 

єдина прив'язка ескізу, яка не активна за 

умовчанням 
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Tangent 

(Дотична прив’язка) 

Виконується прив'язка до дотичних кіл, дуг, 

округлень, парабол, еліпсів, неповних еліпсів та 

сплайнів 

 
Angle 

(Прив’язка по куту) 
Виконується прив'язка до кутів 

Графічна область двовимірного ескізу 

Вікно SolidWorks під час побудови двовимірного ескізу: 

 

Графічна область цього вікна під час побудови двовимірного ескізу: 
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Тобто Графічна область – це динамічне робоче поле, в якому відбувається побудова 

ескізу, а також деталей, збірок, 2D-креслеників. Всі маніпуляції із розроблюваним об’єктом 

відразу відображаються в цій області. За побудови ескізу зображуються побудовані об’єкти, 

взаємозв’язки та нанесені розміри. 

У верхньому правому куті Графічної області поряд з панеллю задач розміщено кнопки 

виходу з побудови ескізу: зелена стрілка для підтвердження побудови та червоний хрестик для 

виходу із ескізу без збереження побудови в ньому.  

 

Кнопки мають приглушене забарвлення поки перебуваються в режимі очікування. При 

наведенні на кнопку курсору вона приймає яскравого забарвлення, що свідчить про її 

готовність виконати відповідну дію при натисканні лівої кнопки миші. Зелена стрілочка 

підтверджує виконану побудову і виходить з режиму Sketch (Ескізу). Червоний хрестик 

закриває цей режим без підтвердження виконаної побудови. 

В нижньому лівому куті розміщується динамічне зображення системи координат, за 

яким можна визначити поточну площину, наприклад: 

 

Стани визначеності ескізу 

Стани визначеності ескізу: 

Назва стану визначеності Опис стану визначеності 

Under Defined 

(Недовизначений) 

Деякі розміри або співвідношення в ескізі не 

визначені та можуть бути змінені.  

Fully Defined 

(Повністю визначений) 

Усі лінії та криві на ескізі та їх положення 

описуються розмірами чи 

співвідношеннями, або тим і іншим. 

Over Defined 

(Перевизначений) 

Деякі виміри або відносини, або обидва, або 

конфліктують, або є зайвими. 

No Solution Found 

(Рішення не було знайдено) 

Ескіз не вирішений. Відображаються 

геометрія, співвідношення та розміри, які 

перешкоджають розв’язанню ескізу. 

Invalid Solution Found 

(Знайдено недопустиме рішення) 

Ескіз розв’язується, але в результаті 

виходить недійсна геометрія, наприклад 

лінія нульової довжини, дуга нульового 

радіуса або сплайн, що перетинає себе. 
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Стан визначеності ескізу вказується в правій частині Рядка стану внизу вікна програми 

SolidWorks біля вказівкою поточної операції. На прикладі нижче стан визначеності ескізу 

Fully Defined (Повністю визначений):  

 

 Про стан визначеності також свідчить наявність знаку оклика в трикутнику  в 

Дереві конструювання перед назвою ескізу. 

Поряд трикутника стоїть знак «+» якщо ескіз перевизначений і знак «-» якщо 

недовизначений. 

Приклад позначення ескізу з назвою «Sketch1» стану Over Defined (Перевизначений) в Дереві 

конструювання: 

 

Колір розмірів, взаємозв’язків та об’єктів ескізу різниться в залежності від їх стану в 

ескізі: 

Колір Статус цих елементів в ескізі 

Синій Недовизначені 

Чорний Повністю визначені 

Жовтий Перевизначені 

Червоний Конфліктні (суперечать один одному) 

Коли в ескізі всі його елементи стануть чорного кольору, тоді ескіз перейде в статус 

Fully Defined (Визначений). 

Нижче наведено приклад вікна SolidWorks під час побудови ескізу стану Over Defined 

(Перевизначений). 
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В наведеному вище прикладі в ескізі існує два розміри по 80 мм, які, по суті, дублюють 

один одного. Адже при наявних взаємозв’язках Горизонтальність та Вертикальність, 

накладених на лінії фігури, ці розміри мають бути однаковими. І задання обох цих розмірів з 

точки зору визначеності ескізу є зайвим. В даному випадку достатньо видалити один із 

розмірів у 80 мм і ескіз набуде статусу Fully Defined (Повністю визначений). 

Для виправлення даного ескізу та переведення всіх його елементів в стан Fully Defined 

(Повністю визначений) необхідно видалити один з дублюючих розмірів у 80 мм: 
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Також для полегшення виправлення перевизначених ескізів в програмі SolidWorks 

існує додатковий інструмент ScetchXpert. Для його активації в режимі редагування ескізу 

необхідно натиснути внизу вікна в Рядку стану на позначенні стану ескізу Over Defined 

(Перевизначений). 

 

ScetchXpert запускається в Диспетчері властивостей PropertyManager та має дві 

основні кнопки: Diagnose (Діагностувати) та Manual repair (Виправлення вручну). 

 

Кнопка Diagnose (Діагностувати) запускає автоматичний пошук рішень для 

виправлення ескізу та шляхи їх реалізації. Є можливість переглянути варіанти знайдених 

рішень з можливістю їх вибору для автоматичного виправлення ескізу, натиснувши кнопку 

Accept (Приймаю). 
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Кнопка Manual repair (Виправлення вручну) видає список всіх розмірів та 

взаємозв’язків, які задіяні в створенні протиріччя, через яке ескіз став перевизначеним. Є 

можливість їх обрання та видалення. 

 

Також для полегшення досягнення стану ескізу Fully Defined (Повністю визначений) 

існує можливість автоматичного додавання розмірів та взаємозв’язків за допомогою команди 

Fully define sketch (Повністю визначений ескіз). Даний інструмент знаходиться на панелі 

інструментів Relations (Взаємозв’язки) вкладки Sketch (Ескіз) в Диспетчері команд. Також 

можна скористатись меню Tools > Dimensions > Fully define sketch (Інструменти > Розміри > 

Повністю визначити ескіз). 

Візьмемо для прикладу попередній ескіз без проставлених розмірів і оберемо команду 

Fully define sketch (Повністю визначити ескіз). 

Диспетчер властивостей та вікно SolidWorks в цілому набуває такого виду: 
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В цій панелі є можливість вибору всіх об’єктів ескізу або обраних вручну. З останніх 

можна вибрати види взаємозв’язків, характер додання горизонтальних та вертикальних 

розмірів, задання місця розташування розмірів. Оберемо варіант All entities in sketch (Всі 

об’єкти в ескізі), натиснемо Calculate (Обчислити) та отримаємо такий результат: 

 

Як видно з рисунку, на ескізі з’явилися розміри і ескіз набув стану Fully Defined 

(Повністю визначений). 
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Система вимірів 

В програмі SolidWorks одиниці розмірностей, в яких задаються розміри, залежать від 

обраної системи вимірів: СІ (MKS), Англійська (IPS) або Метрична (G). Обрати та 

налаштувати систему вимірів можна через меню Tools > Options > Document properties > 

Unit system (Інструменти > Параметри > Властивості документів > Одиниці виміру > Система 

одиниць виміру): 

 

Поточна системи вимірювань відображається в Рядку стану справа. Натискання на ній 

відкриває вікно швидкого вибору системи вимірювання або її налаштування: 
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Натискання на пункт Edit document units (Редагуванням одиниць вимірювання 

документу) аналогічне вище наведеній команді через меню Tools > Options > 

Document properties > Unit system (Інструменти > Параметри > Властивості документів > 

Одиниці виміру > Система одиниць виміру). 

Контрольні запитання 

1. Які існують типи ескізів в програмі SolidWorks? 

2. Яка лінія є допоміжною при побудові ескізу? 

3. Що таке об’єкти ескізу? 

4. Чи можна будувати незамкнуті області в ескізі? 

5. Які бувають взаємозв’язки? 

6. Чим відрізняються швидкі прив’язки від звичайних? 

7. Чи обов’язково необхідно, щоб ескіз мав повністю визначений стан? 

8. Як виправити перевизначений ескіз до стану повністю визначеного? 

9. Який існує інструмент редагування ескізу якщо той має перевизначений стан? 

10. Чи можна в автоматичному режимі проставити всі розміри та взаємозв’язки? 

11. Яким чином видалити існуючи взаємозв’язки? 

12. Як змінити систему виміру на ескізі? 

13. Як прибрати відображення нецілих значень розмірів? 

14. Що таке інструменти ескізу та які вони бувають? 

15. Що таке вихідна точка? 
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3D-проектування: створення деталей 

Інтерфейс при створенні документу типу Деталь 

Вікно програми SolidWorks під час побудови 3D-моделі деталі: 

 

Основною інструментальною панеллю в Диспетчері команд CommandManager під 

час побудови твердотільної моделі є панель інструментів Features (Елементи).  

 

Панель інструментів Features (Елементи) містить інструменти для створення елементів 

моделі. 

Іконка Назва Призначення 

 

Extruded Boss/Base 

(Витягнута бобишка/основа) 

Видовження ескізу або обраних його контурів в 

одному чи декількох напрямках для створення 

твердотільного елемента 

 

Revolved Boss/Base 

(Повернута бобишка/основа) 

Обертання ескізу або обраних його контурів в 

одному чи декількох напрямках для створення 

твердотільного елемента 

 

Swept Boss/Base 

(Бобишка/основа по траєкторії) 

Витягує замкнутий профіль вздовж розімкнутої 

або замкнутої траєкторії для створення 

твердотільного елементу 
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Lofted Boss/Base 

(Бобишка/основа по перерізам) 

Створює елемент шляхом побудови переходів 

між профілями. Елемент перерізів може бути 

основою, бобишкою, вирізом або поверхнею 

 

Boundary Boss/Base 

(Бобишка на межі/основа) 

Додає матеріал між двома профілями в двох 

напрямках для створення твердотільного 

елементу. 

 

 Thicken 

(Надати товщину) 

Створює твердотільний елемент шляхом 

надання товщини одній або декільком сусіднім 

поверхням 

 

Extruded Cut 

(Витягнутий виріз) 

Створює виріз твердотільної моделі шляхом 

витягування нарисованого профіля в одному 

або двох профілях 

 

Revolved Cut 

(Повернутий виріз) 

Створює виріз твердотільної моделі шляхом 

обертання нарисованого профіля навколо осі 

 

Swept Cut 

(Виріз по траєкторії) 

Створює виріз твердотільної моделі шляхом 

витягування замкнутого профілю вздовж 

відкритої або замкнутої траєкторії 

 

Lofted Cut 

(Виріз по перерізам) 

Створює виріз твердотільної моделі шляхом 

видалення матеріалу між двома або декількома 

профілями 

 

Boundary Cut 

(Виріз по межі) 

Створює виріз твердотільної моделі шляхом 

видалення матеріалу між профілями в двох 

напрямках 

 

Thickened Cut 

(Потовщений виріз) 

Створює визріз деталі шляхом потовщення 

поверхні 

 

Cut with Surface 

(Виріз з поверхнею) 

Створює виріз деталі шляхом накладання іншої 

поверхні 

 

Fillet 

(Заокруглення) 

Створює округлену внутрішню чи зовнішню 

грань на деталі. Можна заокруглити всі краї 

грані, вибрані безлічі граней, вибрані кромки 

або петлі 

 

Chamfer 

(Фаска) 

Створює скіс на вибраних кромках, гранях чи 

вершині 

 

Rib 

(Ребро) 

Додає матеріал заданої товщини в заданому 

напрямку між контуром та існуючою деталлю 

 

 Scale 

(Масштаб) 

Змінює масштаб деталі чи поверхні у сфері її 

центроїди чи системи координат 

 

 Shell 

(Оболонка) 

Робить деталь порожнистою, залишаючи 

відкритими вибрані грані та створюючи 

тонкостінні елементи на інших гранях. 
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Якщо на моделі не вибрано жодну грань, можна 

створити оболонку твердотільної деталі, тим 

самим створивши замкнуту порожнисту 

модель. Можна створити оболонку моделі з 

використанням кількох значень товщини 

 

Draft 

(Уклон) 

Загострює вибрані грані моделі під заданим 

кутом (додає ухил моделі) 

 

Move Face 

(Перемістити грань) 

Виконує зміщення, перетворення та поворот 

граней та елементів безпосередньо у 

твердотільних моделях або моделях поверхонь 

 

Simple Hole 

(Простий отвір) 

Створює простий отвір і задає його положення 

 

Hole Wizard 

(Отвір під кріплення) 

Створює такі типи отворів під кріплення: 

цековка, зенківка, отвір, мітчик, трубне 

різьблення, попередня версія 

 

Advanced Hole 

(Додатковий отвір) 

Визначити додаткові отвори на передній та 

задній гранях 

 

Thread 

(Різьба) 

На циліндричних кромках або гранях створює 

спіральне різьблення 

 

Hole Series 

(Група отворів) 

Створення ряду отворів в окремих деталях 

збірки 

 

Dome 

(Купол) 

Створює купол на вибраних гранях, центроїди 

яких лежать поза межами граней. Це дозволяє 

застосувати куполи до контурів з 

неправильною формою 

 

Freeform 

(Вільна форма) 

Використовується для зміни граней поверхні чи 

твердих тіл. Одночасно можна змінити лише 

одну грань, яка може мати будь-яку кількість 

сторін 

 

Deform 

(Деформувати) 

Для зміни форми складних поверхонь або 

твердотільних моделей локально чи глобально, 

не беручи до уваги ескізи або обмеження 

елементів, що використовуються для створення 

моделей. 

 

Indent 

(Відступ) 

Створення виїмки відступу або виступу, що 

точно збігається з контуром вибраного тіла 

інструменту. Це відбувається за допомогою 

значень товщини та зазору. 

 

Flex 

(Згин) 

Для деформування складних моделей та 

створення одного з чотирьох типів вигину: 

згинання, поворот, загострення, розтягування 
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Wrap 

(Перенесення) 

Перенесення ескізу на існуючу поверхню 

 

Live Section Plane 

(Площина розрізу в реальному 

часі) 

Дозволяє динамічно розрізати моделі, 

використовуючи будь-яку площину. 

 

Model Break View 

(Вид моделі із розривом) 

Використовуються, коли потрібно вкоротити 

компоненти моделі, особливо для технічної 

документації та маркетингових цілей 

 

Instant3D 

(Instant3D) 

Створення та змінювання геометрії моделі, 

використовуючи маркери та лінійки 

 

Suppress 

(Погасити) 

Для тимчасового виключення з моделі (але не 

видалення). Елемент зникає з виду моделі та 

відображається сірим кольором у Дереві 

конструювання FeatureManager.  

 

Unsuppress 

(Відміна погашення) 

Відміняє команду Погасити. Включає модель в 

побудову, кольори стають як і до погашення 

 

Unsuppress with Dependents 

(Висвітлити із залежними  

елементами) 

Щоб висвітлити елемент та його залежні 

елементи. Вибраний елемент та всі залежні від 

нього елементи повернуться до моделі 

 

Linear Pattern 

(Лінійний масив) 

Для створення декількох екземплярів одного 

або декількох елементів, які можна розмістити 

на однаковій відстані вздовж однієї чи двох 

траєкторій 

 

Circular Pattern 

(Круговий масив) 

Для розміщення одного або кількох елементів 

навколо осі 

 

Mirror Feature 

(Дзеркальне відображення) 

Для створення копії одного або кількох 

елементів, дзеркально відбитих щодо грані чи 

площини 

 

Curve Driven Pattern 

(Масив, що управляється 

кривою) 

Для створення елемента нового масиву, 

керованого кривою або під час редагування 

існуючого елемента масиву, керованого 

кривою 

 

Sketch Driven Pattern 

(Масив, що управляється 

ескізом) 

Моделює нові компоненти, використовуючи 

двовимірні або тривимірні ескізи з точками 

ескізу, а також допоміжною геометрією 

 

Table Driven Pattern 

(Масив, що управляється 

таблицею) 

Для створення масиву елементів за допомогою 

координат з таблиці. Вихідна точка системи 

координат стає вихідною точкою таблиці 

параметрів, а осі X і Y визначають площину, в 

якій з'являється масив 
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Fill Pattern 

(Зразок заповнення) 

Дозволяє вибрати область, визначену гранями 

копланарними або ескізом, який розташований 

на копланарних’ гранях. Ця команда заповнює 

певну область масивом елементів або 

заздалегідь заданою формою вирізу 

 

Variable Pattern 

(Масив, що управляється 

розміром) 

Створення змінного масиву на плоскій або не 

плоскій поверхні, а також змінити розмірності 

та посилання на кожен екземпляр масиву 

 

Split 

(Розділити) 

Для поділу деталей на кілька тіл 

 

Intersect 

(Перетнути) 

За допомогою інструмента можна перетинати 

чи об'єднувати поверхні, площини та тверді тіла 

 

Combine 

(Скомбінувати) 

Для отримання багатотільної деталі 

 

Join 

(З’єднати) 

Визначаються тіла багатотільної деталі, які 

додаються, віднімаються або перекриваються 

 

Delete/Keep Body 

(Видалити/Зберегти тіло) 

Дає змогу вибирати тіла для збереження та 

видалення. Ця функція корисна під час роботи 

з багатотільними деталями, які мають кілька 

конфігурацій 

 

Heal Edges 

(Виправити кромки) 

Редагує декілька кромок, зокрема об’єднує 

декілька кромок в одну 

 

Imported Geometry 

(Імпортована геометрія) 

Як довідкову геометрію до документів деталей 

можна імпортувати поверхні, тверді тіла, 

ескізи, криві та графічні моделі (тільки файли 

CATIA CGR, STL або VRML) з файлів ACIS, 

CATIA CGR, IGES, Parasolid, Pro/Engineer, 

STEP, STL, VDAFS або VRML. Буде виконано 

імпорт одного або кількох елементів, і 

Імпортовані елементи будуть додані до деталей. 

Елементи розміщуються відносно вихідної 

точки, використовуючи координати 

імпортованого файлу. 

 

Insert Part 

(Вставити деталь) 

Для вставлення базової деталі в документ іншої 

деталі 

 

Move/Copy Bodies 

(Перемістити/копіювати тіла) 

У багатотільних деталях дозволяє переміщати, 

та копіювати тверді тіла та тіла поверхні  

 

Recognize Features 

(Розпізнавання елементів) 

Розпізнає елементи на твердотільному 

елементі, що імпортується, в документі деталі 

SOLIDWORKS 
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FeatureWorks Options 

(Параметри FeatureWorks) 

Дозволяє налаштувати параметри 

FeatureWorks та задати значення за 

замовчуванням 

 

Grid System 

(Система сіток) 

Для побудови системи сіток великих об'єктів 

 

Convert to Mesh Body 

(Перетворити в тіло сітки) 

Перетворює на тіло сітки BREP стандартне тіло 

SOLIDWORKS або графічне тіло 

 

3D Texture 

(3D-текстура) 

Перетворює текстурований зовнішній вид 

деталей у 3D-геометрію 

 

Segmented Imported Mesh 

Body 

(Сегментоване тіло сітки 

імпорту) 

Використовується для групування фасетів тіла 

сітки BREP у грані, пов'язані гострими кутами, 

плоскими поверхнями та циліндричними 

гранями 

Інструменти панелі Features (Елементи) також можна відкрити через меню Insert 

(Вставка): 

 

Основні інструменти побудови твердотільної моделі 

Для додавання матеріалу в модель: 

1. Витягнута бобишка/основа. 
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2. Повернута бобишка/основа. 

3. Бобишка/основа по траєкторії. 

4. Бобишка/основа по перерізам. 

5. Бобишка/основа по межі. 

Для видалення матеріалу з твердотільної моделі: 

1. Витягнутий виріз. 

2. Повернутий виріз. 

3. Виріз по траєкторії. 

4. Виріз по перерізам. 

5. Виріз по межі. 

6. Потовщений виріз. 

7. Виріз з поверхнею. 

Тобто інструменти типу Boss (Бобишка). призначені для створення твердотільної 

моделі та наданні їй матеріалу. Слово «Основа» в назві команди означає, що інструмент 

призначений для створення елементарних, базисних елементів твердотільної моделі, що 

лежать в основі її побудови. 

Відповідно основні інструменти для видалення матеріалу із вже побудованої повністю 

або частково твердотільної моделі – це інструменти типу Cut (Виріз). 

Інструменти типу Boss (Бобишка) на початку побудови не активні (відображаються 

сірим блідим кольором). Активуються іконки інструментів (отримують більш насичене 

різнокольорове забарвлення) після створення ескізів або профілів, які необхідні для побудови 

твердотільної моделі за допомогою Boss (Бобишка). Також це стосується і інструментів типу 

Cut (Виріз). 

 

Алгоритм побудови твердотільної моделі типу Part (Деталь) 

1. Створення файлу типу Part (Деталь) з розширенням .SLDPRT. 

2. Обрати одну з основних площин Front plane, Top plane, Right plane (Спереду, Зверху 

чи Справа). 

3. Побудувати ескіз основи твердотільної моделі. 

4. Застосувати один із інструментів панелі Features (Елементи) для створення 

твердотільної моделі (або її частини). 

5. За необхідності закінчити побудову твердотільної моделі шляхом побудови ескізів та 

використовуючи команди надання об’єму (нарощування або зменшення матеріалу). 

6. Задати інші параметри твердотільної моделі (колір, блиск, матеріал тощо). 

7. Зберегти файл після закінчення побудови твердотільної моделі. 

Інструмент Витягнута бобишка / основа 

Інструмент Extruded Boss/Base (Витягнута бобишка / основа) призначена для 

побудови твердотільного елемента шляхом видовження заданого контуру з можливістю 

задання нахилу та зробити модель тонкостінною. Це можуть бути як прості тіла типу циліндр, 

куб, паралепіпед, а в разі задання нахилу – зрізаний конус, піраміда, так і тіла складного 

перерізу.  
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Додатково в інструменті Extruded Boss/Base (Витягнута бобишка / основа) є 

можливість задати пустотілість та тонкостінність, або зробити твердотільний елемент із 

уклоном. 

Алгоритм типової побудови елементарної твердотільної моделі за допомогою 

інструменту Extruded Boss/Base (Витягнута бобишка / основа): 

1. Побудувати ескіз на одній із поверхонь: 

а.  на одній із основних площин Front plane, Top plane, Right plane (Спереду, Зверху 

чи Справа); 

б. на створеній раніше додатковій площині; 

в.  на грані (поверхні) побудованої до цього твердотільної моделі. 

2. Обрати інструмент Extruded Boss/Base (Витягнута бобишка / основа): 

а.  на інструментальній панелі Features (Елементи) в Диспетчері команд; 

б. в меню Insert / Boss/Base / Extrude … (меню Вставка / Бобишка/ основа / 

Витягнути…). 

3. Виділити ескіз в Дереві конструювання або безпосередньо в Графічній області. 

Якщо ескіз залишився виділеним на стадії пункту 1, то він автоматично буде обраним 

для подальшої побудови. 

4. Задати налаштування побудови в Диспетчері властивостей: 

а. обрати місце побудови  (ескіз, поверхню, грань, площину, вершину, зі зміщенням); 

б. напрямок та відстань (на задану відстань, до вершини, поверхні, на відстань від 

поверхні, до тіла, середня площина); 

в. значення кута нахилу (за необхідності); 

г. значення тонкостінності (за необхідності); 

5. Підтвердити побудову, натиснувши в Диспетчері властивостей кнопку ОК (зелену 

галочку). 

Приклад побудови по ескізу в два напрямки від нього на відстані 88 мм та 100 мм із 

заданням кута нахилу в 5 градусів в обидва напрямки без тонкостінності: 
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Якщо в ескізі всередині зовнішнього профілю буде ще один чи декілька замкнутих 

профілів, то вони будуть сприйматись в побудові як наскрізні отвори. Наприклад: 

Ескіз Твердотільна модель 

 
 

Якщо зовнішній контур в ескізі буде незамкнутим, тоді твердотільна модель 

автоматично буде будуватись як тонкостінна із можливістю редагування товщини стінки. 

Наприклад: 

Ескіз Твердотільна модель 

 

 

Для редагування виконаних операцій за допомогою інструменту Extruded Boss/Base 

(Витягнута бобишка / основа) необхідно обрати її в Дереві конструювання або натиснути 

ЛКМ на побудованій за допомогою цієї команди твердотільній моделі та у спливаючому 

графічному меню обрати Edit features (Редагувати визначення). Для редагування вихідного 

ескізу поряд є іконка Edit sketch (Редагувати ескіз). 

Також аналогічне графічне меню спливає, якщо натиснути ПКМ на твердотільній 

моделі в Графічній області. 

Instant3D 

По замовчуванню в SolidWorks ввімкнутий інструмент Instant3D. Завдяки цьому після 

виділення твердотільної моделі відображаються її розміри, які можна редагувати шляхом 

натискання ЛКМ на них. Після введення нового значення розміру модель перебудується. 
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Інструмент Повернута бобишка / основа 

Інструмент Revolved Boss/Base (Повернута бобишка/основа) призначена для побудови 

твердотільної моделі обертання, що має вісь обертання. Це можуть бути прості тіла типу 

сфера, тороїд, гіперболоїд, циліндр, конус, так і складного перерізу. 

На практиці цей інструмент також особливо поширений для побудови деталі типу 

«вал». 

Для створення ескізу тіла обертання необхідні два елемента: контур та вісь обертання, 

навколо якого буде задаватись його обертання. Якщо контур буде незамкнутий, тоді тіло 

обертання обов’язково буде тонкостінним із заданою товщиною стінки: 

Ескіз Твердотільна модель 

 

 

В ескізі осьова лінія не замикає контур. В такому випадку під час операції Revolved 

Boss/Base (Повернута бобишка/основа) виникне попередження та буде запропоновано 
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автоматично замкнути контур в ескізі. При відмові із такого незамкнутого контуру буде 

можливість лише побудови тонкостінної моделі із заданою товщиною. 

Для створення ескізу вісь обертання (осьова лінія) не обов’язково повинна лежати на 

одній висоті із контуром моделі: 

Ескіз Твердотільна модель 

  

Алгоритм типової побудови елементарної твердотільної моделі за допомогою 

інструменту Revolved Boss/Base (Повернута бобишка/основа): 

1. Побудувати ескіз на одній із поверхонь: 

а.  на одній із основних площин Front plane, Top plane, Right plane (Спереду, Зверху 

чи Справа); 

б. на створеній раніше додатковій площині; 

в. на грані (поверхні) побудованої до цього твердотільної моделі. 

2. Обрати інструмент Revolved Boss/Base (Повернута бобишка/основа): 

а.  на інструментальній панелі Features (Елементи) в Диспетчері команд; 

б. в меню Insert > Boss/Base > Revolve… (Вставка / Бобишка/основа / Повернути…). 

3. Виділити ескіз в Дереві конструювання або безпосередньо в Графічній області. 

Якщо ескіз залишився виділеним на стадії пункту 1, то він автоматично буде обраним 

для подальшої побудови. 

4. Задати налаштування побудови в Диспетчері властивостей: 

а. обрати (або проконтролювати автоматичний вибір) осі обертання; 

б. обрати напрямок та, в разі необхідності, відстань (на задану відстань, до вершини, 

до поверхні, на відстань від поверхні, середня площина) для напрямку 1; 

в. обрати напрямок та, в разі необхідності, відстань (на задану відстань, до вершини, 

до поверхні, на відстань від поверхні, середня площина) для напрямку 2 – за умови 

обрання типу «середня площина» в пункті «б»; 

г. параметри для створення тонкостінного елемента (за необхідності); 

д. обрати (або проконтролювати автоматичний вибір) обраних контурів обертання. 

5. Підтвердити побудову, натиснувши в Диспетчері властивостей кнопку ОК (зелену 

галочку). 

Приклад побудови тіла обертання типу «тороїд»: 
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Інструмент Бобишка / основа по траєкторії 

Інструмент Swept Boss/Base (Бобишка/основа по траєкторії) витягує замкнутий 

профіль вздовж розімкнутої або замкнутої траєкторії для створення твердотільного елементу. 

Для створення більшої різноманітності форм в Диспетчері властивостей можна 

використовувати такі можливості як направляючі криві, параметри орієнтації та повороти. 

Алгоритм типової побудови елементарної твердотільної моделі за допомогою 

інструменту Swept Boss/Base (Бобишка/основа по траєкторії): 

1. Побудувати ескіз в одній чи декількох площинах. 

2. Обрати інструмент Swept Boss/Base (Бобишка/основа по траєкторії): 

а.  на інструментальній панелі Features (Елементи) в Диспетчері команд; 

б. в меню Insert > Boss/Base > Sweep (Вставка / Бобишка/основа / Прокотити…). 

3. Задати налаштування побудови в Диспетчері властивостей: 

а. обрати ескіз профілю, що задає переріз моделі; 

б. обрати круговий профіль (ескіз траєкторії); 

в. налаштування тонкостінності (напрямок задання товщини та  її значення); 

г. за необхідності інші налаштування (кривизну, дотичність, визначити направляючі 

криві, орієнтацію та скручування профілей). 

4. Підтвердити побудову, натиснувши в Диспетчері властивостей кнопку ОК (зелену 

галочку). 

Приклад побудови трубопроводу за допомогою Swept Boss/Base (Бобишка/основа по 

траєкторії): 
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Як видно з рисунку, для створення пустотілості в Менеджері властивості була 

поставлена галочка біля команди Thin features (Тонкостінний елемент) із заданням товщини 

стінки в 20 мм. В разі задання тонкостінності об’єкт буде мати наскрізний внутрішній отвір. 

Ескізи для твердотільної моделі з рисунку вище: 

Ескіз профілю Ескіз кругового профілю 

(траєкторії) 

Поєднання ескізів 
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Результат побудови: 

Оригінальна побудова Внутрішня будова отриманої моделі 

 
 

Інструмент Бобишка/основа по перерізам 

Інструмент Lofted Boss/Base (Бобишка/основа по перерізам) створює твердотільні 

моделі шляхом додання матеріалу між двома або більше профілями. Точками може бути 

перший, останній або перший і останній профілі. Відповідно, точками не можуть бути 

проміжні профілі. 

Алгоритм типової побудови елементарної твердотільної моделі за допомогою 

інструменту Lofted Boss/Base (Бобишка/основа по перерізам): 

1. Побудувати ескіз на двох чи більше площинах чи інших поверхнях. 

2. Обрати інструмент Lofted Boss/Base (Бобишка/основа по перерізам): 

а.  на інструментальній панелі Features (Елементи) в Диспетчері команд; 

б. в меню Insert > Boss/Base > Loft… (Вставка / Бобишка/основа / По перерізам…). 

3. Задати налаштування побудови в Диспетчері властивостей: 

а. обрати ескіз профілю, що задає переріз моделі (якщо ще не було обрано); 

б. налаштування тонкостінності (напрямок задання товщини моделі та  її значення); 

в. за необхідності обрати профіль осьової лінії. 

4. Підтвердити побудову, натиснувши в Диспетчері властивостей кнопку ОК (зелену 

галочку). 

Для зручності побудови для її наглядності в Диспетчері властивостей за 

замовчуванням стоїть галочка Show preview (Попередній перегляд). 

Приклад побудови деталі за допомогою Lofted Boss/Base (Бобишка/основа по 

перерізам) тіла, утвореного з чотирьох профілей (три кола та квадрат), що розташовані на 

площині Top plane (Зверху) та трьох допоміжних паралельних їй площинах: 



 77 

 

Профілі та результат побудови твердотільної моделі: 

Профілі Результат побудови 

 
 

Для побудови також можна вказати осьову лінію як напрямну (лінію траєкторії). 

Розглянемо варіант побудови твердотільної моделі, що складається лише з двох 

профілей перерізу – двох кіл. В першому випадку застосуємо команду Lofted Boss/Base 

(Бобишка/основа по перерізам) з двома колами як перерізами. Утвориться зрізаний конус. 
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Профілі Результат побудови 

  

Додамо між колами ще один профіль – дугу. І під час команди Lofted Boss/Base 

(Бобишка/основа по перерізам) в Диспетчері властивостей в Centerline parameters 

(Налаштування осьової лінії) оберемо цей ескіз дуги в якості осьової напрямної лінії. В 

результаті з’єднання перерізів двох кіл буде спрямоване вздовж обраної дуги в якості осьової 

лінії. 

 



 79 

Вихідна конструкція та результат побудови: 

Профілі Результат побудови 

  

В обох випадках модель можна виконати тонкостінною, задавши необхідні параметри 

в Диспетчері властивостей під час застосування команди Lofted Boss/Base (Бобишка/основа 

по перерізам). На першому й останньому профілі буде сформовано отвори, тобто модель буде 

мати наскрізний отвір. 

Тонкостінне тіло 1 Тонкостінне тіло 2 

  



 80 

 
 

Інструмент Бобишка/основа по межі 

Інструмент Boundary Boss/Base (Бобишка на межі/основа) призначений для побудови 

твердотільної моделі шляхом додання матеріалу між двома профілями в двох напрямках.  

Наприклад, за використання двох профілей квадрата та кола можна створити 

твердотільну модель, за побудовою подібну до команди Lofted Boss/Base (Бобишка/основа по 

перерізам). Проте в даному випадку є можливість редагування точок з’єднання профілей. В 

результаті можна побудовати «закручену» модель. 

Попередній перегляд  

під час побудови 

Результат побудови 

  

Алгоритм типової побудови елементарної твердотільної моделі за допомогою 

інструменту Boundary Boss/Base (Бобишка на межі/основа): 
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1. Побудувати ескізи. 

2. Обрати інструмент Boundary Boss/Base (Бобишка на межі/основа): 

а.  на інструментальній панелі Features (Елементи) в Диспетчері команд; 

б. в меню Insert > Boss/Base > Boundary… (Вставка / Бобишка/основа / По межі…). 

3. Задати налаштування побудови в Диспетчері властивостей: 

а. обрати ескізи для одного чи декількох напрямків; 

б. налаштування тонкостінності (напрямок задання товщини моделі та  її значення). 

4. Задати напрямки у вузлових точках на попередньому перегляді моделі в Графічній 

області: None (Немає), Direction vector (Напрям вектору), Normal to profile 

(Перпендикулярно до профілю). 

5. Підтвердити побудову, натиснувши в Диспетчері властивостей кнопку ОК (зелену 

галочку). 

Приклад побудови: 

 

Побудова вирізів 

Якщо за командами типу Boss (Бобишка) «нарощується» матеріал в твердотільній 

моделі, то команди типу Cut (Виріз) навпаки, видаляють його. А побудова основних типів 

вирізів аналогічна відповідним командам типу Boss (Бобишка). Очевидно, що вирізи 

будуються в матеріалі вже створеної моделі. 

Подібність алгоритму побудови: 

1. Витягнутий виріз – Витягнута бобишка/основа. 

2. Повернутий виріз – Повернута бобишка/основа 
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3. Виріз по траєкторії – Бобишка/основа по траєкторії. 

4. Виріз по перерізам – Бобишка/основа по перерізам. 

5. Виріз по межі – Бобишка/основа по межі. 

Наприклад, результати використання команд створення твердотільної моделі та вирізу 

в ній шляхом використання подібних за алгоритмом побудови команд Extruded cut 

(Витягнутий виріз) та Extruded Boss/Base (Витягнута бобишка / основа). 

Побудова за командою Extruded 

Boss/Base (Витягнута бобишка / основа) 

Побудова за командою Extruded 

cut (Витягнутий виріз) 

 
 

Очевидно, що для створення отвору з розмірами відповідними циліндру необхідно 

попередньо було побудувати довільну твердотільну модель з розмірами більші за виріз (в 

даному випадку отвір). 

В наведеному прикладі за допомогою команди типу Сut (Виріз) створено отвір, який 

може бути як наскрізним, так і глухим на задану відстань в одну або дві сторони від заданого 

ескізу. Також за допомогою вирізу можна відсікати частину моделі ззовні. 

Ескіз кола для відсікання частини 

матеріалу ззовні паралепіпеда  

Результат побудови після 

застосування команди Extruded cut 

(Витягнутий виріз) по ескізу кола 
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Довідкова геометрія 

Панель інструментів Reference Geometry (Довідкова геометрія) вкладки Features 

(Елементи) в Диспетчері команд містить інструменти, призначені для побудови допоміжних 

елементів таких як площини, осі, точки, центр тяжіння, межові рамки та посилання на 

спряження. 

На практиці одним з найбільш вживаних інструментів є допоміжні площини, необхідні, 

зокрема, для побудови ескізів елементів твердотільних моделей та вирізів в них поза 

існуючими площинами чи поверхнями тіла. 

Інструменти довідкової геометрії: 

Іконка Назва Призначення 

 

Plane 

(Площина) 

Побудова допоміжних площин по заданих 

параметрах (обмеженнях) 

 

Axis 

(Вісь) 

Побудова допоміжних осей 

 
Coordinate System 

(Система координат) 

Задання розміщення системи координат (точки 

початку системи координат) в деталі або збірці 

 

Point 

(Точка) 

Побудова допоміжних точок із вказівкою місця 

їх розташування 

 

Center of Mass 

(Центр тяжіння) 

Додавання динамічної точки центру мас в деталь 

чи збірку 

 

Mate Reference 

(Межова рамка) 

Побудова умовних граней навколо моделі за її 

габаритами 

 

Bounding Box 

(Посилання на спряження) 

Для вказаного один або декількох об'єктів 

компонента, які потрібно використовувати для 

автоматичного спряження, створює ці спряження 

Побудова додаткових площин виконується шляхом обрання необхідних об’єктів моделі 

та спосіб встановлення орієнтації додаткової площини відносно них. Всього можна обрати три 

об’єкти (перше, друге та третє посилання). Обирати всі не є необхідної умовою. Далі наведено 

приклад побудови додаткової площини для деталі через її кромку і паралельно одній з граней. 
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Як видно з рисунку, в якості першого посилання обрано ліву бічну грань. До посилання 

задано обмеження Parallel (Паралельно). За друге посилання обрано гостру кромку деталі, 

обмеження Coincident (Співпадіння). Третє посилання для побудови площини обирати будо 

вже непотрібно. 

Результат побудови: 
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До даної деталі проставимо центр тяжіння, перемістимо центр системи координат до 

гострої кромки деталі, проведемо допоміжну вісь через одну з граней, а також додамо межову 

рамку по периметру деталі: 

 

Контрольні запитання 

1. Які основні ознаки документу типу Деталь? 

2. Якою командою можна побудувати шар? 

3. Як зробити тривимірну модель тонкостінною? 

4. Які команди можна використати для побудови зрізаного конуса? 

5. Як побудувати додаткову площину, паралельну грані моделі і що проходить через 

центр системи координат? 

6. Як задати матеріал деталі? 

7. Яке розширення файлів має документ типу Деталь? 

8. Що таке межова рамка і як її побудувати? 

9. Як визначити координати центру мас деталі? 

10. Чому деякі команди типу «бобишка» мають слово «основа» в своїй назві? 
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Моделювання деталей з листового металу 

Інструменти по створенню деталі з листового металу 

У SolidWorks існують спеціалізовані команди для створення деталей із листового 

металу, що мають постійну товщину. Перевагою застосування цих команд на противагу 

застосування звичайних команд типу Бобишок є, насамперед, ширша можливість 

налаштувань побудови з елементами автоматизації та автоматичне створення розгортки 

деталі. 

Розгортка деталі – це вихідний профіль майбутньої деталі із листового матеріалу до 

виконання над нею операцій згинання. Кресленик розгортки необхідний для процесу 

розмічання, перенесення на заготовку із цільного листа матеріалу. Гнуті деталі 

виготовляються зазвичай із металу, тому саме цей матеріал фігурує у відповідних командах 

SolidWorks і розглядається в подальшому. 

Команди по роботі із листовим металом SolidWorks розташовані в меню Insert > Sheet 

metal (Вставка > Листовий метал): 

 

Інструменти Sheet metal (Листовий метал): 

Іконка Назва Призначення 

 

Base-Flange/Tab 

(Базова кромка) 

Створення базової кромки – основного 

початкового елемента листової деталі 
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Convert to Sheet Metal 

(Перетворити в листовий 

метал) 

Для перетворення деталі постійної товщини в 

листову деталь. 

 

Lofted-Bend 

(Елемент по перерізам згину) 

Побудова деталі з листового металу через 

з’єднання декількох ескізів в перерізах 

 

Edge Flange 

(Ребро-кромка) 

Побудова до існуючої грані нової прямої грані 

під заданим кутом до існуючої 

 

Miter Flange 

(Кромка під кутом) 

Побудова до існуючої грані нової за створеним 

ескізом. Відповідно грань може бути складної 

форми 

 

Hem 

(Підгин) 

Додає підгин до обраної кромки деталі із 

листового металу 

 

Jog 

(Вигин) 

Додавання матеріалу до деталі з листового 

металу шляхом створення двох згинів із 

нарисованої лінії 

 

Sketched Bend 

(Нарисований згин) 

Створення згину на існуючій грані листового 

металу 

 
Cross-Break 

(Поперечний перегин) 

Створення умовного перегину для місцевого 

підвищення міцності деталі. Не є геометричним 

об’єктом та не впливає на геометрію деталі. 

Вказується тільки для позначення місця 

перегину під час виробництва деталі. 

 

Closed Corner 

(Закритий кут) 

Додає кут між гранями деталі, доповнюючи 

матеріал між ними 

 

Welded Corner 

(Зварний кут) 

Додає зварний шов між двома гранями листового 

тіла 

 

Break-Corner/Corner-Trim 

(Затуплений кут/Зрізаний 

кут/) 

Відсікає або додає матеріал до складеної деталі з 

листового металу на кромці або грані. 

 

Corner Trim 

(Кут відсікання) 

Відсікає або додає матеріал до плоских деталей 

листового металу на кромці або грані 

 

Forming Tool 

(Інструмент форми) 

Створення з деталі інструмента форми, який в 

подальшому можна використовувати як 

формоутворюючий інструмент на інших деталях 

 

Unfold 

(Розігнути) 

Застосовується для розгинання одного, декількох 

або всіх згинів в деталі з листового металу (тобто 

надання формі деталі до операції згинання) 

 

Fold 

(Зігнути) 

Застосовується для згинання одного, декількох 

або всіх раніше створених згинів в деталі з 

листового металу  
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Flatten 

(Плаский стан) 

Для розгинання всієї деталі, обробка кутів 

застосовується до створення чистої, розігнутої 

деталі з листового металу. 

 

No Bends 

(Без згину) 

Відміняє всі згини з деталі листового металу, до 

якої були додані згини 

 

Rip 

(Розрив) 

Створює розрив на існуючій грані чи гранях 

 

Insert Bends 

(Вставити згини) 

Додає згини, перетворюючи деталь з оболонкю 

на деталь з листового металу 

 

Swept Flange 

(Фланець по траекторії) 

Створення перегинів складної форми вздовж 

кромки грані. Форма перегину задається ескізом. 

Часто застосовується для створення бортиків до 

грані 

 

Sheet Metal Gusset 

(Ребро жорсткості) 

Додання кутового з’єднання з листового металу 

зі спеціальними відступами, що йдуть вздовж 

згинів 

 

Corner Relief 

(Кутове зняття 

напруженості) 

Додавання прорізу між зігнутими об’єктами, 

створюючи розрив між ними 

 

Tab and Slot 

(Виступи та прорізи) 

Створює виступи для одного тіла та прорізи 

(отвори) на іншому тілі для фіксації двох тіл. 

Аналог створення замкового з’єднання шип-паз 

 

Normal Cut 

(Перпендикулярний виріз) 

Створює всі вирізи перпендикулярними якщо 

вони такими ще не є  

Базова кромка 

Зазвичай із цієї команди Base-Flange/Tab (Базова кромка)  починається побудова 

деталі із листового металу. Параметри задаються у вікні Менеджера властивостей. 

Є два основних варіанти застосування команди до обраного ескізу, в результаті якого 

деталь стане пласкою або аналог штампованій (об’ємно деформованій). 

Перший варіант: деталь залишиться пласкою. Ескіз: 
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Застосуємо до ескізу команду Base-Flange/Tab (Базова кромка): 

 

В Менеджері властивостей можна задати всі необхідні параметри. 
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Основними параметрами є Sheet metal parameters: 

1. Товщина деталі (листа металу). 

2. Можливість зміни напрямку додавання металу Reverse direction. 

3. Можливість розташування ескізу посередині товщини листової деталі 

Symmetric. 

Параметр Bend allowance (Допуск згину) регулює геометрію розгортки деталі. 

Найпоширеніший варіант коефіцієнту К (від 0 до 1) задає розміщення лінії розгортки в місцях 

згину згідно радіусів згину. Значення К=0,5 задає лінію розгортки посередині товщини листа. 

Параметр Auto relief (Автозняття напруженості) задає чи потрібні зазори в місцях, де 

пряма ділянка листового металу знаходиться біля згину. Значення Rectangular 

(Прямокутний), Tear (Без зазорів), Obround (Скруглений). Параметр Ratio (Співвідношення) 

задає значення співвідношення зазору до товщини листа металу деталі. 

Результат побудови: 
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Другий варіант застосування команди Base-Flange/Tab (Базова кромка): Деталь 

матиме вигнуту об’ємну форму. Приклад: 

Ескіз Результат побудови 

  

Ребро-кромка 

Команда Edge Flange (Ребро-кромка)  додає новий загнутий елемент, що 

починається від кромки існуючого. 

Розглянемо раніше побудовану деталь: 

 

Додамо до існуючої деталі у верхній частині ребра-кромки. Напрямок задається 

мишкою. 
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В Менеджері властивостей можна задати всі необхідні параметри. 
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З основних параметрів є задання кута нахилу під’єднаної деталі Angle (Кут), довжина 

елемента. Значення довжини елемента (його «вильоту») може вираховуватись трьома 

способами, тип якого обирається через відповідну іконку: 

 

 Радіус згину можна задати, або використати раніше виставлений за замовчуванням, 

поставивши галочку Use default radius (Використати радіус за замовчуванням). 

Параметри під’єднання деталі обираються візуалізованими іконками: 

 

Результат побудови: 

  

За замовчування побудований елемент має форму прямокутника шириною обраної 

кромки. Проте існує можливість редагування форми елемента. Для цього під час команди Edge 

Flange (Ребро-кромка) в Диспетчері властивостей натиснути кнопку Edit flange profile 

(Редагувати профіль кромки): 
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Відкриється вікно зі сповіщення про допустимість редагування ескізу, а сама кромка 

довернеться у площину екрана для її редагування: 

 

Додамо, наприклад округлення на кутах кромки та два отвори. Після чого необхідно 

натиснути на кнопку Готово у додатковому вікні. 
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Результат побудови: 

 

Кромка під кутом 

Команда Miter Flange (Кромка під кутом)  дещо подібна до команди Edge Flange 

(Ребро-кромка). Вона також будує додатковий елемент від існуючого. Проте профіль кромки 

тепер може бути складного перерізу. А розміщення кромки не обмежується лише одним 

ребром існуючого елемента, а може добудовуватись вздовж його периметра, подібно до 

команд типу «По траекторії». 

Розглянемо команду, добудувавши кромки-бортики по периметру існуючоїдеталі із 

листового металу, яка побудована за допомогою команди Base-Flange/Tab (Базова кромка). 

Деталь Вихідний ескіз деталі 

  

Оберемо команду Miter Flange (Кромка під кутом) та застосуємо її до ребра лівої грані 

деталі: 
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Створиться нова площина, перпендикулярна до обраного ребра грані деталі та програма 

перейде в режим побудови ескізу: 

 

Побудуємо профіль нової кромки: 
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Підтверджуємо побудову ескізу натисканням зеленої галочки поблизу Панелі задач. 

Вікно переходить в режим команди Miter Flange (Кромка під кутом): 

 

В Менеджері властивостей необхідно задати діаметр радіуса округлень або залишити 

радіус за замовчуванням, а також обрати тип прилягання нової кромки Flange position: 

 

Де 
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Якщо натиснути на інших ребрах граней вихідної деталі, то нова кромка буде також 

побудована і вздовж них. 

 

Значення зазору Між новими кромками будуть утворені зазори, значення яких 

задається в параметрі Gap distance. 

Параметр Start/End offset (Початковий/кінцевий зсув) задає зміщення побудови 

кромок відносно початкової та кінцевої точок траєкторії. При цьому стає активним задання 

Тип зняття напруження Custom bend allowance. 

Результат побудови: 
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Вигин 

Команда Jog (Вигин)  дозволяє створити на прямій ділянці існуючої деталі із 

листового металу подвійний перегин, своєрідну «сходинку». 

Деталь Вихідний ескіз 

 
 

Застосуємо команду Jog (Вигин) та оберемо верхню грань. Оскільки на ній відсутній 

ескіз для подальшої побудови, SolidWorks перейде в режим його побудови. 

Будуємо ескіз у вигляді відрізка, де буде здійснюватися вигин від площини існуючої 

деталі. 

 

Відрізок може не повністю перекривати всю площину грані деталі. Тому проводимо 

його без чітких розмірів та прив’язок крім задання розміщення відносно правого краю деталі. 

Підтверджуємо побудову ескізу і вікно переходить в режим команди Jog (Вигин). В 

Менеджері властивостей необхідно вказати на поверхню , яка залишеться нерухомою під час 

вигину. Для цього достатньо натиснути ЛКМ на ній коди активне поле Fixed face (Фіксована 

поверхня) в Менеджері властивостей. Також можна задати свій радіус згину чи залишити за 

замовчуванням. Необхідно вказати висоту вигину Jog offset та метод її прорахунку: 

 



 100 

Задається також кут вигинання Jog angle, який за замовчуванням рівний 90 градусів та 

тип розміщення вигину: 

 

Важливим параметром є Fix projected length (Зафіксувати проектовану довжину). За 

активації цього параметра наявність вигину не впливає (не зменшує) першочергову довжину 

деталі. В разі деактивації довжина деталі (габаритна, її проекція на вид зверху) стає меншою 

через висоту вигину, яка входить в першочергову довжину деталі. Розглянемо на наведеному 

вище прикладі: 

  

  

  

 
 

Нарисований вигин 

Команда Sketched Bend (Нарисований згин)  дозволяє зробити одинарний вигин 

на деталі із листового метала за побудованим відрізком на ескізі. 

Ескіз: 
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Побудована деталь з листового металу командою Base-Flange/Tab (Базова кромка): 

 

Застосуємо команду Sketched Bend (Нарисований згин). Обираємо верхню грань 

деталі. Після чого програма перейде в режим побудови ескізу. Будуємо відрізок: 

 

Виходимо з режиму ескізу, після чого вікно перейде до режиму команди Sketched Bend 

(Нарисований згин): 
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В Менеджері властивостей активне поле Fixed face (Фіксована поверхня) для вибору 

яка частина деталі зліва чи справа від відрізку залишиться фіксованою. Потрібно також обрати 

розміщення згину Bend position: 

 

Також обирається кут згину, напрямок згину, значення радіусу чи використання його 

за замовчуванням. 

Оберемо фіксовану поверхню зліва від відрізка, кут згину в 60 градусів та прямий 

напрямок згину. В результаті отримаємо таку деталь: 
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Розігнути та Зігнути 

Команда Unfold (Розігнути)  призначена для розгинання деталі в місці створення 

згину. Зазвичай команда застосовується для тимчасового розгинання і побудови в місці згину 

додатвого елемента, наприклад вирізу. 

Команда Fold (Зігнути)  призначена для повторного згинання частини деталі, де 

вже був побудований раніше згин, але перед цим була застосована команда Unfold (Розігнути). 

Зазвичай команда застосовується для повторного згинання після закінчення додаткових 

побудов, наприклад створення вирізу. 

Наприклад, існує така деталь: 

 

 

Застосуємо команду Unfold (Розігнути), обравши яка частина деталі залишиться 

фіксованою Fixed face та місце згину для його розгинання Bends to unfold: 

 

 

Побудуємо додатковий виріз на місці дезактивованого згину: 
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Побудуємо наскрізний виріз командою Extruded cut (Витягнутий виріз): 

 

Застосуємо команду Fold (Зігнути), обарви фіксовану частину деталі та місце вигину: 

 

Розгортка 

Команда Flat-Pattern (Розгортка) виникає в Дереві конструювання відразу після 

створення листового тіла, останньою в списку і є неактивною. Для активації розгортки 

необхідно її відобразити. Піднісши до неї курсор і вибравши з графічного меню команду 

Unsuppress (Відобразити/Висвітлити). 

До відображення розгортки: 
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Після відображення розгортки: 

 

Для повернення відображення всіх вигинів, тобто деактивацію відображення 

розгортки, необхідно обрати з графічного меню Suppress (Приховати/Погасити). 

Контрольні запитання 

1. Які ознаки мають деталі із листового металу? 

2. Як побудувати подвійний перегин? 

3. Як задати загальний радіус згину для всіх операцій? 

4. Що таке розгортка? 

5. Як тривимірну деталь з листового металу перетворити на розгортку? 

6. Чи може деталь з листового металу мати різну товщину? 

7. Як задати тип металу для деталі з листового металу? 

8. Які переваги має деталь із листового металу побудована в цьому режимі на відміну 

від деталі, побудованої за допомогою звичайних команд типу «бобишка» та 

«виріз»? 

9. Чи можна змінити параметри перегину? 

10. Як дізнатись що у створеній деталі з листового металу перекривають грані і її 

виготовлення через це неможливе? 

11. Як зняти напруження в місцях перегину в деталі з листового металу? 

12. Як додати ребро жорсткості на місце перегину? 

13. Як показати зварний шов на місця дотикання двох граней? 

14. Чи можна за ескізом розгортки побудувати тривимірну деталь з листового металу? 

15. Яке розширення документу (файлу) деталі з листового металу?  
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3D-проектування: створення збірок 

Інтерфейс при створенні документу типу Збірка 

Вікно програми SolidWorks після створення нового документу типу Assembly (Збірка): 

 

Основні команди зосереджені в інструментальних панелях вкладки Assembly (Збірка) 

в Диспетчері команд. 

 

Додавання компонентів збірки 

Створення нового документа Збірка виконується через меню File > New > Assembly 

(Файл > Новий > Збірка) або через спливаюче діалогове вікно під час запуску SolidWorks, 

обравши відповідну кнопку: 
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Після створення нового документа програма може автоматично запропонувати 

відкрити необхідні файли, а у вікні Менеджера властивостей PropertyManager висвітлиться 

підказка по початку створення збірки. 

 

До документи типу Assembly (Збірка) можна додавати як документи типу 

Part (Деталь), так і створені до цього документи типу Assembly (Збірка). 

Для додання компонентів збірки через вікно Менеджера властивостей необхідно 

натиснути на кнопку Browse (Переглянути). 

Якщо відмовитись від обрання компоненту/-ів збірки вікно Менеджера властивостей, 

створиться новий документ із пустою Графічною областю і режим вибору компонентів 

збірки деактивується. 
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Для повторної активації вибору компонентів необхідно на вкладці Assembly (Збірка) 

Диспетчера команд обрати команду Insert components (Вставити компоненти): 

 

Також додати нові компоненти можна через меню Insert > Component 

(Вставка  > Компонент): 

 

Для копіювання деталі в збірці необхідно натиснути на клавіатурі клавішу Ctrl, а на 

деталі ЛКМ та, не відпускаючи їх, потягнути мишу в сторону.  

Існує один компонент Ctrl+ЛКМ в сторону Результат 

  
 

Розглянемо на прикладі побудову 3D-збірки основної частини шнекового змішувача: 
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Додамо першу деталь «Циліндр»: 

 

Вона з’явиться в Графічній області, проте без фіксації відносно системи координат. 

При русі мишкою деталь також рухається в цій області. Якщо натиснути ЛКМ в довільному 

місці в Графічній області деталь зафіксується в ній в центрі системи координат. Про фіксацію 

також свідчить в дужках літера f (f – fixed, зафіксована) у назві деталі в Дереві 

конструювання: 

 

Деталь після відкриття в документі до її фіксації зорієнтована в просторі та системи 

координат так, як була створена раніше. Для зміни орієнтації деталі відносно системи 

координат під час додавання компонента збірки відкривається спливаюче вікно:  

 

У даному вікні існує три іконки з позначенням відповідних осей. Одноразове 

натискання на іконці призводить до провертання деталі на кут, вказаний в цьому вікні і який 

можна змінити. Наприклад за заданого у вікні кута  (90 градусів) подвійне натискання 

на іконці  призводить до подвійного провертання деталі по 90 градусів (тобто сумарно на 

180 градусів) відносно осі Y. 

Дане налаштування дає змогу змінити орієнтацію всієї збірки незалежно від орієнтації 

першого компонента збірки. Адже другий компонент збірки орієнтуються в просторі по 

заданим користувачем взаємозв’язкам відносно першого. Далі відносно вже існуючих в 

документі збірки. 

В нашому прикладі деталь «Циліндр» додається, зорієнтованій вздовж осі X: 
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Розвернемо деталь вздовж осі Z, тричі натиснувши на іконці  за заданого кута 90 

градусів. Аналогічний результат можна досягнути, змінивши кут на 270 градусів і натиснувши 

на дану іконку лише один раз. 

 

Команди по зміні орієнтації вставки першого компонента до його фіксації шляхом 

провертання на 90 градусів по осям також доступні, натиснувши ПКМ в Графічній області: 

 

Отже після додавання деталі та зміни її орієнтації маємо зафіксовану першу деталь 

збірки: 
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Після додання та фіксації першого компонента збірки можна додавати наступні 

почергово, кожен  раз після додання накладаючи на них взаємозв’язки і фіксуючи відносно 

інших доданих раніше компонентів збірки. Також можна додавати компоненти збірки по 

декілька або відразу всі. В такому разі вони всі будуть розміщені в обраному користувачем 

місці в Графічній області. Та потребуватимуть в подалі накладання на кожен з них 

взаємозв’язків.  

У нашому прикладі додамо відразу ще п’ять деталей. Всі вони відобразяться в 

Менеджері властивостей у вікні Part/Assembly to insert (Деталі/Збірки для вставки) Open 

documents (Відкриті документи): 

 

Проте в Графічній області з’явиться перший з доданих компонентів (деталей). Для 

вставки деталі потрібно натиснути ЛКМ в обраному місці Графічної області. В подальшому 

натискання і утримування ЛКМ на доданому компоненту збірки дозволить перемістити його 

в інше місце Графічної області. Ця можливість залишається до накладання на нього 

взаємозв’язків відносно вже зафіксованих елементів збірки. 

Після додання цієї деталі в Графічної області почергово з’являтимуться інші із 

обраних. Аналогічно першій їх фіксація відбувається шляхом натискання ЛКМ. 
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За великої кількості доданих компонентів збірки вони можуть завадити зручності 

подальшого проєктування. В такому випадку доцільно почергово додавати нові компоненти. 

А після додання нового компонента відразу накладати на нього взаємозв’язки, розміщуючи в 

збірці. 

Видалення доданих компонентів збірки можливе, обравши їх в Дереві конструювання 

та натиснувши на клавіатурі кнопку Del. Або можна натиснути на назві компонентів в Дереві 

конструювання ПКМ та в контекстному меню  обрати Delete (Видалити). 

Наприклад, видалимо з нових доданих компонентів всі , крім деталь «Корпус»: 

 

З’єднання компонентів збірки (взаємозв’язки)  

З’єднання компонентів збірки між собою відбувається шляхом накладення між ними 

взаємозв’язків. Тобто, в цілому, алгоритм з’єднання компонентів полягає в наступному: 

1. Додати перший компонент збірки та зафіксувати його відносно системи координат. 

2. Додати наступний компонент збірки (або декілька, або всі). 

3. Обрати команду Mate (Взаємозв’язок). 

4. Виділити перший компонент збірки та щойно доданий (або один (рідше декілька) з 

щойно доданих). 

5. Обрати необхідний тип взаємозв’язку в Диспетчері властивостей. 

6. За необхідності додати інші взаємозв’язки до обраних компонентів для досягнення 

необхідного розташування та фіксації доданого компонента/-ів відносно першого 

компонента збірки. 

7. Додати наступний компонент збірки (або обрати з вже доданих, але ще не 

зафіксованих компонентів збірки). 
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8. Додати необхідні взаємозв’язки на новий компонент. При цьому його можна вже 

фіксувати як відносно першого компонента збірки, так і наступного вже 

зафіксованого. 

9. Повторити операції додання нових компонентів збірки та накладання на них 

взаємозв’язки. 

Умова накладання взаємозв’язків: їх кількість повинна бути мінімальною, але 

достатньою. Вся збірка повинна бути як в реальності, тобто її компоненти не повинні мати 

зайвих ступенів вільності руху. 

В нашому прикладі необхідно з’єднати дві деталі «Циліндр» та «Корпус». 

Поточне розміщення Необхідний результат 

 
 

Оберемо команду Mate (Взаємозв’язок). В Диспетчері властивостей активне вікно 

вибору елементів Mate selections, тобто елементів компонентів збірки (в нашому випадку 

елементів деталей), на які необхідно накласти взаємозв’язки: 

 

Виділимо дві грані деталей (за допомогою ЛКМ, затиснувши CTRL або Shift), які в 

реальності повинні дотикатись одна до одної: 

Деталь «Циліндр» Деталь «Корпус» 
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Для зручності виділення елементів деталей доцільно використовувати функції 

масштабування та обертання системи координат з усіма її компонентами збірки. 

Після виділення граней необхідно обрати вид взаємозв’язку. SolidWorks попередньо 

може сам обрати та застосувати один з найбільш доцільних типів взаємозв’язку. Можна 

змінити вибір або відразу підтвердити. 

Оскільки дані грані мають дотикатись, застосуємо тип Coincident (Збіг) з вікна вибору 

типу взаємозв’язку Mate type в Менеджері властивостей. Їх кількість і тип можуть 

відрізнятись, адже SolidWorks автоматично прораховує всі можливі варіанти для обраних 

елементів. 

 

Для підтвердження обраного взаємозв’язку і щоб вийти з команду Mate 

(Взаємозв’язок) необхідно натиснути зелену галочку зверху справа в Графічній області. 

Якщо натиснути на зеленій галочці в Диспетчері властивостей підтвердиться накладання 

обраного взаємозв’язку, виділення елементів компонентів збірки пропаде, але команда Mate 

(Взаємозв’язок) залишиться активною. 

Даний взаємозв’язок Coincident (Збіг) розмістить обрані грані в одній площині. Проте 

поки вони можуть і не дотикатись, адже зміщені відносно одна одної, хоч і в одній площині: 

 
Застосуємо ще один взаємозв’язок Concentric (Концентричний), щоб зробити дві 

деталі співвісними (тобто концентричними). Виділимо циліндричні грані деталей (тут їх більш 

однієї в кожній деталі і всі вони можуть бути використані): 
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Деталь «Циліндр» Деталь «Корпус» 

  

Результат: 

 

Інколи для правильності застосування взаємозв’язку необхідно один з компонентів 

збірки змістити чи провернути відносно системи координат та інших компонентів. Для цього 

на вкладці Assembly (Збірка) Диспетчера команд є команди Move component (Пересунути 

компонент) та Rotate component (Повернути компонент): 

 

Головне, що ці команди не призначені для точного позиціонування одного компонента 

збірки відносно іншого. Ця функція виключно за взаємозв’язками. 

У даному прикладі далі необхідно почергово додати два фланця, шнек та 

нестандартний болт, застосовуючи відповідні взаємозв’язки. Болт можна копіювати, 

затиснувши Ctrl та ЛКМ на болті і, не відпускаючи їх, потягнути в сторону до копіювання. 

Так повторити необхідну кількість разів. Або можна вставити один болт у фланці та копіювати 

як коловий масив Circular component pattern. 
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Додавання стандартних виробів (Toolbox) 

Для вставки стандартних виробів у збірку в SolidWorks існує модуль Toolbox. 

Toolbox містить бібліотеку стандартних деталей, яка повністю інтегрована з 

SolidWorks. Достатньо обрати стандарт і тип деталі, яку потрібно вставити, а потім 

перетягнути стандартний виріб у збірку. 

Також користувач може налаштувати бібліотеку деталей Toolbox, що містить папку з 

основними файлами стандартних виробів для підтримуваних стандартів, а також інформацію 

про їх розмір та конфігурацію.  

Toolbox підтримує міжнародні стандарти, зокрема: ANSI, AS, GB, BSI, CISC, DIN, GB, 

ISO, IS, JIS і KS. 

Toolbox включає наступне обладнання: підшипники, болти, кулачки, шестерні, джиг-

втулки, виводи, шпильки, стопорні кільця, гвинти, зірочки, конструкційні форми, включаючи 

алюміній і сталь, шківи ременя ГРМ, шайби. 

Також Toolbox має такі інженерні інструменти: 

1. Калькулятор балки для визначення напруги та прогину балки. 

2. Калькулятор підшипників для визначення ємності та терміну служби 

підшипника. 

3. Пази для додавання стандартних канавок до циліндричної деталі. 

4. Поперечні профілі конструкційної сталі для додавання ескізу до деталі. 

Компоненти з бібліотеки Toolbox за необхідності можуть додатково бути налаштовані 

користувачем. Зокрема можна змінити матеріал компонентів та їх розміри. Модифіковані 

компоненти можна зберегти в бібліотеку і використовувати в подальшому. 

Для активації модуля Toolbox необхідно обрати через меню Tools > Add-ins 

(Інструменти > Доповнення) або через меню швидкого доступу: 

 

У вікні підключення доповнень, що відкрилось, необхідно проставити галочки в 

модулях SOLIDWORKS Toolbox Library та SOLIDWORKS Toolbox Utilities. Також бажано 

поряд в стовпці Start Up також поставити галочки для автозапуску цих модулів в подальшому. 

Після натиснути кнопку ОК. 
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Доступ до Toolbox тепер доступний в Панелі задач у вкладці Design library 

(Бібліотека дизайну): 
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Список містить паки згідно до відповідного стандарту. Український ДСТУ відсутній. 

До ГОСТу подібний китайський GB. Поширеним є міжнародний ISO. 

Для додавання стандартного виробу із бібліотеки Toolbox необхідно відкрити папку 

необхідного стандарту. Там знайти необхідний тип виробу і перетягнути його до Графічної 

області. Наприклад, додамо болт з шестигранною головкою за стандартом ISO: 

 

В Менеджері властивостей відкриється можливість налаштування виробу, зокрема 

розмір Size , довжина болта Length, довжина різьби Thread length, метод відображення різьби 

Thread display. 

Приклад відображення різьби болта розміром M24: 

Simplified (спрощена) Schematic (Схематична) 
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Рознесення компонентів збірки 

Рознесення компонентів збірки необхідне для часткового або повного рознесення 

готової збірки для кращої візуалізації її компонентів із можливістю створення анімації цього 

процесу (як рознесення, так і процесу збирання). 

Отже розносити збірку можна на окремі вузли, на деталі, або часткового на вузли, 

частково на деталі, або можна змістити лиш один вузол чи деталь.  

Налаштування процесу рознесення реалізується інструментом Exploded view 

(Деталізований вид), що знаходиться на вкладці Assembly (Збірка) в Диспетчері команд, а 

також в меню Insert (Вставка). 

 

Розберемо команду на прикладі рознесення на деталі збірку шнекового змішувача, який 

складає із двох частинок циліндричного корпусу, двох фланців, скріплених гвинтами з 

головкою під внутрішній ключ та шнеком всередині корпусів. 

 

Оберемо команду Exploded view (Деталізований вид). Активується Менеджер 

властивостей: 
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У верхній частині є поле Explode steps (Етапи рознесення) для занесення етапів 

процесу рознесення з можливістю їх редагування. Нижче Add step (Додати етап) є дві кнопки 

вибору типу рознесення (звичайне лінійне чи радіальне), поле з назвою поточного етапу, поле 

обраних компонентів збірки, напрямок рознесення, довжина рознесення (довжина зміщення 

компонентів вздовж обраного напрямку), кут повороту. Нижче розміщується кнопку Add 

(Додати) для додання поточного етапу в історію рознесення. 

Алгоритм рознесення: 

1. Виділити компонент чи компоненти збірки, які будуть зміщуватись відносно свого 

положення в збірці. 

2. Обрати тип рознесення (звичайне лінійне чи радіальне). 

3. Обрати напрямок рознесення. 

4. Задати відстань зміщення обраного компонента (чи компонентів). Або в Графічній 

області змістити мишкою вручну в необхідну сторону на необхідну відстань. 

5. Після зміщення компонента (чи компонентів) підтвердити кнопкою Done 

(Виконано). 

6. Щойно виконане зміщення відобразиться у полі Explode steps (Етапи рознесення). 

Можна починати виконувати зміщення наступного компонента чи компонентів 
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згідно пунктів 1-4. Причому можливе зміщення одного з компонентів щойно 

переміщеного вузла компонентів. 

7. Підтвердити побудову зміщення, натиснувши зелену галочку в Менеджері 

властивостей. 

Отже, в нашому випадку спочатку виділимо всі кріпильні вироби (або в Дереві 

конструювання або безпосередньо мишкою в Графічній області на моделі). З’явиться 

графічне відображення системи координат для полегшення задання напрямку зміщення і за 

допомогою якої  можна виконувати зміщення мишкою. 

 

В Менеджері властивостей з’являться обрані (виділені) компоненти збірки. Наразі це 

кріпильні вироби на фланцях. Також тут вище обираємо звичайний лінійний тип рознесення 

(Regular step (translate and rotate) [Звичайний етап (перемістити та провернути)]: 

 

Задаємо напрямок та довжину зміщення виділених компонентів збірки в Менеджері 

властивостей або, що зручніше, піднісши курсор мишки до графічного значка системи 

координат на обраних компонентах та, натиснувши ЛКМ, потягнути у потрібну сторону. 

Наразі це вздовж осі X,зворотній напрямок. 

 

У результаті кріпильні вироби перемістяться відносно моделі 
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За необхідності можна більш точно вказати значення відстані чи кута провертання в 

Менеджері властивостей:  

 

Кріпильні вироби зміщені: 

 

Підтвердимо виконання цього етапу створення рознесення збірки шляхом натискання 

на кнопку Done (Виконано), що знаходиться в Менеджері властивостей нижче. 
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Продовжимо зміщення наступних компонентів. Виділимо частину циліндричного 

корпусу та відповідний фланець: 

 

Змістимо їх курсором мишки шляхом перетаскування після піднесення курсору мишки 

на відповідну вісь на значку системи координат (вісь Х, зворотній напрямок): 

 

Після підтвердження побудови даного етапу рознесення виділення щойно переміщених 

компонентів зніметься: 
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Продовжимо побудову, виділивши вже переміщений фланець на переміщеній 

циліндричній частині корпусу та змістивши фланець в сторону моделі: 

 
 

Далі оберемо інший фланець з частиною циліндричного корпусу та змістимо їх в 

сторону від моделі: 

  

 

Аналогічним чином змістимо щойно переміщений фланець в сторону моделі: 
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Останній етап рознесення  збірки на окремі деталі виконано. Проте загальна команда 

ще не підтверджена. 

 

Або з іншого ракурсу: 

 

В Менеджері властивостей відображаються всі етапи рознесення, які можна видалити, 

редагувати, тимчасового виключити з побудови. Нижня полоса рухома і дає змогу тимчасово 

виключати з побудови знизу вгору етапи. 
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Для остаточної побудови рознесення необхідно натиснути зелену галочку кнопки OK 

в Менеджері властивостей. 

 

Щоб відмінити рознесення або редагувати необхідно переключитись на вкладку бічної 

панелі Менеджер конфігурацій ConfigurationManager. Тут знаходиться список наявних 

конфігурацій даної моделі. В нашому випадку лише один рознесений вид ExplView1 

(Рознесений вид 1) 

 

Можна його розкрити. Відкриється список всіх етапів побудови рознесення. 

 

 

В даному вікні також можна викликати редагування рознесення або виключення етапу 

з побудови. Виключимо, наприклад, всі етапи крім першого, перетягнувши нижню лінію 

відкату: 
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Натисканням ПКМ відкривається контекстне меню з можливістю збирання рознесеної збірки 

(відміни рознесення) Collapse (Зібрати) або, навпаки, повторно рознести Explode (Рознести): 

  

В наведеному прикладі моделі оберемо Collapse (Зібрати): 

 

Далі оберемо Explode (Рознести): 

 

Після побудованого рознесеного виду операції рознесення та збирання виконуються миттєво. 

Проте можливо зробити анімаційне відтворення цих процесів з можливістю запису відео. Для 

цього в попередньому контекстному меню необхідно обрати пункт Animate collapse (Анімація 

збирання) або Animate explode (Анімація рознесення) в залежності від поточного стану 

відображення моделі. 
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З’явиться додаткове віконце Animation controller (Контролер анімації) з 

налаштуванням процесу створення анімації: 

 

В контролері присутні кнопки перемотки на початок, попереднього етапу рознесення 

чи збірки, старту, наступного етапу, перемотки на кінець побудови, кнопки збереження 

анімації у файл, способів відтворення анімації (одноразове, зациклене відтворення одного 

процесу, зациклене збірка-рознесення, уповільнене вдвічі відтворення, пришвидшене вдвічі 

відтворення). 

Нижче наведено кожного кроку на анімації процесу збирання рознесеної збірки на 

деталі: 
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 130 

Типи файлів для збереження анімацій: 

 

Також під час збереження можна налаштувати співвідношення сторін відео та його 

розширення: 

 

Також є можливість додання умовних ліній рознесення з можливістю їх редагування за 

допомогою команди Insert/Edit smart explode lines (Вставити/редагувати розумні лінії 

рознесення): 

 

Результат побудови: 
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Контрольні запитання 

1. Яке розширення файлу має документ типу «Збірка»? 

2. З яких компонентів може складатись документ типу «Збірка»? 

3. Чи можна в документі типу «Збірка» редагувати додану деталь? 

4. Яка кількість взаємозв’язків необхідна між двома компонентами збірки? 

5. Які типи взаємозв’язків існує в документі типу «збірка»? 

6. Що таке інструмент Toolbox? 

7. Які типи стандартів підтримує Toolbox? 

8. Як змінити параметри доданого стандартного виробу в збірці? 

9. Як створити рознесення елементів в збірці? 

10. Чи можна відмінити рознесення документів в збірці? 
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Створення 2D-креслеників за 3D-моделлю 

Інструментальна панель Drawing (Кресленик) 

Інструментальна панель активується при виборі вкладки Drawing (Кресленик) в 

Диспетчері команд. Більшість інструментів стають доступними після появи в кресленику хоч 

одного виду. 

Інструментальна панель Drawing (Кресленик): 

 

Інструменти панелі: 

Іконка Назва Призначення 

 

Model View  

(Вид з моделі) 

Створює один вид на основі визначеній до цього 

орієнтації виду. 

 

Projected View  

(Проекційний вид) 

Створює один із 8 проекційних стандартних 

видів, що є проекцією існуючого. Види: вид 

зверху, знизу, зліва, справа та 4 діагональних 

(кутових) види  

 

Auxiliary View  

(Допоміжний вид) 

Створює проекційний вид до існуючого із 

розміщенням перпендикулярно поряд нього 

 

Section View  

(Розріз) 

Створює простий чи складний розріз до обраного 

виду 

 

Removed Section 

(Видалений розріз) 

Створює винесені локальні перерізи до обраного 

місця на існуючому виді, є відображенням 

локального зрізу виду 

 

Detail View 

(Місцевий вид) 

Створює вид, який є частиною існуючого, у, 

зазвичай, збільшеному масштабі 

 

Relative View  

(Відносний вид) 

Створює ортогональний вид (спереду, справа, 

зліва, зверху, знизу та позаду), який 

визначається двома ортогональними гранями 

або площинами в моделі та зазначенням їх 

відповідних орієнтацій.  

 

Standard 3 View 

(Три стандартних види) 

Створюються одночасно три проекційно 

пов’язаних ортогональні види деталі або збірки 

(спереду, справа, зліва, зверху, знизу та позаду) 

 

Broken-out Section 

(Місцевий розріз) 

Створює місцевий розріз з відображенням 

внутрішньої структури моделі 
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Break view 

(Вид з розривом) 

Створює розрив виду моделі для зменшення 

його місця розташування на кресленику 

 

Crop view 

(Обрізаний вид) 

Створює вид шляхом обрізання іншого виду 

поза межами області, що задається 

 

Alternative position view 

(Вид альтернативного 

положення) 

Створює вид, що відображає зміщене 

положення існуючого і накладається на нього. 

Наприклад вид поршня, в зміщеному положенні 

відносно існуючого показує наявність руху 

поршня 

 

Empty view 

(Пустий вид) 

Створює вид із ескізом, в якому відображаються 

елементи, відсутні в тривимірній моделі. 

Наприклад частина станини, до якої кріпиться 

тривимірна деталь 

 

Predefined view 

(Вид-шаблон) 

Створює вид із заданими налаштуваннями, який 

можна зберегти як шаблон і використовувати в 

подальшому  

 

Update view 

(Оновити вид) 

Оновлює (перебудовує) існуючий вид. Особливо 

актуально у випадку зміни тривимірної моделі, 

за якою створений кресленик 

 

Replace view 

(Заміна моделі) 

Заміна посилань для окремих видів на 

тривимірну модель, за якою виконується 

побудова цих видів 

Дані інструменти також можна обрати в меню Insert > Drawing view (Вставка >Вид 

кресленика) 

 

Створення листа кресленика 

Створення кресленика можливе за існуючої твердотільної моделі (деталі або збірки), 

або довільного нового кресленика, який не пов’язаний з жодною моделлю (тобто з жодним 

документом SolidWorks). 



 134 

Для створення нового довільного кресленика необхідно обрати відповідну іконку при 

запуску програми: 

 

Також можливо створити кресленик через меню Files > New (Файл > Новий) і обрати 

відповідну іконку. 

Для створення кресленика за побудованою моделлю необхідно за відкритого 

документу цієї моделі (збірки або деталі) зайти в меню File (Файл) та обрати активний пункт 

Make drawing from part (Створити кресленик за деталлю) або Make drawing from assembly 

(Створити кресленик за збіркою): 

  

Наприклад, за відкритого активного документу деталі «Кронштейн» створення нового 

кресленика виглядає так: 

 

Після натискання Make drawing from part (Створити кресленик за деталлю) 

відкриється вікно вибору формату листа кресленика: 
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За умови відсутності налаштованого шаблону листа або якщо пам’ятала останній вибір 

у вікні можуть бути відсутні на вибір формати листа і запропоновано вибір нестандартного 

формату. В такому разі необхідно переключитись на Standard sheet size (Стандартний розмір 

листа). 

 

За необхідності прибрати галочку Only sheet size (Тільки розмір листа) і обрати 

необхідний формат зі списку. 
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Або можна натиснути кнопку Browse (Огляд) і обрати необхідний шаблон листа згідно 

його формату. Назва шаблону відповідає розміру листа, стандарту, типу листа (перший чи 

наступні) та його орієнтації (горизонтальна Landscape та вертикальна Portrait): 

 

Оберемо лист форматом А1 з горизонтальною орієнтацією, лист перший згідно 

стандарту ГОСТ. 

 

Для відображення основного напису переконаймося в наявності галочки поряд 

Display sheet format (Показувати формат листа / основний напис): 

 

В результаті створиться кресленик відповідного типу з активною панеллю View palette 

(Оглядова палітра) на Панелі задач: 
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Види 

Після створення листа кресленика на вкладці View palette (Оглядова палітра) на Панелі 

задач розташовані значки основних видів. Причому їх вигляд відображає схематичне 

зображення саме відкритої моделі в даному документі. Кожен значок виду має нижче 

відповідну назву: 

 

Для вибору необхідного виду та розміщення його на кресленику необхідно натиснувши 

ЛКМ перетягнути даний вид на кресленик в місце його розташування та відпустити ЛКМ: 
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Також додати необхідний вид на кресленик можна за допомогою інструменту Model 

view (Вид моделі) або Standard 3 view (Стандартні три види) на інструментальній панелі 

вкладки Drawing (Кресленик) в Диспетчері команд. 

 

В Менеджері властивостей після додання виду спереду представлені основні його 

налаштування, зокрема Display style (Стиль відображення), Scale (Масштаб): 
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Після перетягування виду та розміщення його на кресленику активується режим 

додавання нових видів згідно щойно розміщеного виду. Пересуваючи курсор миші в різні 

сторони від доданого фронтального виду на екрані з’являтимуться фантоми (попередні 

перегляди) нових генерованих видів. Їх створення відбувається згідно напрямку руху курсора 

миші. Так переміщення курсору вгору генерує вид згори, вниз – вид знизу, вправо, вид справа, 

вліво – вид зліва, по діагоналі – відповідний вид по діагоналі з відображенням по напрямку 

руху курсора миші: 

 

Доданий фронтальний вид 

 

Рух миші по діагоналі вправо догори 

 

Рух миші вгору – вид згори 

 

Рух миші вниз – вид знизу 

 

Рух миші вліво – вид зліва 

 

Рух миші вправо – вид справа 

Додані види будуть розміщуватись згідно проекційного зв’язку. Їх подальше 

переміщення за замовчуванням можливе лише зі збереженням проекційного зв’язку. Для 

завершення побудови потрібно натиснути зелену галочку в Менеджері властивостей або 

натиснути Esc (відміна продовження побудови). 
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За необхідності через інструмент Visibility off (Вимкнення видимості) на Панелі 

інструментів керованого перегляду можна налаштувати відображення чи приховання 

додаткових елементів, наприклад вихідних точок: 

 

Отже, під час додання виду спереді також згенеруємо вид зверху та вид зліва 

перетягуванням миші та натисканням ЛКМ: 
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Місце розташування видів зліва та зверху не відповідають стандарту. Адже вид зверху 

має розташовуватись знизу від виду спереду, а вид зліва – справа від нього. Для переміщення 

виду необхідно піднести курсор до нього так, щоб по його межі з’явилась рамочка і курсор 

набув відповідного вигляду: 

 

Після цього необхідно затиснути ЛКМ та перетягнути вид до нового місця його 

розташування на кресленику і відпустити ЛКМ. Оскільки вид зліва та зверху є проекційними, 

то і перетягування здійснюється зі збереженням проекційного зв’язку. 

 

За необхідності можна перенести обрані види одним цілим об’єктом. Для цього 

необхідно виділити види, затиснувши клавішу Ctrl, та перетягнути за рамку одного з них всіх 

їх до нового місця розташування. 

Побудуємо ізометричний вид твердотільної моделі із реалістичним відображенням по 

основному виду (виду спереду). Для цього оберемо інструмент Model view (Вид моделі). 

Натиснемо ЛКМ по виду спереду, а в Менеджері властивостей оберемо Orientation 
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(Орієнтація) Isometric (Ізометричний вид), стиль відображення Display style – Shaded with 

edges (Заливка із краями). Змінемо масштаб виду Scale на 1:1 через поле Use custom scale 

(Задання масштабу користувачем). Оскільки масштаб головного виду спереду 2:1, то масштаб 

1:1 призведе до двократного зменшення нового виду відносно головного. Також бажано 

поставити галочку в Preview (Попередній перегляд). Тоді на кресленику з’явиться попереднє 

відображення нового виду, що полегшить визначення місця його розташування на кресленику. 

Натискання ЛКМ на кресленику закінчить побудову ізометричного виду тривимірної моделі. 

 

Розрізи  

Побудуємо складний горизонтальний розріз до виду спереду: 

 

Для цього використаємо інструмент Section view (Розріз). Складний розріз планується 

виконати через площини внутрішнього отвору, які на виді спереду не відображені (оскільки 

знаходяться всередині моделі). Тому доцільно тимчасово змінити відображення виду спереду, 

відобразивши невидимі лінії. Для цього натискаємо ЛКМ на вид спереду. В Менеджері 

властивосте обираємо в Display style (Стиль відображення) Hidden lines visible (Показати 

невидимі лінії): 
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Натискаємо зелену галочку в Менеджері властивостей для підтвердження зміни 

відображення виду спереду. Після цього на основному виді невидимі лінії, які характеризують 

внутрішню будову твердотільної моделі на цьому виді, стануть видимі (хоча трішки менш 

інтенсивно, ніж видимі лінії). Оскільки інші ортогональні види пов’язані із видом спереду, їх 

відображення також зміниться: 

Було Стало 

  

 

Оскільки складний розріз планується в декількох горизонтальних площинах, то в 

Менеджері властивостей оберемо Cutting line (Лінія розрізу) горизонтальну Horizontal  

 

Оберемо точку початку розрізу на виді спереду. Перша й остання точка можуть 

розміщуватись безпосередньо на лінії виду. Це дозволить більш зручно обрати точку початку 

розрізу. Отже, алгоритм побудови: 

1. Задаємось точкою початку розрізу натисканням ЛКМ (оскільки поки активний 

режим простого горизонтального розрізу можна обрати т будь-яку точку на лінії 

цього розрізу). Якщо підтвердити побудову і вийти з команди Section view (Розріз), 

то буде побудовано простий (одинарний) горизонтальний розріз. 
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2. Після натискання ЛКМ з’явиться графічне меню. Продовжимо створенням 

одинарного перегину. Для цього в графічному меню натискаємо другу іконку Single 

offset (Одинарний перегин): 

 

3. Вказуємо першу точку до перегину: 

 
4. Вказуємо другу точку після перегину: 

 
Хоч наступний перегин заплановано робити посередині внутрішнього отвору, 

проте дану точку зручніше було проставити на внутрішній стінці отвору через 

наявну спливаючу прив’язку до середини висоти верхнього внутрішнього отвору. 

Оскільки обидві точки лежать в одній горизонтальній площині, то і дадуть один 

результат. 

5. Одинарний перегин побудовано, тому знову спливе графічне меню: 

 

Оскільки запланована побудова ще одного перегину в складному перерізі, знову 

обираємо другу іконку Single offset (Одинарний перегин). 

6. Обираємо першу точку одинарного перегину по центру верхнього внутрішнього 

отвору: 
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7. Обираємо другу точку одинарного перегину посередині висоти нижнього 

внутрішнього отвору: 

 

Якщо виникають трудності з вибором токи посередині висоти отвору (наприклад, 

коли спрацьовує інша прив’язка), можна під час вибору точки натиснути ПКМ та 

з контекстного меню обрати Quick snaps (Швидкі прив’язки) та обрати необхідну 

(в даному випадку Midpoint snap (Прив’язка до середини лінії)). 

8. Друга точка другого перегину побудована. Знову відобразиться графічне меню. 

Оскільки побудова задання траєкторії складного горизонтального розрізу закінчена, 

завершуємо команду шляхом натискання зеленої галочки в графічному меню або в 

Менеджері властивостей. 

9. Біля виду спереду в проекційному зв’язку до нього відобразиться фантом 

майбутнього розрізу, який переміщується мишкою. 

 

10. Програма запропонує напрямок виду розрізу. Його можна змінити в менеджері 

властивостей, натискаючи кнопку Flip direction (Змінити напрямок). Оскільки 

планується відкинути верхню частину моделі, змінимо напрямок шляхом 

натискання даної кнопки. 
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Якщо нижче кнопки поставити галочку в Auto flip (Автоматичне повертання), то 

напрямок виду розрізу змінюватиметься на протилежний якщо курсор миші 

перетинатиме лінію розрізу у відповідності до сторони розрізу. Обираємо 

 
11. Розташування розрізу необхідно змінити. За стандартом розріз може бути 

розміщений на будь-якому вільному місці кресленика без проекційного зв’язку до 

виду, за яким він був створений (адже на виді має позначення, наприклад, А поряд 

зі стрілкою та А-А поряд із самим розрізом). Проте в даному випадку переміщення 

розрізу ускладнене накладеному на ньому проекційним зв’язком. Для вимкнення 

проекційного зв’язку необхідно натиснути ПКМ на розрізі і обрати з контекстного 

меню пункт Alignment > Break alignment (Вирівнювання > Розірвати 

вирівнювання) 

 

12. Задаємо нове розташування розрізу, переміщуючи його, затиснувши ЛКМ на 

ньому. Побудова складного горизонтального розрізу до виду спереду звершена. 
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13. Приховаємо невидимі лінії. Для цього обираємо вид спереду і в Менеджері 

властивостей в полі Display style (Стиль відображення) обираємо відповідний тип 

Hidden lines removed (Видалено приховані лінії): 
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Додаткові позначення на кресленику 

До додаткових позначень на кресленику відносяться нотатки, позиції, позначення 

зварних швів, отворів, штамповок, центрів кіл, різьби, форми, баз, виносок, осьових ліній, 

штриховки, заливки тощо. 

Дані інструменти знаходяться на інструментальній панелі Annotation (Нотатки) на 

вкладці Annotation (Нотатки) Диспетчера команд. 

Інструментальна панель Annotation (Примітки): 

 

Інструменти даної панелі також можна обрати через меню Insert (Вставка): 

 

Інструменти панелі Annotation (Нотатки): 

Іконка Назва Призначення 

 
Note 

(Нотатка) 

Вставка в кресленик нотатки, що може містити 

простий текст, символи, параметричний текст та 

гіперпосилання. Виноска може бути прямою, 

вигнутою або з вигнутими покажчиками 

 
Linear note pattern 

(Лінійний масив нотаток) 

Задання нотатко у вигляді лінійного масиву 

 
Circular note pattern 

(Круговий масив нотаток) 

Задання нотатко у вигляді кругового масиву 

 
Balloon 

(Позиція) 

Вставка позицій 
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Auto balloon 

(Автопозиція) 

Автоматична генерація позицій 

 
Stacked Balloons 

(Група позицій) 

Дозволяє об’єднати декілька позицій на одній 

виносці 

 
Magnetic line 

(Магнітна лінія) 

Створення лінії, що призначення для 

вирівнювання позицій вздовж неї 

 
Caterpillar 

(Гусеничний) 

Додання позначення зварних швів як гусеничних 

швів, що вказує на розташування та довжину 

зварного шва на кресленику (але позначення 

зварного шва чи геометрії зварного шва) 

 
End Treatment 

(Обробка торців) 

Додання позначення зварних швів як позначення 

обробку торців без позначення зварного шва чи 

геометрії зварного шва 

 
Surface finish 

(Позначення шорсткості 

поверхні) 

Додання позначення шорсткості поверхні 

 
Weld symbol 

(Позначення зварного шва) 

Додання позначення зварного шва 

 
Hole callout 

(Позначення отвору) 

Додає керовані розміри діаметра отвори, 

створені за допомогою інструмента "Отвір під 

кріплення" або кругових елементів вирізу 

 
Geometric tolerance 

(Допуски відхилення форми) 

Додає позначення допусків з їх значеннями 

 
Datum feature 

(Базова поверхня) 

Створює позначення базової поверхні 

 
Datum target 

(Місце, що задає базу) 

Задає місце на кресленику, яке визначає базу 

 
Cosmetic Thread 

(Умовне позначення різьби) 

Додає умовне позначення різьби, а саме менший 

(внутрішній) діаметр різьби деталі типу «вал» 

або більший (зовнішній) діаметр різьблення в 

отворі і може включати умовне його позначення 

 
Multi-jog Leader 

(Виноска зі зламом) 

Для створення виносок з необхідною кількістю 

вигинів 

 
Dowel Pin Symbol 

(Позначення штифта) 

Додання до отворів (кругових кромок, ескізів кіл 

або дуг) позначення штифта. Позначення 

відповідає розміру вибраного отвору 

 Center mark 

(Покажчик центру) 

Задає місце, яке є центром кола, дуг. Може бути 

орієнтиром для нанесення розмірів 

 
Centerline 

(Осьова лінія) 

Додає лінію, яка позначає центр радіальних чи 

діаметральних поверхонь 
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Area hatch/fill 

(Штриховка / Заливка) 

Додає штриховку або заливку в замкнену область 

на елемента на кресленику 

 

Location Label 

(Мітка розташування) 

Для розміщення мітки розташування для 

місцевих видів, розрізів та додаткові видів 

кресленика для надання їм місцерозташування 

листа та зони для батьківського виду 

 
Model Items 

(Елементи моделі) 

Для додання нотаток, розмірів і довідкової 

геометрії з моделі (деталі або збірки) в кресленик 

 
Hide/Show Annotations  Відображає або приховує наявні позначення на 

кресленику 

 
Revision cloud 

(Хмара перегляду) 

Додання хмароподібного елементу для 

привернення уваги до конкретного місця на 

кресленику 

Таблиці 

Інструментальна панель Tables (Таблиці) призначена для створення на кресленику 

таблиць. Вона розміщена на вкладці Annotation (Нотатки) в Диспетчері команд. 

 

Інструменти панелі Tables (Таблиці): 

Іконка Назва Призначення 

 

General table 

(Загальна таблиця) 

Створення загальної (довільної) таблиці для 

ручного введення необхідних даних 

 

Hole table 

(Таблиця отворів) 

Для автоматичної генерації інформації про 

отвори в табличному форматі 

 

Bill of material 

(Специфікація) 

Для додання в кресленик таблиці специфікації 

деталей збірки 

 

Excel based bill of materials 

(Специфікація у вафлі Excel) 

Створення специфікації на основі таблиці Excel. 

Кресленик може містити специфікацію у вигляді 
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таблиці або специфікації у файлі Excel, але не 

обидві 

 

Revision table 

(Таблиця змін) 

Додає таблицю змін (блок) та позначення 

асоційованої редакції у кресленик 

 

Excel design table 

(Таблиця параметрів Excel) 

Таблиця параметрів дозволяє створювати кілька 

конфігурацій деталей або збірок шляхом задання 

параметрів у вбудованій таблиці Microsoft Excel 

 

Weldment cut list 

(Перелік зварних деталей) 

Для створення схожої до специфікації таблиці 

для вирізаних зварних конструкційних профілів 

 

Weld table 

(Таблиця зварних швів) 

Додання на кресленик таблиці зварних швів 

 

Bend table 

(Таблиця згинів) 

Додання на кресленик таблиці згинів деталі, що 

є листовим тілом 

 

Title Block Table 

(Таблиця блоку заголовка) 

Для деталей і збірок таблиці, в яких можна 

зв'язати представлену в них інформацію з 

властивостями окремої конфігурації документа. 

 

Punch table 

(Таблиця штамповок) 

Додання на кресленик таблиці штамповок, які 

містять елементи форми та бібліотечні елементи, 

що використовуються в тілах з листового металу 

 

General tolerance table 

(Таблиця загальних допусків) 

Створення таблиці для відображення поточних 

допусків 

Нанесення розмірів 

Інструменти для нанесення на кресленику розмірів  знаходяться на вкладці Annotation 

(Нотатки) в Диспетчері команд. Це інструментальна панель Dimensions (Розміри) та 

інструмент Model items (Елементи моделі): 

 

Розміри на кресленику пов'язані з моделлю, тому будь-які зміни в моделі будуть 

відображатись на кресленику. 

Зазвичай розміри створюються по мірі створення кожного елемента деталі. Потім вони 

проставляються  в різні допоміжні види. При зміні розміру в моделі оновлюється кресленик, а 

при зміні вставленого в кресленик розмір змінюється модель. 

За замовчуванням розміри відображаються чорним кольором. Це також відноситься до 

розмірів, які відображаються синім кольором в документі деталі або збірки. Справжні розміри 

за замовчуванням відображаються сірим кольором у скобках. 
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Розміри проставляються до деталей лише один раз, навіть якщо деталь відображається 

в кількох екземплярах у збірці. 

При імпорті розмірів відразу у всі види, розміри з'являються в найбільш придатному 

для цього виді. Розміри елементів, що з'являються в часткових видах (наприклад місцевому 

виді або розрізі), спочатку вказуються в цих видах. 

При вставці розмірів у вибрані види можна проставити розміри для всієї моделі або 

вибірково для одного або декількох складальних одиниць (у кресленику збірки), або для 

елементів (в кресленику деталі або збірки). 

Розміри розміщуються у відповідних видах. Можна вибрати, чи потрібно залишити 

дублюючі розміри в меню Tools > Options > Drawing (Інструменти > Параметри > 

Кресленик). Якщо розмір був проставлений в один із видів, він не проставляється повторно в 

іншому виді. Також можна вибрати параметр (Виключити повтори) при вставці елементів 

моделі (розміри, примітки, довідкова геометрія). 

Можна видалити розмір з одного виду, а потім поставити його в інший вид або 

перемістити або скопіювати його в інший вид. 

Інструментальна панель Dimension (Smart dimension) [Розмір (Розумний розмір)] 

Інструментальна панель Dimension (Smart dimension) [Розмір (Розумний розмір)] 

призначена для почергового нанесення розмірів на видах елемента кресленика. 

 

Інструменти панелі Smart dimension (Розумний розмір): 

Іконка Назва Призначення 

 

Smart dimension 

(Розумний розмір) 

Нанесення розмірів, тип яких визначаються 

вибраними об’єктами ескізу. 

 

Auto Insert Dimension Нанесення розмірів на ескізі з автоматичним 

розпізнаванням типу об’єкта ескізу 
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(Автоматичне нанесення 

розмірів) 

 
Horizontal dimension 

(Горизонтальний розмір) 

Задає горизонтальний розмір між двома об'єктами. 

 
Vertical dimension 

(Вертикальний розмір)  

Задає вертикальний розмір між двома об'єктами 

 

Baseline dimension  

(Розмір від базової лінії)  

Створення групи лінійних розмірів, виміряних в 

тому самому місці 

 

Chain dimension 

(Ланцюговий розмір) 

Створення групи розмірів, кожен наступний з яких 

починається від закінчення попереднього 

 

Symmetric linear diameter 

dimension 

(Симетричний лінійний 

розмір діаметра) 

Cтворення симетричних лінійних розмірів діаметра, 

для яких потрібна лише одна сторона виноски 

 

Ordinate dimension 

(Ординатний розмір)  

Проставляння розмірів, що починаються з нульової 

ординати у кресленні чи ескізі. У кресленнях є 

довідковими розмірами, тому їх значення не можна 

змінювати чи використовуватиме керування 

моделлю 

 

Horizontal ordinate 

dimension 

(Горизонтальний 

ординатний розмір)  

Створення горизонтальних ординатних розмірів у 

кресленні або ескізі, що починаються по 

горизонталі першого обраного об'єкта 

 

Vertical ordinate dimension 

(Вертикальний ординатний 

розмір)  

Створення вертикальних ординатних розмірів у 

кресленні чи ескізі, що починаються по вертикалі з 

першого вибраного об'єкта 

 

Angular Running 

Dimension 

(Ординатний кутовий 

розмір)  

Створення кутового ординатного розміру в 

градусах від обраного об’єкта. 

 
Path length dimension 

(Розмір довжини шляху)  

Створення компонувальних ескізів наприклад для 

верстатів. 

 

Chamfer Dimension 

(Розмір фаски) 

Задання розміру фасок з використанням різних 

типів тексту, виносок та розмірів знаку X. 

Інструмент Model items (Елементи моделі) 

Інструмент Model items (Елементи моделі)  дозволяє вставляти розміри, примітки та 

довідкову геометрію з документа моделі (деталі або вузла) у кресленик у автоматизованому 

режимі. 

Вибір інструмента активує Менеджер властивостей: 
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Призначення полів із командами в Менеджері властивостей: 

Назва Призначення 

Message  

(Повідомлення) 

Показує підказку щодо виконання поточної операції 

Source/Destination 

(Джерело/Призначення) 

Вибір елемента, до якого будуть проставлені розміри та 

інші додаткові позначення 

Dimensions  

(Розміри) 

Вибір необхідних типів розмірів до обраного елемента на 

кресленику 

Annotations  

(Нотатки) 

Вибір необхідних типів додаткових позначень до 

обраного елемента на кресленику 

Reference geometry 

(Довідкова геометрія) 

Вибір необхідних типів інструментів довідкової геометрії 

до обраного елемента на кресленику, які будуть 

проставлені до обраного елемента на кресленику 
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Options  

(Параметри) 

Задає чи потрібно включити елементи з прихованих 

компонентів та чи необхідно використати розміщення 

розмірів на ескізі 

Layer  

(Шар) 

Вставка елементів моделі в указаний шар кресленика 

Проставлені розміри інструментом Model items (Елементи моделі) можуть дещо не 

відповідати очікуваному результату. Проте дані розміри можна видаляти та переміщувати. А 

потім доставити розміри, яких не вистачає, в ручному режимі за допомогою панелі Dimension 

(Smart dimension) [Розмір (Розумний розмір)]. 

Наприклад, результат проставлення розмірів на виді зліва раніше побудованого 

кресленика: 

Вид зліва до проставляння розмірів Вид зліва після проставляння розмірів за 

допомогою Model items (Елементи моделі) 

  

Виконаємо незначні переміщення розмірів. Результат: 
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Для зміни системи виміру або параметрів відображень значень розмірів необхідно 

знизу в Рядку стану натиснути на поточній системі виміру та обрати пункт Edit document units 

(Редагувати одиниці виміру документа): 

 

Відкриється вікно, в якому можна обрати, наприклад, систему виміру MMGS в 

міліметрах та задати відображення розмірів лише цілими числами: 
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Контрольні запитання 

1. Яке розширення файлів документів типу «Кресленик»? 

2. Як задати формат листа та його орієнтацію? 

3. Як змінити фон кресленика в Графічній області? 

4. Як додати довільний вид до існуючого на кресленик? 

5. Як зробити розрив існуючого виду? 

6. Як проставити розміри на кресленику? 

7. Як додати тривимірне зображення моделі на кресленик? 

8. Як проставити шорсткість на видах? 

9. Як побудувати складний розріз? 

10. Як додати таблицю на кресленик? 
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Атрибути тривимірної моделі, основний напис 2D-кресленика, 

специфікації та конфігурації 

Атрибути тривимірної моделі 

Атрибути моделі – набір змінних, які можуть набувати різних значень, наприклад 

матеріал, маса, найменування, позначення, розробник тощо. 

Додання атрибутів до документу (файлу SolidWorks) необхідно для заповнення 

основного напису 2D-кресленика та створення специфікації. 

Для відкриття вікна з атрибутами моделі необхідно в меню файл File > Properties 

(Файл > Властивості) або через кнопку швидкого доступу File properties (Властивості файлу) 

поряд з основним меню: 

 

 

Після вибору команди з’явиться вікно Summary information (Загальна інформація): 
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Вікно має три вкладки Summary (Загальна), Custom (Користувальницька) та 

Configuration specific (Особлива конфігурація). 

Вкладка Summary (Загальна) містить загальну інформацію про поточний документ. 

Вкладка Custom (Користувальницька) містить властивості моделі, притаманні для всіх 

конфігурацій моделі. 

Вкладка Configuration specific (Особлива конфігурація) містить властивості 

конфігурації поточного документа. 

Оберемо останню вкладку: 

 

У вікні з’явиться таблиця з можливими атрибутами файлу з можливістю додати новий. 

Таблиця містить стовпці з порядковим номером, назвою властивості (атрибуту) Property 

name, його типом Type, значенням / текстовим позначенням Value/Text expression та 

вирахуваним значенням Evaluated value: 

 

У ній наявні шаблонні властивості згідно наявних мовних пакетів програми. В 

останньому пункті можна додати користувацький: 

 

Наприклад, додамо властивість (атрибут) із назвою «Позначення». Тип атрибута можна 

лише обрати з чотирьох наявних: текстовий (може містити будь-які символи), дата, чисельний 

та логічний «так чи ні: 
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Оберемо текстовий тип атрибуту, введемо позначення ЛН01.065112.001 СБ: 

 

Додамо ще декілька атрибутів: «Найменування» зі значенням «Змішувач шнековий». 

Далі додамо ще один атрибут «Маса». Оскільки даний атрибут є типовим, його 

значення можна обрати із випадаючого списку: 

 

Хоча у списку назви позначень англійською мовою, а не українською, проте це не є 

проблемою. Адже це тільки позначення атрибуту для програми, назва змінної. За обрання її із 

спливаючого списку SolidWorks розуміє, яке саме значення має показувати. І на документі 

буде відображатись лише позначення, що з’явилось в останньому стовпчику Evaluated value 

(Вирахуване значення). У даному випадку це 10.87 (маса тривимірної моделі шнекового 

змішувача). 

Наступним доданим атрибутом буде «Розробник» зі значенням «Шевченко». Проте 

планується, що розробник Шевченко і в подальшому може вказуватись у атрибутах інших 

документів. Тому доцільно додати даний атрибут у вкладці Custom (Користувальницька): 
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У цій же вкладці користувацьких атрибутів можна додати, наприклад, «Тип елемента» 

зі значенням «1 Складальні одиниці». Цифра на початку необхідна для сортування елементів 

по розділам специфікації крім початкового розділу «Документація», який автоматично 

розміщується першим. 

 

Для підтвердження збереженої інформації та щоб вийти з режиму редагування 

атрибутів моделі необхідно у вікні Summary information (Загальна інформація) натиснути 

кнопку ОК. 

Аналогічним чином можна додавати інші атрибути моделі. Якщо вони мають 

стосуватись виключно поточного документа – тоді їх додавати у вкладці Configuration 

specific (Особлива конфігурація). Якщо доданий атрибут актуальний не тільки для поточного 

документа, а й для подальших створюваних документах, тоді доцільно атрибути вводити у 

вкладці Custom (Користувальницька). Крім того для автоматичного обрахування значень та 

автозаповнення деяких атрибутів (наприклад, маси, густини, матеріалу, площі поверхні тощо) 

позначення даних властивостей необхідно обирати із випадаючого списку (аналогічно 

розглянутого атрибуту «Маса»). 

Основний напис 2D-кресленика 

Основний напис тривимірної моделі збірки шнекового змішувача із попереднього 

розділу теми «Атрибути тривимірної моделі» має такий вигляд: 

 

Запустимо режим редагування основного напису, натиснувши ПКМ на кресленику та 

обравши пункт Edit sheet format (Редагувати основний напис): 



 162 

 

На кресленику зникнуть всі види (для акцентування уваги на основному напису), а на 

основному напису деякі позначення стануть синім кольором: 

 

Синім кольором позначені динамічні атрибути. Щоб визначити до якого атрибуту 

належить те чи інше значення синім кольором, необхідно або піднести до нього курсор і 

спливе його позначення, або натиснути на ньому ПКМ та обрати пункт Edit text in window 

(Редагувати текст у вікні) 
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Наприклад натиснувши на значенні маси 10.87 у спливаючому вікні відобразиться 

найменування відповідного атрибуту: 

 

Хоча в тривимірній моделі можуть (і мають) бути вже додані атрибути моделі, проте в 

основному напису вони можуть бути відсутні. Це пов’язано з відсутністю даних в SolidWorks 

щодо необхідності прив’язки того чи іншого атрибуту до конкретного місця в основному 

написі. 

Для додання значення атрибуту в основний напис додамо його. Для цього на вкладці 

Annotation (Примітки) в Диспетчері команд оберемо інструмент Note (Нотатка): 

 

Її поле введення з’явиться як фантом для можливості вибору місця її фіксації 

користувачем шляхом натискання ЛКМ: 

 

Після фіксації нотатки вона перейде в режим редагування. Після закінчення введення 

нотатку можна перетягнути в інше місце. Тому для зручності попередньо нотатку можна 

розмістити на вільному полі кресленика, а потім вже перетягнути на необхідне місце в 

основному написі. 

Отже попередньо розмістимо нотатку над основним написом: 
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У Менеджері властивостей з’являться параметри її редагування. Курсор стане 

активним всередині самої нотатки для безпосереднього вводу текстової або чисельної 

інформації. А в додатковому вікні стануть доступними параметри редагування тексту: 

 

За необхідності так можна додати нотатку з будь-яким необхідним вмістом і 

розташувати на основному написі. Проте в даному випадку додамо інформацію із введеної в 

тривимірну модель інформацію як її атрибут. 

Для цього в Менеджері властивостей активуємо параметр Link to property 

(Посилання на властивість), тобто обрання атрибуту моделі (як загальних користувацьких, так 

і конкретних лише для цієї тривимірної моделі: 

 

З’явиться вікно вибору місця розташування атрибуту та конкретно якого саме: 
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У вікні параметр Current document (Поточний документ) відповідає за вибір 

властивостей поточного кресленика, а параметр Model found here (Модель знаходиться тут) 

задає відображення атрибутів тривимірної моделі, за якою створений поточний 2D-кресленик. 

Отже, для вибору атрибутів, доданих у документ тривимірної моделі шнекового 

змішувача необхідно обрати (активувати) другий параметр Model found here (Модель 

знаходиться тут). 

Для вибору конкретного атрибуту тривимірної моделі необхідно розкрити список їх 

найменувань Property name (Найменування властивості). Крім шаблонних атрибутів 

програми у списку присутні і додані вручну: 

 

Додамо раніше доданий до тривимірної моделі атрибут «Розробник» зі значенням 

«Шевченко» та натиснемо кнопку ОК: 
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У полі нотатки на кресленику з’явиться значення цього атрибуту, тобто «Шевченко»: 

 

Налаштуємо тип та розмір шрифту: 

 

Підтвердимо редагування нотатки, натиснувши на зелену галочку в Менеджері 

властивостей, та за допомогою ЛКМ перетягнемо нотатку на основний напис: 
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Аналогічним чином додамо в основний напис атрибут тривимірної моделі 

«Найменування». А атрибут СБ замінимо на атрибут моделі «Позначення», також обравши 

його зі списку вибору властивостей: 

 

Додамо прізвище перевіряючого Франко, ввівши нотатку вручну: 

 

Оскільки прізвище Франко введено вручну, а не пов’язане із атрибутом (відповідно 

воно не є динамічним атрибутом), то  прізвище відображається чорним кольором. 

У поле основного напису «Масштаб» необхідно додати масштаб основного виду, який 

побудовано в масштабі 1:5. Це можна зробити, додавши в нотатку текст в ручному режимі. 

Проте в разі зміни масштабу виду цей напис не зміниться і перестане відповідати дійсності. 

Тому більш правильним варіантом буде додати примітку із вказанням на атрибут, але вже 

поточного документа (2D-кресленика) і обравши відповідне найменування атрибуту: 

 

Після цього в нотатці з’явиться масштаб. За необхідності необхідно відредагувати 

шрифт та перетягнути нотатку у відповідне поле основного напису: 
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Додамо ще дату створення документа в графі де вказаний розробник в режимі додання 

атрибуту поточного документа: 

 

Ще до підтвердження натисканням кнопки ОК у вікні є попередній перегляд як буде 

вставлене значення атрибуту в нотатку: 
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Після редагування формату шрифту та перетягування нотатки у відповідне поле 

основного напису її вміст не поміщається в задані межі: 

 

Відредагуємо шрифт тексту нотатки, обравши інструмент Fit text (Вписати текст) у вікні 

редагування шрифту або в Менеджері властивостей в розділі Text format (Формат тексту): 

 

 

Після можна ЛКМ перетягувати межі нотатки, а текст автоматично буде займати 

ширину вікна нотатки. 

У результаті основний напис матиме такий вид: 

 

Також в одній нотатці можна розміщувати декілька атрибутів або комбінувати із 

доданням тексту вручну. Наприклад позначення шифру документа в прикладі 

ЛН01.065112.001 СБ можна розділити на три атрибути. Перший атрибут моделі - це вибір 

конкретної групи розробників (ЛН01). Після підтвердження й додання вибору курсор 

ставиться в кінець нотатки і знову натискається додання посилання на атрибут. Далі 

обирається атрибут шифру типу апарата і порядковий номер документа або, наприклад, 

вводиться вручну (065112.001). Після підтвердження ставиться пробіл в нотатці та додається 

атрибут типу документа СБ. Отже вийшла одна нотатка із комбінованим наповнення декількох 

атрибутів і, можливо, доданням частини тексту вручну. 

Для закінчення редагування основного напису та повернення до редагування самого 

кресленика необхідно в правому верхньому куті Графічної області натиснути на відповідну 

графічну кнопку: 
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Оскільки за замовчування SolidWorks може мати відмінне від необхідного 

налаштування шрифту нотатки, щоб щоразу при доданні нотатки їх не редагувати можна для 

даного документу відредагувати ці налаштування в Options > Document 

properties > Annotations > Notes (Параметри > Властивості документу > Примітки > 

Нотатки): 

 

Натиснувши на кнопку Font (Шрифт), у новому вікні змінимо деякі налаштування, а 

саме оберемо шрифт GOST Type A, похилий (курсив):  

 

Доцільно основні позначення основного напису, які повторюються в різних документах 

додавати як користувацькі атрибути і потім лише обирати їх зі списку. Насамперед, це 

позначення організації виконавця, прізвища виконавця, перевіряючого (або декількох, 

відобразивши це в найменування атрибутів як, наприклад, «Перевіряючий Корольов», 

«Перевіряючий Зінченко» тощо). 
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Всі зміни, зроблені в основному написі, будуть збережені лише для даного документу 

(файлу). Проте можна на свій розсуд заповнити основний напис, зробивши його шаблон, і 

перезаписати поточний тип 2D-кресленика або зберігши його під іншою назвою. Наприклад, 

можна створити відразу 2D-кресленик, заповнити основний напис розробником, назвою 

організації у правому нижньому куті основного напису (наприклад, гр. ЛН-01, каф. МАХНВ, 

КПІ ім. Ігоря Сікорського), в позначенні додати нотатку ЛН01. для подальшого її редагування 

(доповнення). І всі ці написи виконати зміненим привальним шрифтом GOST Type A, курсив. 

За замовчуванням в основному написі в різних його полях є пусті нотатки, які можна 

редагувати замість створення нових і розміщення поверх пустих (чи їх видалення): 

 

Для зберігання такого шаблону кресленика із частково заповненим основним написом 

необхідно в меню File (Файл) обрати команду Save sheet format (Зберегти основний напис) і 

задати назву файлу (або перезаписати існуючий). 

Наприклад, створимо кресленик форматом А3 за ГОСТ, заповнимо частково основний 

напис (хто розробив та перевірив, підприємство, частково шифр документа та кількість листів 

1) та збережемо як новий файл в папці за замовчуванням з іншими відповідними файлами: 

 

Тепер створимо новий кресленик. Оберемо спочатку формат кресленику А3 

горизонтальний без модифікацій: 
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Тепер створимо ще один кресленик і у вікні вибору формату кресленика оберемо 

створений перед цим змінений (з частково заповненим основним написом) шаблон такого ж 

формату кресленика: 

 

Створиться такий кресленик: 
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Як видно, новий кресленик має з моменту його створення частково заповнений 

основний напис. 

Специфікації 

Специфікацію до 2D-кресленика можна створити безпосередньо на кресленику, або на 

окремому листу. За замовчуванням SolidWorks зорієнтований на створення специфікації разом 

з креслеником 2D.  

Для вставки таблиці специфікації доцільно спочатку налаштувати її параметри, а саме 

шрифт та лінії. Для цього необхідно перейти до Options > Document properties > Tables 

(Параметри  > Властивості документа > Таблиці) та змінити шрифт на ГОСТ А, курсив, 

розміром 5 мм. 

 
 



 174 

Також, відкривши розділ «Таблиці» та обравши пункт «Специфікації» (Bill of material), 

налаштуймо товщину ліній в 0,18 мм: 

 

Для додання специфікації на лист необхідно обрати команду через меню 

Insert > Tables > Bill of material або на вкладці Annotation в Диспетчері команд на 

інструментальній панелі Tables інструмент Bill of material. 

 
 

Далі необхідно обрати вид на кресленику, за яким необхідно створювати специфікацію. 

Зазвичай найбільш доцільно обирати головний вид моделі (зазвичай це вид спереду). 

Всі налаштування специфікації можна задати через Менеджер властивостей: 
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Зокрема необхідно обрати за якими рівнями буде створюватись специфікація 

(складальні одиниці чи за всіма деталями окремо). Цей параметр обирається через BOM type: 
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Також для вибіркового обрання значень конфігурацій окремої деталі необхідно обрати 

такий пункт: 

 

Після підтвердження створення специфікації натисканням зеленої галочки в Менеджері 

властивостей на кресленику з’явиться фантом специфікації. Для її фіксації необхідно 

натиснути ЛКМ у вибраному місці кресленика, наприклад: 

 

Звісно, кількість елементів у специфікації залежить від кількості компонентів 

тривимірної моделі. Найменування компонентів та їх позначення пов’язані з заповненням 

відповідних атрибутів компонентів в тривимірній моделі. 

У прикладі в стовпці «Part number» автоматично проставлені компоненти збірки згідно 

їх назв. 

Для зміни назви стовпців специфікації необхідно двічі натиснути ЛКМ над заголовком 

відповідного стовпця. 

Наприклад змінимо назву стовпця «Part number» на «Найменування». Подвійним 

натисканням над назвою отримаємо спливаюче вікно: 
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Обираємо із спадаючого списку пункт Custom property (Налаштування користувача). 

Це дозволить обрати введені раніше типи конфігурацій окрім наявних за замовчуванням. 

 

Далі можна відкрити повний список всіх конфігурацій (за замовчуванням та створених 

користувачем під час побудови компонентів тривимірних моделей чи їх редагування під час 

побудови збірки). 
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Як видно з рисунку, окрім стандартних типів конфігурацій наявна створена 

користувачем з атрибутом «Найменування». Обираємо її. 

 

Тепер назва стовпця змінилась на обрану «Найменування». Проте всі назви окрім 

«Шнек» зникли. Це пов’язано з тим, що лише під час створення компонента збірки «Шнек» 

лише для нього було додано атрибут «Найменування» із значенням «Шнек» форматом типу 

«Текст». Для заповнення всіх елементів специфікацій необхідно для всіх компонентів збірки 

створити атрибут «Найменування», ввівши відповідні назви компонентів у значення атрибуту. 

Для зміни шрифту, розташування тексту тощо необхідно виділити необхідні рядки або 

стовпці. Тоді з’явиться вікно налаштувань: 

 

Для додавання нових рядків чи стовпців, зміни висоти рядків або ширини стовпців, 

заблокувати ці значення, видалення, приховання або повторне відображення стовпців чи 

рядків, вмістити текст тощо необхідно натиснути ПКМ поряд з необхідним стовпцем чи 

рядком. Виділення відповідного стовпця чи рядки при цьому відбудеться автоматично: 

 



 179 

Наприклад, для додання стовпця зліва від обраного: 

 

Для сортування компонентів збірки (відповідно елементів специфікації) необхідно 

натиснути ПКМ на хрестику зліва вгорі таблиці і обрати команду Sort (Сортувати): 

 

З’явиться вікно налаштувань параметрів сортування: 
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У вікнах Sort by, Then by та наступним Then by можна обрати почергові принципи 

сортування. Тобто спочатку елементи специфікації будуть відсортовуватись за параметром, 

заданим у вікні Sort by. Елементи, які однакові за цим параметром між собою відсортуються 

за параметром, заданим в наступному вікні Then by. І якщо будуть однакові елементи за двома 

попередніми параметрами, тоді між собою вони відсортуються за параметром, заданим в 

третьому вікні Then by. 

Наприклад для сортування згідно ГОСТу необхідно обрати почергово такі параметри 

сортування: тип елемента, позначення, найменування. 

За необхідності специфікацію можна розмістити на окремому листі. Для додання листа 

до існуючого 2D-кресленика (до цього ж файлу) необхідно обрати відповідну команду через 

Insert > Sheet (Вставка > Лист) або натиснути на відповідну кнопку Add sheet (Додати лист) 

знизу на лівій бічній панелі: 

 

 

Після додання нового листа в Дереві конструювання з’явиться відповідний напис: 
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Для зміни формату листа потрібно натиснути ПКМ на його назві в Дереві 

конструювання та у спливаючому вікні обрати необхідне налаштування: 

 

 

Проте оформлення листа згідно вимог до специфікацій відсутні. Тому доречно обрати 

формат листа згідно ГОСТ форматом А4 вертикальний перший лист, вручну розграфити лист 

згідно норм та зберегти його як шаблон File > Add sheet format (Файл > Зберегти основний 

напис [Зберегти формат листа]), обравши йому нову назву (або перезаписавши наявний файл 

шаблону): 

 
 

Додання позицій на 2D-кресленик 

Для налаштування оформлення шрифту, ліній виносок позицій необхідно перейти до 

Options > Document properties > Annotation > Balloons (Параметри  > Властивості 

документа > Примітки > Позиції): 
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Необхідно обрати шрифт ГОСТ тип А, товщину ліній 0,18, тип позицій (одинарних та 

групових) – лінія під низом, розмір полички – одинарний розмір, інші – за необхідністю: 
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Для додання позицій оберемо команду через меню Insert > Annotation > Auto balloon 

(Вставка>Примітки>Автопозиції) або через вкладку Annotation в Диспетчері команд  

 

 

Для ручного додання однієї позиції поряд є команда Balloon (Позиція). 

Налаштування простановки позицій відбуваються через Менеджер властивостей: 
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Зокрема можна задати до чого будуть проставлятись лінії позицій Leader attachment: 

до граней, до кромок; задати алгоритм розташування позицій Pattern type. 

 

Для додання об’єднаних позицій на одній ліній виносці необхідно обрати команду 

Insert > Annotation > Stacked balloon (Вставка>Примітки>Група позицій). 

Розташування позицій (як за ручного додання, так і автопозицій) можна редагувати 

перетягування ЛКМ за маркерні точки на позиціях. 

Для вирівнювання позицій вздовж вертикальної або горизонтальної лінії можна 

скористатись командою Magnetic line (Лінія вирівнювання): 

 

 

Конфігурації деталей 

Конфігурації дозволяють на одному документі, відповідно в одному файлі, створити 

декілька варіантів побудованої тривимірної моделі. 

Розглянемо деталь шатуна, побудовану у відповідному документі «Шатун»: 
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В шатуні є два отвори з фасками під штифти та фігурний отвір для зменшення маси. 

Всі грані, окрім отворів під штифти, мають заокруглення. Діаметри отворів під шатуни рівні 

60 мм і 30 мм, міжцентрова відстань між ними становить 400 мм. 

Загальні розміри шатуна зображено на наступному рисунку: 
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Проте якщо на виробництві необхідне інше виконання цього ж шатуна, наприклад, 

змінивши міжцентрову відстань між отворами із 400 мм в 500 мм необов’язково створювати 

нову тривимірну модель. Це збільшить кількість створених документів та час на проектування. 

А за наявності більшої кількості варіацій виконання шатуна ще й можливе ускладнення по 

ідентифікації необхідного файлу. У такому разі рекомендовано створювати різні конфігурації 

у вихідному документі (файлі). 

Під час створення нового файлу в ньому вже наявна одна конфігурація Default (За 

замовчуванням). 

Для перевірки наявних конфігурацій необхідно у бічній лівій панелі управління 

перейти на вкладку Менеджера конфігурацій Configuration manager: 

 

Існує два основних способи для додання конфігурацій. 

Перший спосіб 

У Менеджері конфігурацій ConfigurationManager натиснемо ПКМ та оберемо Add 

configuration (Додати конфігурацію): 

 

Активується вкладка Менеджера властивостей, на якій необхідно задати назву 

створеній конфігурації. Додатково можна навести опис та коментар: 
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Введемо назву, опис та коментар. Всі пункти заповнювати необов’язково. 
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Створення нової конфігурації підтверджується натисканням зеленої галочки в цьому 

вікні. 

У результаті активується щойно створена нова конфігурація тривимірної моделі, 

названа користувачем як «01»: 

 

Змінемо довжину міжцентрової відстані з 400 мм на 500 мм. Для редагування розміру 

необхідно двічі натиснути на розмірі, обравши відповідний елемент тривимірної моделі в 

Графічній області: 

 

УВАГА! Щоб на тривимірній моделі відображались розміри 

має бути активований режим Instant3D! 

Також для зміни значення розміру можна зайти в режим редагування відповідного 2D-

ескізу: 
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Зміни розміру міжцентрової відстані отворів необхідно зберегти лише для створеної 

конфігурації. Тому перед збереженням введеного розміру необхідно у цьому ж вікні відкрити 

список наявних конфігурації, натиснувши на іконку All configuration (Всі конфігурації) і 

обрати пункт This configuration (Ця конфігурація): 

 

Також необхідно в цьому ж віконці натиснути на кнопку Rebuild (Перебудувати) щоб 

внесені зміни відразу відбулись після натискання на зелену галочку. 

У результаті документ містить дві конфігурації: перша за замовчуванням Default та 

створено вручну 01. Перехід між конфігураціями здійснюється подвійним натисканням ЛКМ 

на їх назвах. При цьому в Графічній області тривимірна модель буде змінюватись в 

залежності від обраної конфігурації. 
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Активована конфігурація за замовчуванням, де міжцентрова відстань становить 400 

мм: 

 

Активована нова конфігурація «01», де міжцентрова відстань становить 500 мм: 

 

Аналогічним чином створимо ще одну конфігурацію, назвавши її «02». Наразі 

видовжений шатун аналогічний з конфігурації «01» та виглядає так: 
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У новій конфігурації «02» змінемо довжину фігурного отвору, збільшивши відстань 

міжцентрової відстані зі 192 мм до 380 мм. 

Для цього зайдемо в режим редагування цього розміру 192 мм, змінемо на 380 мм, 

обравши This configuration (Ця конфігурація), натиснемо Rebuild (Перебудувати) та зелену 

галочку. Зміни почнуть відображатись відразу після натискання Rebuild (Перебудувати): 

 

У результаті отримаємо видовжений фігурний отвір у новій конфігурації «02». Загалом, 

у файлі документа «Шатун» отримаємо три конфігурації, перемикаючись між ними отримаємо 

три варіації однієї і тієї ж деталі: 
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Конфігурація «Default» Конфігурація «01» Конфігурація «02» 

 
  

У нових конфігураціях крім змін в розмірах, також можна, наприклад, змінювати 

матеріал деталі, видаляти/приховувати старі або додавати нові елементи. 

Недоліком першого способу створення нової конфігурації та редагування тривимірної 

моделі в ній є те, що це потребує редагування кожного елемента окремо із обранням 

новоствореної конфігурації. Це збільшує загальний час її компоновки та збільшує вірогідність 

допущення помилок. 

Другий спосіб 

Запустимо режим редагування розмірів поточних конфігурацій (але із можливістю 

додання нових). У нашому випадку розглянемо вже змінюваний розмір першочергово у 400 

мм. Для цього натиснемо ПКМ на цьому розмірі тривимірної моделі: 
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Оберемо пункт Configure dimension (Налаштувати розмір). Відкриється вікно Modify 

configuration (Змінити конфігурацію), у якому наведена інформація про цей розмір у всіх 

існуючих конфігураціях: 

 

Назва активної конфігурації відображається жирним. Для зміни активної конфігурації 

потрібно двічі натиснути на її назві. Оберемо конфігурацію «02»: 

 

Як видно з рисунку, наразі в документі існує три конфігурації (вихідна за 

замовчуванням та дві додані користувачем). Поряд в стовпчику показані значення обраного 

перед цим розміру в кожній із конфігурацій. 

Перевагою цього способу є, насамперед, те, що зручно можна в одному вікні редагувати 

ряд значень розмірів в кожній із конфігурацій. 

Уявімо, наприклад, що за поставленою задачею в наведеному прикладі необхідно, щоб 

у третій конфігурації «02» (за видовжених шатуна до 500 мм та фігурного отвору до 380 мм) 

додатково необхідна зміна верхнього отвору з 60 мм до 40 мм та нижнього отвору з 30 мм до 

20 мм: 
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Для зміни розмірів отворів  необхідно без закриття вікна Modify configuration (Змінити 

конфігурацію) почергово обрати розміри отворів в Графічній області SolidWorks подвійним 

натисканням ЛКМ на цих розмірах. 

Це можливе без додаткових операцій якщо ці розміри знаходяться в тому ж ескізі (чи 

дії), що й обраний перед цим розмір. Тобто за умови, що необхідні розміри вже 

відображається. Проте в даному випадку розміри отворів не відображаються: 

 

Отвори були створені в іншому ескізі, ніж ескіз контуру шатуна, тому при запуску 

конфігурацій розміру міжцентрової відстані 500 мм не видно розмірів отворів 60 мм та 30 мм. 
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Для обрання цих розмірів отворів необхідно натиснути двічі на отворах в тривимірній 

моделі. У вікні Modify configuration (Змінити конфігурацію) з’явиться стовпчик Suppress 

(Погасити) операції вирізання отворів Cut-extracted (Вирізано-витягнуте), а на тривимірній 

моделі стануть відображатись розміри отворів: 

 

За необхідності можна погасити (відмінити) команду створення отворів в будь-якій 

конфігурації, поставивши галочку у відповідній комірці. У результаті отвори в даній 

конфігурації зникнуть (стануть прихованими; їх фантом залишиться як підказка, що отвори 

можна відобразити знову). Наприклад: 
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Якщо дану операцію проводити не планується можна прибрати стовпець (наприклад, 

для вивільнення пустого місця у вікні Modify configuration (Змінити конфігурацію)). 

Щоб перейменувати стовпець необхідно натиснути ПКМ на назві стовпця та ввести 

необхідну назву: 

 

 

 

За необхідності також можна перейменувати позначення розміру, натиснувши на 

відповідній йому назві ПКМ. Наприклад, перейменуємо позначення розміру «D6» в 

«міжцентровий»: 

 

Очевидно, що ця ж назва відображатиметься в Графічній області  на тривимірній 

моделі для позначення розміру. На саме ж числове значення зміна назви позначення не вплине. 
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Для видалення будь-якого стовпця (тобто його відображення в таблиці, а не дії чи 

розміру) потрібно натиснути ПКМ на його назві та обрати команду Delete (Видалити): 

 

Отже, після видалення стовпця «Отвори» таблиця оновилася. А оскільки перед цим 

було активовано відображення на тривимірній моделі розмірів побудови отворів, відповідні 

розміри відображаються в Графічній області: 
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Двічі натискаємо ЛКМ на діаметральних розмірах отворів у 60 мм та 30 мм, в результаті 

чого в таблиці вікна Modify configuration (Змінити конфігурацію) з’являться відповідні 

стовпці: 

 

Змінимо значення розмірів отворів, ввівши у відповідних комірках таблиці необхідні 

значення для конфігурації «02» (зміна верхнього отвору з 60 мм до 40 мм та нижнього отвору 

з 30 мм до 20 мм). 

 

Для підтвердження та закриття вікна налаштувань Modify configuration (Змінити 

конфігурацію) необхідно натиснути кнопку ОК. Для підтвердження введення та застосування 

нових значень розмірів отворів необхідно натиснути кнопку Apply (Застосувати). За 

необхідності також можна натиснути кнопку Rebuild active configuration (Перебудувати 

активну конфігурацію) для оновлення в тривимірній моделі всіх значень. 

 

Оскільки зміни для розмірів отворів зроблені у активній конфігурації, ці результати 

відразу стануть видимими на тривимірній моделі: 
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Порівняння шатуна за конфігурацією «02» до зміни значень розмірів отворів у ній та 

після зміни: 

Конфігурація «02» до зміни розмірів Конфігурація «02» після зміни розмірів 
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Вікно Modify configuration (Змінити конфігурацію) крім налаштувань поточних 

конфігурацій також дає можливості додати нові та відразу задати необхідні значення розмірів 

та інших параметрів тривимірної моделі. 

Для прикладу створимо ще одну конфігурацію «03», у якій верхній отвір становитиме 

80 мм, нижній отвір 40 мм, а фігурний отвір буде відсутнім. 

Спочатку необхідно створити нову конфігурацію. Натиснемо ЛКМ на назві <Create a 

new configuration> (Створити нову конфігурацію) в останньому рядку таблиці вікна Modify 

configuration (Змінити конфігурацію)  

 

Введемо назву «03» та натиснемо на першій комірці: 

 

Як видно з рисунку, комірки автоматично заповнилися значення розмірів останньої 

конфігурації. 

Введемо нові необхідні значення діаметральних розмірів верхнього та нижнього 

отворів у 80 та 40 мм. Проте навіть після натискання на кнопці Apply (Застосувати) на 

тривимірній моделі зміни не будуть відображатись. Це пов’язано з тим, що створення нової 

конфігурації не робить її автоматично активною. Отже, необхідно двічі натиснути на назві 

«D3» в першому стовпчику Configuration name (Назва конфігурації). Після цього нова 

конфігурація «03» стане активною, а зміни відобразяться на тривимірній моделі: 
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Залишилось видалити фігурний отвір із конфігурації «03». Для цього потрібно обрати 

цей виріз фігурного отвору на тривимірній моделі 

  

І двічі натиснути ЛКМ на ньому (можна відразу двічі натиснути без виділення). 
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У вікні Modify configuration (Змінити конфігурацію) з’явиться новий стовпчик 

відповідної операції (вирізання фігурного отвору з можливістю погасити). Також на 

тривимірній моделі з’являться розміри, які, за необхідністю, також можна редагувати для 

будь-якої конфігурації: 

 

Поставимо галочку в щойно доданому стовпчику у рядку конфігурації «03»: 

 

Для застосування введених змін необхідно натиснути кнопку Apply (Застосувати). 

Оскільки раніше вже було активовано нову конфігурацію «03», то зміни відразу відобразяться 

на тривимірній моделі: 
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Якщо потрібно додати новий елемент в поточну конфігурацію, то достатньо як і разі 

без застосувань конфігурацій почати будувати цей елемент.  

Наприклад, додамо для останньої конфігурації «03» додатковий отвір діаметром 40 мм 

поряд з нижнім отвором з міжцентровою відстанню у 50 мм між ними. 

Для цього побудуємо закриємо вікно Modify configuration (Змінити конфігурацію), 

натиснувши кнопку ОК,  та побудуємо ескіз отвору на боковій поверхні шатуна: 

Ескіз отвору та сам новостворений отвір в тривимірній моделі: 

  



 204 

Наразі активна остання додана конфігурація «03», про що можна переконатись, 

обравши на бічній Панелі управління вкладку Менеджер конфігурацій: 

 

Оскільки новий отвір побудований вже після додання конфігурацій 01, 02, то в них 

отвір не буде відображатись (проте він там теж наявний, але погашений, тобто візуально 

прихований). В цьому можна переконатись, переключившись на інші конфігурацій подвійним 

натисканням ЛКМ на їх назвах в Менеджері конфігурацій. 

Отже, існуючі конфігурації шатуна: 

Default 

 

01 

 

02 

 

03 
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Дослідимо стан останнього отвору в інших конфігураціях. 

Для цього спочатку на тривимірній моделі виділимо останній отвір, натиснувши на 

ньому ЛКМ: 

 

Натиснувши на розмірі отвору 40 мм натиснемо ПКМ та оберемо пункт Configure 

dimension (Налаштувати розмір): 

 

Хоча розмір отвору 40 мм і присутній в усіх конфігураціях, проте це ще не вказує на 

відображення отвору. Натиснемо двічі ЛКМ на товщині отвору 40 мм щоб у вікні з’явився 

стовпчик налаштувань операції вирізання отвору: 
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Як видно з рисунку, отвір погашений для всіх конфігурацій, окрім «03». Додамо цей 

отвір, наприклад, для конфігурації «01», прибравши галочку у ній. Опісля зробимо цю 

конфігурацію активною для відображення змін на тривимірній моделі та натиснемо кнопку 

Apply (Застосувати): 

 

Як видно з рисунку, отвір в 40 мм з конфігурації «03» з’явився також і у конфігурації 

«01». 

Контрольні запитання 

1. Яке призначення атрибутів тривимірної моделі? 

2. Як додати значення атрибуту до нотатки кресленика? 

3. Алгоритм створення шаблону частково заповненого основного напису. 

4. Як додати до основного напису масштаб основного виду на кресленику в 

автоматичному режимі? 

5. Вказати декілька способів створення специфікації на кресленику. 

6. Яким чином вирівняти позиції по вертикалі за допомогою однієї команди? 

7. Як згрупувати декілька позицій на одному кресленику. 

8. Як змінити атрибут тривимірної моделі? 

9. Як видалити всі атрибути поточного документу? 

10. Як додати стовпці до специфікації? 
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Створення фотореалістичного зображення тривимірної моделі 

Надання тривимірній моделі фотореалістичного відображення 

Для побудованої тривимірної моделі деталі або збірки можна обрати матеріал та 

накласти на неї візуальні ефекти відображення кольору, текстури, написів, заднього фону та 

зберегти як фотореалістичне зображення. 

Нижче наведено методику задання матеріалу деталям збірки «Шнек змішувача». 

 

Для відображення існуючих параметрів застосованих до тривимірної моделі необхідно 

в Панелі управління відкрити вкладку DisplayManager. В DisplayManager є три вкладки: 

View appearances (Перегляд зовнішніх видів), View decals (Перегляд написів), View scene, 

lights, and cameras (Перегляд сцени, освітлення і камер). 

 

Наразі до даної моделі ще не було застосовано жодних відповідних параметрів 

відображення. Тому в DisplayManager замість інформації по параметрам виведена інформація 

з жовтим фоном про їх відсутність. 
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Для додання параметрів відображення на Панелі задач обираємо Appearances, scenes, 

and decals (Зовнішні види, сцени та написи). 
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Редагування параметрів відображення можна зайти в меню 

PhotoView360  > Edit appearance (PhotoView360 > Редагувати зовнішній вигляд). Якщо дане 

меню відсутнє, то його можна включити шляхом натискання на іконці PhotoView360, яка 

розташована на вкладці SOLIDWORKS add-in в Диспетчері команд. Також команди 

редагування розміщені на вкладці Render tools (Інструменти візуалізації) Диспетчера 

команд. 

У вікні, що відкрилось справа від вкладок Панелі задач, є три інструменти вибору: 

Appearance(color) (Зовнішні види (колір)) – для вибору типу матеріалу, Scenes (Сцени)  – для 

вибору сцени (середовища) для розміщення тривимірної моделі (по суті є фоном для моделі), 

Decals (Написи) – для нанесення написів, торгових марок, лейблів. 

Наприклад, оберемо матеріал polished brass (шліфована латунь) через 

Appearance(color) (Зовнішні види (колір)) із відкриваючого списку або графічних іконок 

відповідних матеріалів у вікні нижче. 

 

Для застосування обраного типу матеріалу необхідно перетягнути його графічне 

відображення на необхідний елемент тривимірної моделі в Графічній області. В даному 

випадку оберемо шнек. При цьому може відкритись додаткове вікно для уточнення вибору 

(наприклад, можна обрати застосувати до однієї деталі чи всієї збірки цілком. В разі 

пофарбування може уточнити фарбувати лише одну поверхні деталі, або всю деталь, або всю 

збірку). 
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В результаті шнек прийме забарвлення та текстуру обраного матеріалу – як у 

шліфованої латуні. Відображення може різнитись в залежності від налаштувань дисплею, 

можливостей відеокарти.  

Зліва у вкладці View appearances (Перегляд зовнішніх видів) в DisplayManager 

з’явиться запис про застосованого до моделі матеріалу «шліфована латунь». 

 

Застосуємо до половинок циліндричного корпусу сатинований титан (satin finish titan), 

до обох фланців шліфовану бронзу (polished bronze), а до кріпильних елементів шліфовану 

сталь (polished steel). 
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В розділі  Scenes > Studio scenes (Сцени > Студійні сцени) оберемо фон Factory floor 

(Заводська підлога), натиснувши ПКМ на графічному зображенні сцени та обравши пункт 

контекстного меню Add scene to part (Додати сцену до моделі). 

 

В результаті фон тривимірної збірки набуде такого виду: 
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Для додання написів потрібно в розділі  Decals (Написи) обрати необхідний графічний 

значок. Після перетаскування значка на необхідній частині деталі збірки є можливість зміни 

його масштабу та положення. Наприклад, додамо знак Recycling (Рециркуляція) ззовні на 

циліндричний корпус. Оберемо знак з розділу Decals (Написи): 

 

Після виділення циліндричного корпусу, обрання значка та маніпуляцій з ним для зміни 

його розміру та кута розміщення згідно поверхні корпусу, тривимірна модель збірки матиме 

такий вид: 
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Рендеринг фотореалістичного зображення 

Для налаштування якості, розмірів та інших параметрів кінцевого відображення 

твердотільної моделі необхідно натиснути на піктограму PhotoView 360 options (Параметри 

PhotoView 360) в DisplayManager. 

 

Також можна зайти до налаштувань через меню PhotoView 

360 > Options   (PhotoView 360 > Параметри) або в Диспетчері команд на вкладці Render 

tools (Інструменти візуалізації). 

Вікно DisplayManager набуде такого вигляду: 

Початок вікна Закінчення вікна  
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Насамперед в цьому вікні доцільно задати необхідні розміри зображення, виставити 

максимальну якість кінцевої генерації рисунку, поставити галочку Output ambient occlusion 

(Об’ємне світло на виході). 

Наприклад, задамо розмір зображення 1920×1080 пікселів, формат рисунку TIFF, 

якість кінцевої генерації рисунку на maximum (максимальна) та поставимо галочку Output 

ambient occlusion (Об’ємне світло на виході).  

 

Для рендерингу (генерації рисунку) необхідно натиснути на інструмент Final render 

(Остаточний рендеринг) на вкладці на вкладці Render tools (Інструменти візуалізації) 

Диспетчера команд або в меню PhotoView360 > Final render (PhotoView360 > Остаточний 

рендеринг). Перед цим за необхідності можна уточнити рамкою в Графічній області 

рендерингу, обравши команду Render region. 
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Після команди Final render (Остаточний рендеринг) розпочнеться генерація рисунку, 

яка може бути достатньо тривалою. Перебіг генерації рисунку буде відображатись в окремому 

вікні. 

Для збереження результатів рендерингу необхідно натиснути на кнопку Save and 

(Зберегти та…) та обрати місце, назву та формат файлу.  

Згенерований файл типу, збережений як 16-бітний tiff: 

 

Типове збереження тривимірної моделі як рисунку 

Також можна зберегти дане відображення твердотільної моделі як рисунок 

безпосередньо через меню File > Save as (Файл > Зберегти як). Проте якість зображення буде 

значно гіршою, адже не буде застосоване додаткове налаштування рендерингу. 

Збережене зображення через меню File > Save as (Файл > Зберегти як): 
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Порівняння згенерованих зображень: 

Через інструмент «Остаточний рендеринг» Через меню Файл > Зберегти як 

  

Контрольні запитання 

1. Чи є різниця у згенерованих зображеннях та збережених через меню Файл 

напряму? 

2. Як обрати задній фон для моделі? 

3. Як змінити матеріал компонента? 

4. Як задати якість відображення генерованого зображення моделі? 

5. Як змінити розширення файлу реалістичного зображення моделі? 

6. Як змінити пропорції генерованого зображення моделі? 

7. Як впливає розмір генерованого зображення моделі на час генерації моделі? 

8. Що таке рендеринг? 

9. Як додати написи на модель? 

10. Які типи файлів дають кращу якість відображення згенерового зображення 

тривимірної моделі?
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Створення анімаційного відео динамічної тривимірної моделі 

Ручне додання ефектів. Ключі 

Анімація тривимірних моделей необхідна для створення відео-презентацій їх 

зображення в 3D, показу відео збирання, розбирання, зміни позицій елементів, демонстрації 

руху окремих елементів або варіацій їх положення, демонстрації роботи пристрою тощо. 

Розглянемо створення анімаційного відео на прикладі збірки шнекового змішувача: 

 

Для роботи та налаштування анімації необхідну активувати відповідну вкладку Motion 

study (Дослідження руху/Анімація) знизу лівої бічної панелі управління, якій за 

замовчуванням присвоюється порядковий номер 1. 

 

Після її активації знизу вікна відобразиться часова шкала, на якій в подальшому будуть 

відображатись всі накладені ефекти до анімації. 

Вікно SolidWorks набуде такого вигляду: 
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Назви деяких елементів можуть відрізнятись в залежності від наявності різних мов 

інтерфейсу.  

Стрічка (область) анімації в збільшеному виді: 

 

Розмітка часової шкали у збільшеному виді: 

 

Для створення анімації необхідно, щоб був активний параметр Animation (Анімація) в 

полі Type of study (Тип дослідження): 

 

У цілому, можливі варіанти Animation (Анімація) та Basic motion (Базовий рух) 

 

У лівій частині Motion study (Дослідження руху/Анімація) є Дерево елементів з 

відображенням усіх елементів збірки, для яких можна створити рух в анімації. 

Для відображення параметрів, для яких можна задати анімаційні ефекти (зміну в часі) , 

необхідно розкрити компонент: 
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Як видно з рисунку, це такі параметри як Move (Перемістити/Рухати), Explode 

(Рознести) та Appearance (Зовнішній вигляд). 

Ключові точки (або просто ключі), що створюється на часовій шкалі і які показують 

часові межі налаштованого параметр анімації, є ромби. Кожен ромб відноситься до 

конкретного параметра і розташований в один рядок навпроти нього. Оскільки до анімації ще 

не було налаштовано жодного параметра, то всі ромби спочатку знаходяться на позначці нуль 

часової шкали: 

 

Додамо анімацію обертання шнека усередині змішувача. 

Наразі обертання шнека не обмежене взаємозв’язками і він має змогу вільно обертатись 

всередині змішувача у збірці: 

   

Додамо у часову шкалу анімації два ключі за положенням спіралі шнека. Для цього 

виділимо в Графічній області шнек, натиснувши на ньому. При цьому виділиться команда 

його створення як в Дереві конструювання, так і в Дереві елементів анімації: 
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Положення спіралі доцільно задавати через взаємозв’язок задання кута між площиною 

на кінці спіралі та зрізом корпусу змішувача. Оскільки такий взаємозв’язок відсутній, додамо 

його. Для цього оберемо інструмент Mate (Взаємозв’язок) та виділимо в Графічній області 

відповідні поверхні спіралі та корпусу змішувача: 

 

Звісно, даний взаємозв’язок можна було додати і перед створенням анімації. Проте 

створення взаємозв’язку в режимі Motion study (Дослідження руху) не додає даний 
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взаємозв’язок в стандартному режимі відображення тривимірної моделі. Тобто в даному 

випадку у звичайному стані шнек всередині змішувача має змогу обертатись, а в режимі 

анімації він зафіксований. 

Після виділення поверхонь обираємо взаємозв’язок задання кута між ними, задаємо 

нуль градусів (тобто розміщуються паралельно) та підтверджуємо команду створення 

взаємозв’язку. 

 

В Графічній області можна пересвідчитись, що шнек втратив можливість обертатись 

всередині корпусу змішувача. 

Перейдемо до Дерева елементів анімації. Тепер якщо розкрити елемент побудови 

шнека в розділі Mates (Взаємозв’язки) з’явився новий щойно створений взаємозв’язок, що 

характеризує положення спіралі разом зі шнеком в цілому відносно корпусу змішувача: 

 

Додамо новий часовий ключ параметра цього доданого взаємозв’язку, натиснувши 

ПКМ справа в полі часової шкали під значенням в 3 секунди навпроти (в одному ряду) з 

назвою даного взаємозв’язку: 



 222 

 

Оберемо команду Place key (Розмістити ключ). У результаті з’явиться відповідний 

ключ навпроти обраного взаємозв’язку з показним часовим інтервалом на його виконання 

(смужка гірчичного кольору): 

 

У доданому ключу числове значення кута між площинами аналогічне оригінальному, 

тобто нуль градусів. Змінимо це значення. Для цього необхідно двічі натиснути ЛКМ на 

новому ключу. З’явиться віконце зі значенням параметру взаємозв’язка: 

 

Введемо нове значення у 360 градусів (тобто повний оберт) та підтвердимо команду. 

Між ключами з’явиться синя лінія, що свідчить про наявність переходу між 

параметрами, що задані цими ключами: 
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Візуально тривимірна модель збірки не змінилась. Проте це пов’язано з особливістю 

нового значення в 360 градусів. Адже нове розміщення спіралі відповідає попередньому за 

умови виконання повного оберту. Щоб простежити стан шнека (тобто як змінюється перехід 

від одного значення параметра першого ключа до нового значення параметра другого ключа 

необхідно натиснути ЛКМ на числових значеннях часової шкали. Наприклад, натиснемо на 

відмітці у 1,7 секунди: 

 

При цьому шнек змінить своє положення, характерне для поточного моменту часу за 

умови, що повний його оберт становить 3 секунди (тобто налаштування, що були задані): 

 

Для кращої порівняння розміщення шнеку всередині корпусу змішувача в наступній 

таблиці показано зображення збірки змішувача у різний момент часу, заданого ключами: 
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0 секунд 

 

1,9 секунди 

 

2,5 секунди 

 

Для швидкого перегляду поточної анімації над часовою шкалою знаходиться повзунок 

для вибору необхідного моменту анімації: 

 

Для прорахунку зміни всіх параметрів тривимірної моделі під час переходу від одного 

її стану згідно ключа 1 до наступного згідно ключа 2 необхідно натиснути кнопку Calculate 

(Розрахувати): 

 

Після прорахунку стає можливим запуску анімації тривимірної моделі в Графічній 

області, натиснувши на кнопку Play from start (Відтворити спочатку) або Play (Відтворити): 

 

Також тепер з’явиться відмітка між ключами параметра Move (Перемістити/Рухати): 

 

Додатково можна налаштувати відтворення анімації у вікні SolidWorks (тобто в 

Графічній області), а саме обравши значення швидкості відтворення Playback speed, режиму 

відтворення Playback mode: Normal (Нормальний) – одноразове відтворення, Loop (Петля) – 
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зациклене відтворення та Reciprocate (Зворотно-поступальний) – зациклене відтворення 

пряме-зворотне: 

 

 

Майстер анімацій 

Також поряд розташована кнопка Animation wizard (Майстер анімацій), що відкриває 

вікно налаштувань для створення відеофайлу анімації: 

 

Вікно майстра анімацій виглядає наступним чином: 
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Найбільш поширеними опціями для створення анімації є команди створення обертання 

тривимірної моделі, рознесення елементів та зібрання разом. Для активності команд 

рознесення та зібрання у моделі має бути перед цим виконані відповідні операції. 

Оскільки перед цим збірку не було рознесено на елементи та, відповідно, зібрано назад, 

тому ці дві команди неактивні. Оберемо обертання моделі та натиснемо кнопку Далі. 

Програма запропонує обрати одну з головних осей, навколо якої можна задати обертання 

моделі,  кількість обертів та напрямок: 

 

Оберемо два оберти навколо осі Y за часовою стрілкою і натиснемо Далі. У вікні буде 

запропоновано ввести загальний час анімаційного відео та початок доданого типу анімації ( в 

даному випадку обертання). Оскільки за задумом планувалось, щоб спочатку у відео обертався 

шнек в нерухомому корпусі, а вже потім вся збірка починала обертатись для її наглядності, 

оберемо 12 секунд як вся тривалість обертання збірки та 3 секунда початок обертання: 
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Далі натискаємо Готово. У полі на часовій шкалі загальний час збільшився і становить 

15 секунд (попередні 3 секунди обертання шнека та додаткові 12 секунд обертання збірки ): 

 

Також додались нові ключі (ромби) навпроти позначення орієнтації та видів камери 

Orientation and camera views: 

 

Для врахування всіх доданих налаштувань анімації натиснемо кнопку Calculate 

(Розрахувати). При цьому тривимірна модель повністю повторить всі налаштування, задані в 

анімації. У даному випадку 3 секунди обертається шнек, а потім він зупиняється і 12 секунд 

обертається вже вся збірка. 

На часовій шкалі після  весь інтервал у15 секунд пожовтіє, що свідчить про те, що 

програма прорахувала цей діапазон: 

 

Збереження анімаційного відео 

Для збереження анімації тривимірної моделі в такому вигляді, як вона відтворюється у 

Графічній області в SolidWorks необхідно натиснути кнопку Save animation (Зберегти 

анімацію): 

 

У вікні, що з’явиться, необхідно ввести назву файлу, його тип, розширення документу: 
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Крім популярних розширень відеофайлів, також можна обрати розширення графічного 

формату (рисунків): 

 

Якщо обрати формат рисунку, то в такому випадку буде створено ряд файлів, в яких 

почергово відображатиметься перебіг протікання анімації. Наприклад, для даної анімації у 15 

секунд було створено 114 файлів: 
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Ось вибірково деякі з цих файлів: 

  

  

  

  

  

  

За необхідності додання рознесення та подальшого зібрання збірки необхідно спочатку 

виконати дані налаштування в тривимірній моделі, а потім вже, активувавши вкладку Motion 

study (Дослідження руху) та обравши Animation wizard (Майстер анімацій) налаштувати ці 

параметри анімації. 
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Рендеринг анімаційного відео  

Крім звичайного збереження анімаційного відео (тобто аналогічного, як і  

відображається анімація тривимірної моделі у Графічній області вікна SolidWorks), також 

можна зберегти відео шляхом рендерингу із застосуванням інструменту PhotoView 360.  

Тому спочатку перед збереженням анімації необхідно активувати PhotoView 360 на 

вкладці SOLIDWORKS add-in Диспетчера команд: 

 

Тепер аналогічно й звичайному збереженню анімації необхідно натиснути кнопку Save 

animation (Зберегти анімацію) над часовою шкалою. Тепер крім можливості збереження 

аналогічно анімації з екрану програми, так і за допомогою інструменту PhotoView 360: 

 

Обираємо режим збереження за допомогою інструменту PhotoView 360, необхідне 

розширення сторін відео, місце збереження, частоту кадрів тощо. 

Рендеринг досить ресурсоємний процес, тому його тривалість в залежності від 

можливостей персонального комп’ютера та складності тривимірної моделі може становити від 

хвилин до годин. 
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Оберемо розширення  файлу .avi, розміри сторін 1920*1080 px, частоту кадрів 30, час 

відео рівний тривалості анімації (показується жовтим на часовій шкалі): 

 

Натискаємо Зберегти. Далі в новому вікні необхідно обрати кодек для стиснення відео 

або обрати варіант без стиснення відео для максимальної якості та натиснути кнопку ОК. 

З’явиться вікно з відображенням показу пройденого часу:  
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Ефект «Вид з камери» 

До анімації також можна додати зміну ракурсу огляду тривимірної моделі згідно 

вказаної траєкторії виду з камери. 

Створимо ескіз кривої на площині, паралельній основній горизонтальній та вище неї на 

40 мм: 

  

Додамо камеру, активувавши на лівій Панелі управління вкладку Менеджер 

властивостей та його вкладку Scene, lights, and cameras (Сцени, освітлення та камери): 

 
Вікно SolidWorks набуде такого виду: 
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Тепер вже наявні два активні вікна. Зліва вікно з переглядом та задання розташування 

камери відносно тривимірної моделі. Справа вікно з тривимірною моделлю, розташування 

якої автоматично змінюється в залежності від задання розташування камери в лівому вікні. 

В лівому вікні камеру та точку цілі камери можна переміщувати за допомогою 

затискання на них ЛКМ. Розташуємо червону точку цілі на тривимірній моделі. 

 

Для більш швидкого розташування точки цілі на конкретному елементі моделі 

необхідно за активного поля Target point (Точка цілі) в Менеджері властивостей натиснути 

на необхідний елемент тривимірної моделі. Вона автоматично перенесеться на цей елемент. 

 

Для більш точного розташування червоної точки цілі в просторі без прив’язки до 

елемента можна почергово орієнтувати розташування тривимірної моделі перпендикулярно 

основним осям, натискаючи по ним в тріаді осей (динамічної позначки системи координат) 

внизу зліва поточного активного вікна. 

Наприклад, ось поточне орієнтування системи координат і, відповідно, тривимірної 

моделі в ній: 

 

Після натискання, наприклад, на червоній осі X в результаті орієнтація відображення 

набуде такого виду (розташується перпендикулярно цій осі X): 
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Після кожного такого орієнтування моделі затисканнями ЛКМ на точці цілі можна її 

переміщувати для більш точного позиціонування. 

Отже, налаштуймо камеру в Менеджері властивостей таким чином: 

1. У Target point (Точка цілі) поставити галочку в Target by selection (Ціль вибором) і 

обрати точку на шнеку тривимірної деталі. 

2. У Camera position (Розміщення камери) поставити галочку в Position by selection 

(Розміщення вибором) і обрати ескіз кривої. 

3. У Camera rotation (Обертання камери) за необхідності обрати кут нахилу камери. 

4. У Field of view (Поле огляду) налаштувати параметри огляду камери з можливістю 

активації налаштування перспективи Perspective (Перспектива). 

5. У Aspect ratio (width : height) (Співвідношення сторін: ширини до висоти) обрати 

співвідношення сторін вікна генеруємого камерою огляду. 
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Вікно програми: 

 
Переключимось на вкладку Motion study (Дослідження руху). Навпроти щойно 

створеної камери в кінці часової шкали додамо ключ, натиснувши ПКМ та обравши 

відповідний пункт: 

 
Відкриємо налаштування параметрів камери за ключем камери на початку часової 

шкали подвійним натисканням на ключу ЛКМ: 
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Як видно з рисунку, камери розташована в крайньому правому положенню, що 

відповідає задуму. Тому натискаємо ОК  для виходу з режиму редагування першого ключа 

камери. 

Відкриємо налаштування параметрів камери за ключем камери у кінці часової шкали 

подвійним натисканням на ключу ЛКМ. Змінимо розташування камери в крайнє ліве 

положення траєкторії за кривою ескізу: 

 

 

Місце змінювання у збільшеному виді: 

 

У результаті після підтвердження зміни параметрів ключа маємо бірюзову лінію між 

двома ключами камери, що свідчить про наявність руху тривимірної моделі за цим параметром 

(руху камери): 

 
Оскільки рух камери буде конфліктувати з попередньо доданим ефектом обертання 

камери за допомогою Майстра анімації, то видалимо той ефект (на рисунку лінія з ключами 

чорним кольором). 

Отже виділяємо непотрібний ефект: 
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Натискаємо кнопку Del для його видалення: 

 

Натискаємо Calculate (Розрахувати) для перерахування програмою зроблених змін: 

 

Проте на анімації в режимі камери руху камери (ракурсу на тривимірну модель) ще не 

відбувається. Для усунення цього необхідно обрати команду Disable playback of view keys 

(Вимкнути відтворення ключів перегляду) в контекстному меню, що відкривається 

натисканням ПКМ на параметрі Orientation and camera views (Положення та види камери). 

 

Після цього необхідно ще раз провести перерахунок натисканням кнопки Calculate 

(Розрахувати). 

Далі переходимо в режим перегляду камери, натиснувши ПКМ на назві камери в 

Менеджері властивостей та обравши пункт Camera view (Вид з камери): 
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Даний ефект також можна зберігати окремими рисунками або відео за допомогою 

кнопки Save animation (Зберегти анімацію): 

 

SolidWorks Motion: створення та аналіз руху тривимірних об’єктів 

SolidWorks Motion6 є додатковим компонентом пакету SolidWorks Premium і 

дозволяє створювати та аналізувати рух тривимірних моделей з урахуванням взаємодії різних 

об’єктів між собою, їх фізико-механічних властивостей, зокрема пружності, з урахуванням 

швидкості тіл та гравітації. 

Для активації (запуску) цього програмного додатку необхідно зайти в Options 

(Параметри) та обрати пункт Add-ins (Додатки): 

 

Відкриється вікно, в якому потрібно обрати SolidWorks Motion та натиснути кнопку 

ОК: 

 
6 Motion: англ. – рух 
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Розглянемо створення руху тривимірних тіл при їх взаємодії на наступному прикладі. 

Це збірка, яка складається з двох тривимірних моделей: деталі «Куля» та деталі «Піддон». До 

кулі додано взаємозв’язок дотичність її поверхні до верхньої площини піддона. 

 

Активуємо режим Motion study (Дослідження руху) та оберемо варіант Motion analysis 

(Аналіз руху): 
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Саме цей варіант є найбільш подібним до реальних умов руху твердих тіл з 

урахуванням взаємодії між собою та основних фізичних законів. 

Додамо дію гравітації на компоненти збірки, натиснувши кнопку Gravity (Гравітація): 

 

У правому нижньому куті в Графічній області з’явиться зелена стрілка, яка вказує 

поточне значення напрямку сили тяжіння: 

 

А в Менеджері властивостей є можливість відкоригувати значення прискорення 

вільного падіння та обрати одну з основних осей у якості напрямної для сили тяжіння, або 

можна побудувати додатково вісь. Оберемо вісь Y: 
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Для подальшого задання напрямку руху кулі додамо на поверхні піддону ескіз та 

побудуємо відрізок у ньому: 

 

Тепер додамо значення початкової сили, що діє на кулю (в напрямку відрізка). Для 

цього в Дереві анімацій натискаємо ПКМ на компоненту «Куля» і обираємо Initial velocity 

(Початкова швидкість): 

 

У Менеджері властивостей у полі Initial linear velocity (Початкова лінійна швидкість) 

вводимо значення швидкості у 1000 мм/с.  
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Далі за активного вище поля задаємо напрямок прикладання сили, обравши раніше 

побудований відрізок: 

 

Якщо відрізок не відображався, можна переключитись на вкладку Дерева 

конструювання і, натиснувши ПКМ на назві відрізка, обрати команду Show (Показати). 

Для зміни напрямку сили вздовж обраного елемента на протилежний в Менеджері 

властивостей є відповідна кнопка: 

 

Після всіх налаштувань у Менеджері властивостей вікно SolidWorks набуде такого вигляду: 



 243 

 

Підтверджуємо налаштування початкової лінійної швидкості натисканням зеленої 

галочки. 

Тепер вкажемо між якими елементи має відбуватись контакт. Для цього натиснемо на 

кнопці Contact (Контакт) інструментальної панелі анімації: 

 

За активного поля Selections (Обрані об’єкти) у Менеджері властивостей оберемо 

компоненти «Куля» та «Піддон»: 
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Також необхідно вказати матеріал компонентів нижче (порядок задання матеріалів не 

важливий). За відсутності необхідного матеріалу зі списку можна відключити розділ Material 

(Матеріал). У такому випадку нижче стане активним ручне налаштування фізичних 

параметрів: 

 

У нашому випадку оберемо акрил для кулі та алюміній для піддону. 

Налаштування параметрів для симуляції спрямованого удару по акриловій кулі по 

поверхні алюмінієвого піддону із початковою швидкістю кулі у 1000 мм/с завершено. 

Перед початком створення анімації необхідно відключити відображення ключових 

точко у відео: 
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Також задамо необхідну кількість кадрів за секунду, натиснувши на іконку Motion 

study properties (Властивості дослідження руху): 

 

Задамось частотою кадрів 60: 

 

Тепер необхідно щоб система зробила всі прорахунки з урахуванням доданих значень 

параметрів. Натискаємо на кнопці Calculate (Розрахувати): 

 

Анімаційне поле часової шкали виглядає наступним чином: 

 

Та все вікно SolidWorks в цілому: 
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Якщо зберегти анімаційне відео, то можна побачити, що ракурс спостереження може 

бути невдалим. Приклад скріншотів анімаційного відео: 
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Зміна положення збірки шляхом обертання не дасть ефекту для збереження 

анімаційного відео. У такому випадку для вибору кращого ракурсу спостереження (згідно 

якого формується анімаційне відео) з можливістю налаштувань спостереження (обрання 

аналогу фокусу об’єктива камери, перспективи тощо) доцільно додати камеру спостереження. 

Отже, додамо камеру Camera1 з обранням цілю спостереження посередині піддона та 

налаштувавши параметри зони знімання. А в полі часової шкали з ключами додамо ключ 

камери Camera1 у кінцевий момент часу: 

 

Де ключі камери Camera1: 

 

Як видно з рисунку, між ключами немає з’єднання, адже вони мають абсолютно однакові 

налаштування і руху об’єктів за цими ключами не відбувається. 

Для відображення анімації з ракурсу камери ця камера має бути включена: 
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Виконаємо ще раз перерахунок анімації натисканням на кнопці Calculate (Розрахувати). 

Після чого збережемо анімацію: 

 

Налаштуємо параметри збереження анімаційного відео. Для цього, насамперед, 

вкажемо ім’я файлу, його тип та, відповідно, розширення, розширення та пропорції сторін 

відео, частоту кадрів: 

 

За необхідності рендерингу відео перед збереженням необхідно спочатку активувати 

режим PhotoView 360. 
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Приклад скріншотів анімаційного відео: 

   

   

   

На відміну від стандартного, збереження з камери дає більш вдалий ракурс. 
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